Instruction Manual
ZEISS SIGMA series
Field Emission Scanning Electron Microscope
ZEISS SIGMA series

Original Manual

Carl Zeiss Microscopy GmbH
Carl-Zeiss-Promenade 10
07745 Jena
Germany
info.microscopy.de@zeiss.com
www.zeiss.com/microscopy

Carl Zeiss Microscopy Ltd
1030 Cambourne Business Park
CB23 6DW Cambridge
United Kingdom

Document Name: Instruction Manual ZEISS SIGMA series
Order Number: 352102-9344-006
Revision: 7
Language: en-US
Effective from: 11/2020

© 2021 Without the prior written consent of ZEISS, this document or any part of it must neither be translated nor reproduced or transmitted in any form or by any means - including electronic or mechanic methods, by photocopying, recording or by any information or filing system. The right to make backup-copies for archiving purposes shall remain unaffected thereby. Any violations may be prosecuted as copyright infringements.

The use of general descriptive names, registered names, trademarks, etc. in this document does not imply that such names are exempt from the relevant intellectual property laws and regulations and therefore free for general use. This shall also apply if this is not specifically referred to. Software programs shall entirely remain the property of ZEISS. No program or subsequent upgrade thereof may be disclosed to any third party, copied or reproduced in any other form without the prior written consent of ZEISS, even if these copies or reproductions are destined for internal use at the customer’s only, the only exception being one single back-up copy for archiving purposes.

ZEISS reserves the right to make modifications to this document without notice.
Table of Contents

1 General Information........................................................................ 6
  1.1 Text Conventions and Link Types .................................................. 6
  1.2 Explanation on Warnings and Additional Information ......................... 7
  1.3 Further Applicable Documents .......................................................... 8
  1.4 Contact ............................................................................................ 8

2 Safety ............................................................................................. 10
  2.1 Intended Use .................................................................................... 10
  2.2 General Safety Information ................................................................. 11
    2.2.1 Safe Operation Conditions .......................................................... 11
    2.2.2 Requirements for Personnel ......................................................... 11
    2.2.3 Preventive Maintenance ................................................................. 12
    2.2.4 Safe Handling of Spare Parts ......................................................... 12
  2.3 Prevention of Hazards ......................................................................... 12
    2.3.1 Biological Hazards ........................................................................ 12
    2.3.2 Burn Hazards ................................................................................ 12
    2.3.3 Chemical Hazards ........................................................................ 13
    2.3.4 Electrical Hazards ........................................................................ 13
    2.3.5 High Pressure Hazards ................................................................. 14
    2.3.6 Magnetic Field Hazards ................................................................. 14
    2.3.7 Mechanical Hazards ..................................................................... 15
    2.3.8 Radiation Hazards ........................................................................ 16
    2.3.9 Suffocation Hazards .................................................................... 17
  2.4 Warning Labels and Lights ................................................................. 18
    2.4.1 Warning Labels .......................................................................... 18
  2.5 Safety Devices and Interlocks ............................................................... 22
    2.5.1 Protective Cover Panels ............................................................... 23
    2.5.2 Main Disconnect Device .............................................................. 23
    2.5.3 Circuit Breaker ........................................................................... 24
    2.5.4 Emergency Off (EMO) Option External ........................................ 24
    2.5.5 Vacuum Locking Device .............................................................. 26
    2.5.6 Interlock System of Optional Airlock ........................................... 27
    2.5.7 Energy Isolating Devices .............................................................. 27

3 Product and Functional Description................................................ 28
  3.1 System Overview............................................................................... 28
  3.2 Main Components ............................................................................ 30
    3.2.1 Vacuum System .......................................................................... 30
    3.2.2 Vacuum System Pressure Modes ................................................ 31
    3.2.3 Electron Optical Column | Gemini 1 ............................................. 32
    3.2.4 Gun Modes .............................................................................. 34
    3.2.5 Detectors .................................................................................. 34
    3.2.6 Specimen Stage | Sigma 300 ...................................................... 53
    3.2.7 Specimen Stage | Sigma 500 ...................................................... 55
  3.3 Optional Components and Accessories ............................................ 56
    3.3.1 Optional Detectors ..................................................................... 56
    3.3.2 Dual Joystick ............................................................................ 68
    3.3.3 Control Panel .......................................................................... 69
4 Installation...................................................................................... 76

5 Commissioning and First Operating Steps....................................... 77

5.1 Prerequisites for Commissioning and Operation ............................ 78
5.2 Switching On the Microscope System.......................................... 78
5.2.1 Energizing the Microscope......................................................... 78
5.2.2 Starting the Microscope............................................................... 80
5.3 Starting the Software....................................................................... 81
5.3.1 Calling up the Help................................................................. 81
5.3.2 Keyboard Shortcuts................................................................. 82
5.4 Acquiring an Image........................................................................ 83
5.4.1 Preparing the Specimen Holder.................................................. 84
5.4.2 Loading the Specimen Chamber............................................... 85
5.4.3 Locating the Specimen.............................................................. 89
5.4.4 Switching on the Gun............................................................... 90
5.4.5 Switching on the EHT.............................................................. 90
5.4.6 Acquiring an Image................................................................. 91
5.4.7 Optimizing the Image.............................................................. 93
5.4.8 Saving the Image..................................................................... 96
5.5 Modifying Gun Parameters............................................................ 96
5.5.1 Selecting the Gun Mode........................................................... 96
5.5.2 Measuring the Probe Current.................................................. 97
5.5.3 Setting the Probe Current......................................................... 98
5.5.4 Continuously Modifying the Probe Current (License: OPTIPROBE) .................................................. 98
5.5.5 Changing the Extractor Voltage............................................. 98
5.6 Finding Appropriate Detector Settings........................................... 99
5.6.1 Selecting a Detector................................................................. 99
5.6.2 Setting up the InLens SE Detector........................................... 100
5.6.3 Setting up the InLens Duo Detector......................................... 100
5.6.4 Setting up the SE Detector...................................................... 101
5.6.5 Setting up the VPSE Detector............................................... 102
5.6.6 Setting up the C2D Detector.................................................. 103
5.6.7 Setting up the aBSD1-LH Detector....................................... 104
5.6.8 Setting up the HDAsB Detector............................................ 105
5.6.9 Setting up the Manually Insertable BSD Detector.................... 107
5.6.10 Setting up the YAG BSD Detector......................................... 108
5.6.11 Setting up the CL Detector.................................................. 108
5.7 Working with Variable Pressure..................................................... 109
5.7.1 Changing to Standard VP Mode.............................................. 109
5.7.2 Returning to HV Mode........................................................... 110
5.8 Working with Optional Accessories............................................ 110
5.8.1 Using the Optional Airlock...................................................... 110
5.8.2 Using the Optional Plasma Cleaner........................................ 118
5.8.3 Using the Optional Raman Spectroscopic Microscope............. 122
5.9 Shutting down the System............................................................ 126
5.9.1 Finishing the Work Session.................................................... 126
5.9.2 Closing the SmartSEM User Interface................................... 127
5.9.3 De-energizing the Microscope.............................................. 128
5.10 Performing an Emergency Shutdown........................................... 129
6 Care and Maintenance .......................................................130
  6.1 Safety During Cleaning and Maintenance..........................130
  6.2 Maintenance Schedule ..................................................130
  6.3 Maintenance Work .......................................................130
    6.3.1 Change of Consumables and Chemicals.......................130
    6.3.2 Servicing the Pre-vacuum Pump .................................131
  6.4 Care and Cleaning Work ...............................................131
    6.4.1 Cleaning the Microscope .........................................132
7 Troubleshooting ..............................................................133
  7.1 Chamber .......................................................................134
    7.1.1 Initializing the Stage ................................................134
    7.1.2 Defining the Post Initialization Position of the Stage ....135
    7.1.3 Changing the Joystick TV Angle .................................135
    7.1.4 Resetting the Touch Alarm ........................................136
    7.1.5 Checking the Water Flow and Temperature .................136
    7.1.6 Replacing the Chamber Door Seal ..............................137
  7.2 Column ........................................................................138
    7.2.1 Baking out the Gun Head ..........................................138
    7.2.2 Calibrating OptiProbe ..............................................140
  7.3 Power Circuit ................................................................140
    7.3.1 Checking the Position of the Circuit Breakers ..............140
  7.4 Detectors .......................................................................141
    7.4.1 Lubricating the Rod ................................................141
  7.5 PC ..............................................................................142
    7.5.1 Cleaning up the PC ................................................142
8 Decommissioning and Disposal ..............................................143
  8.1 Decommissioning ..........................................................143
  8.2 Transport and Storage ...................................................144
  8.3 Disposal .......................................................................146
  8.4 Decontamination ..........................................................146
9 Technical Data and Conformity .............................................147
  9.1 Performance Data and Specifications | Sigma 300 and Sigma 300 VP ..........................147
  9.2 Performance Data and Specifications | Sigma 500 and Sigma 500 VP .........................151
  9.3 Installation Requirements ................................................155
    9.3.1 Layout and Connections ..........................................159
    9.3.2 System Layout ......................................................160
  9.4 Applicable Standards and Regulations ..............................161
10 Parts and Tools ...............................................................162
  10.1 Tools and Accessories ..................................................162
Glossary ..............................................................................162
Index ....................................................................................167
1 General Information

This Instruction Manual is considered to be part of the SEM workstation. Herein after referred to as Microscope System.

This Instruction Manual contains basic steps and safety information that must be observed during operation and maintenance. Therefore, it must be read by the operator prior to commissioning and must always be available at the place of use of the Microscope System. This Instruction Manual is a permanent part of the Microscope System and, if resold, must remain with the Microscope System or be handed over to the new owner.

This manual contains the following chapters:

<table>
<thead>
<tr>
<th>Chapter Content</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Information</td>
<td>Explains the function and structure of this manual.</td>
</tr>
<tr>
<td>Safety</td>
<td>Summarizes important safety details.</td>
</tr>
<tr>
<td>Product and Functional Description</td>
<td>Describes the microscope and its main hardware components and provides an overview of the user interface.</td>
</tr>
<tr>
<td>Installation</td>
<td>Refers to the ZEISS service representatives.</td>
</tr>
<tr>
<td>Commissioning and First Operating Steps</td>
<td>Contains information about starting the microscope and the software, obtaining a first image, adjusting important parameters, and powering down the microscope, also in emergency.</td>
</tr>
<tr>
<td>Care and Maintenance</td>
<td>Informs you about preventive maintenance work and intervals and the change of consumables.</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>Describes common issues and how to resolve them.</td>
</tr>
<tr>
<td>Decommissioning and Disposal</td>
<td>Summarizes notes on shutdown and disposal.</td>
</tr>
<tr>
<td>Technical Data and Conformity</td>
<td>Lists hardware specifications as well as the manufacturer’s declaration that the equipment is in conformity with all applicable European Directives.</td>
</tr>
<tr>
<td>Parts and Tools</td>
<td>Lists consumables, spare parts, tools, and accessories.</td>
</tr>
<tr>
<td>Glossary</td>
<td>Lists important technical terms.</td>
</tr>
<tr>
<td>Index</td>
<td>Lists keywords to help you find relevant information quickly.</td>
</tr>
</tbody>
</table>

1.1 Text Conventions and Link Types

The following text conventions and link types are used:

<table>
<thead>
<tr>
<th>Text convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Start. Press the \textsc{Standby} button. Press [Enter] on the keyboard.</td>
<td>The names of controls and important information are shown in bold letters.</td>
</tr>
<tr>
<td>Press \texttt{&lt;Ctrl+Alt+Del&gt;}</td>
<td>Press several keys on the keyboard simultaneously.</td>
</tr>
<tr>
<td>Select \texttt{Tools &gt; Goto Control Panel &gt; Airlock}.</td>
<td>Follow a path in the software.</td>
</tr>
</tbody>
</table>
### 1.2 Explanation on Warnings and Additional Information

DANGER, WARNING, CAUTION, and NOTICE are standard signal words used to determine the levels of hazards and risks of personal injury and property damage. Not only the safety instructions and warnings in the Safety chapter are to be considered but also the safety instructions and warnings in other chapters. Failure to comply with these instructions and warnings can result in both personal injury and property damage and involve the loss of any claims for damages.

The following symbols and warnings indicating dangerous situations and hazards are used in this document.

<table>
<thead>
<tr>
<th>Type and source of danger</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DANGER</strong></td>
<td>Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.</td>
</tr>
<tr>
<td><strong>WARNING</strong></td>
<td>Indicates a potentially hazardous situation which, if not avoided, may result in death or serious injury.</td>
</tr>
<tr>
<td><strong>CAUTION</strong></td>
<td>Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury.</td>
</tr>
<tr>
<td><strong>NOTICE</strong></td>
<td>Indicates a potentially harmful situation which, if not avoided, may result in property damage.</td>
</tr>
</tbody>
</table>
1.3 Further Applicable Documents

Please take also note of the following documents:

**Brochures and Certificates**
For Brochures, ISO certificates, CSA certificates and EU declarations of conformity ask your ZEISS Sales & Service Partner.

**Installation Requirements**
For more details on technical data, refer to the corresponding Installation Requirements.

**Local and National health and safety regulations**
Local and national health and safety regulations should be adhered to for the site and the use of the Microscope System. Please consult with your ZEISS Sales & Service Partner in the event of these regulations conflicting with the installation requirements of the Microscope System.

**Safety data sheets**
Observe the enclosed safety data sheets. The instructions and guidelines given in the respective safety data sheets must be complied with.

**Software**
For more detailed information on how to use SmartSEM, please refer to its Online Help or ask your ZEISS Sales & Service Partner.

**System and 3rd Party Components, Accessories**
The Microscope System can be configured in many ways. Information about the individual components, enhancements and accessories can be obtained from your ZEISS Sales & Service Partner. Also refer to the 3rd Party documentation of the manufacturer.

1.4 Contact

If you have any questions or problems, please contact your local ZEISS Sales & Service Partner or one of the following addresses:

**Headquarters**

Phone: +49 1803 33 63 34  
Fax: +49 3641 64 3439  
Email: info.microscopy.de@zeiss.com

**Courses and training**

Email: courses.microscopy.de@zeiss.com

**ZEISS Portal**
The ZEISS Portal ([https://portal.zeiss.com/](https://portal.zeiss.com/)) offers various services that simplify the daily work with your ZEISS systems (machines and software). It is being constantly improved and extended to better meet your needs and requirements.

**ZEISS Sales & Service Partner**
You can find a ZEISS Sales & Service Partner in your area under [https://www.zeiss.de/mikroskopie/website/forms/sales-and-service-contacts.html](https://www.zeiss.de/mikroskopie/website/forms/sales-and-service-contacts.html).

**Service Germany**

Phone: +49 7364 20 3800
Fax: +49 7364 20 3226

Email: service.microscopy.de@zeiss.com
2 Safety

This chapter contains general requirements for safe working practices. Any person using the Microscope System or commissioned with installation or maintenance must read and observe these general safety instructions. Knowledge on basic safety instructions and requirements is a precondition for safe and fault-free operation. Operational safety of the supplied Microscope System is only ensured if it is operated according to its intended use.

If any work is associated with residual risks, this is mentioned in the relevant parts of this document in a specific note. When components must be handled with special caution, they are marked with a warning label. These warnings must always be observed.

2.1 Intended Use

The microscope has been designed to generate an image or to analyze appropriate specimens, which is achieved by scanning a focused electron beam across the specimen (SEM Imaging).

In addition to microscopic examination, the microscope also allows for the modification of appropriate specimens. For these purposes, the specimen is placed in the evacuated specimen chamber.

The microscope has been designed for the following applications:

- **Imaging**
  
  Image generation and specimen analysis can be performed by means of a focused electron beam that is scanned across the specimen.
  
  This application allows for the analysis of surface structures and near-surface structures of appropriate specimens.

- **Analytics**
  
  Elemental analysis with optional EDS spectroscopy at the focused electron beam position.
  
  Crystal structure and orientation with optional EBSD detectors.

Info

Not for therapeutic, treatment or medical diagnostic evidence.

Info

Not all products are available in every country. Contact your local ZEISS representative for more information.

SmartSEM Software

The SmartSEM software is intended for the operation of scanning electron microscopes (SEMs).

The SmartSEM software has to be run exclusively on a personal computer delivered by ZEISS. Any other applications are not allowed.

Regarding the operation of the microscope, the following regulations must be met:

- Only operate the microscope according to the operating conditions after correct installation by a ZEISS service representative.
- The microscope is only to be used by operators who have been trained by a ZEISS service representative. Basic operator training and safety instructions will be provided within the scope of the initial start-up by ZEISS. Make sure that everyone who operates the microscope only performs the tasks for which he/she is trained.
- Operators of the microscope must not deviate from the instructions provided in this manual.
- Only perform preventive maintenance tasks described in this manual. All tasks of maintenance, service, and repair not described in this manual have to be performed by an authorized ZEISS service representative.
- The microscope is to be used in a laboratory environment for commercial and scientific purposes only.

Using the microscope for any other purpose is not allowed and can be hazardous.
Improper use can easily lead to impairment of its function or even damage to the Microscope System. Damage caused by incorrect operation, negligence or unauthorized intervention, in particular by removing, modifying or replacing parts of the device, can not be held liable by the device manufacturer. Third-party devices or components that are not expressly approved by ZEISS may not be used.

2.2 General Safety Information

This Instruction Manual must be read before commissioning in order to ensure safe and uninterrupted operation. Pay particular attention to all listed safety notes. Make sure that

- the operating personnel has read and understood this Instruction Manual, associated documents and particularly all safety regulations and instructions, and applies the same.
- the local and national safety and accident prevention regulations must be observed, as well as the applicable laws and regulations in your country.
- this Instruction Manual is always available with/together with the Microscope System.
- the Microscope System is always in perfect condition.
- the Microscope System is secured against access by unauthorized persons.
- maintenance and repair work, remodeling, removal or replacement of components, as well as any other intervention in the Microscope System not described in this Instruction Manual, may only be carried out by the manufacturer ZEISS or persons expressly authorized by ZEISS to do so.

2.2.1 Safe Operation Conditions

If the product safety labels are covered or worn or if any of the safety devices are not in proper working condition, operation of the microscope can be hazardous.

- Periodically check the function of safety equipment and that all protective cover panels are installed.
- Always follow the instructions given on the safety labels.
- Inspect and clean the product safety labels to maintain good legibility.

2.2.2 Requirements for Personnel

Deviating from the instructions given in this manual and on the safety labels can be hazardous or can lead to property damage.

- Do not operate the microscope until you have completely read and understood the entire user documentation delivered with the microscope.
- Observe all safety labels on the microscope and within this manual.
- Only operate the microscope according to the operating conditions after correct installation by a ZEISS service representative.
- Only ZEISS service representatives, who have specialized knowledge of radiation protection, are permitted to service the microscope.

Operator Training

Within the scope of initial start-up, the ZEISS service representative will perform a basic operator training. The basic operator training consists of fundamental operation procedures including safety instructions. Besides, an introduction to basic maintenance tasks will be given for an advanced operator, who has to be an electrically skilled person. The training performed must be documented appropriately.

Special application training is offered on request.
2.2.3 Preventive Maintenance

Deviating from the maintenance and repair tasks described in this manual can be hazardous or can lead to property damage:

- Only perform preventive maintenance and repair tasks described in this manual.
- All tasks of maintenance, service, and repair not described in this manual have to be performed by an authorized ZEISS service representative.
- To maintain best performance of the microscope, it is essential to perform preventive maintenance on a regular basis. Moreover, it is recommended that you conclude a service contract with your local ZEISS service representative or organization.

2.2.4 Safe Handling of Spare Parts

Using spare parts that are not provided by ZEISS can be hazardous or can lead to property damage:

- Only genuine parts supplied by ZEISS are to be used in servicing the microscope.
- Contact your ZEISS service representative for information regarding how to order spare parts.
- Unless authorized by ZEISS, all spare parts should be installed by a ZEISS service representative.

2.3 Prevention of Hazards

This section summarizes potential hazards and recommended safety precautions. Failure to follow the safety instructions and instructions may result in personal injury and property damage.

2.3.1 Biological Hazards

**WARNING**

**Biological hazards**

Biological substances may pose a threat to the health of humans and other living organisms.

- Keep a logbook of the biological substances loaded into the microscope and show it to the ZEISS service representatives before they perform any work on the microscope.

2.3.2 Burn Hazards

**NOTICE**

**Hot surfaces during bakeout**

Parts of the enclosure in the upper range of the column may become hot during bakeout, particularly after a long bakeout cycle.

- Do not place any combustible objects on the grids of the electron optical column during bakeout.
- After the bakeout procedure, let surfaces cool down before working around the column.
- Only advanced operators are allowed to perform the bakeout procedure.
2.3.3 Chemical Hazards

**WARNING**

**Aggressive or toxic chemicals**
Aggressive or toxic chemicals can cause chemical burns.
- When handling aggressive or toxic chemicals, wear suitable protective clothing, gloves, and eye/face protection.
- Do not eat, drink, or smoke while handling toxic chemicals.
- Refer to local safety regulations.
- Read and follow the instructions in the material safety data sheet of the chemical. The material safety data sheet can be obtained from the supplier of the chemicals.

**CAUTION**

**Oil mist around the rotary pump**
The rotary pump RV12 may emit oil mist especially at high gas load (e.g. door accidentally open). Inhaled oil mist is harmful to health.
- Regularly service the oil mist filter (refer to pump manual and material safety data sheets). Recommended is the connection to an exhaust line.

**NOTICE**

**Environmental risk due to disposal of aggressive or toxic chemicals**
When disposing of aggressive or toxic chemicals, there is a threat of damage to the environment.
- When disposing of waste that has been generated during a service operation (e.g. used rotary pump oil), comply with all national and local safety and environmental protection regulations.

2.3.4 Electrical Hazards

**WARNING**

**Hazardous voltage inside the microscope**
High voltages are present inside the microscope. Contact may cause burn or electrical shock.
- Do not remove any parts.
- Only authorized ZEISS service representatives are allowed to service the microscope.
- Do not try to service the microscope yourself.
- Disconnect power before opening.
2 Safety | 2.3 Prevention of Hazards

### WARNING

**High leakage current**

High leakage currents are present in the microscope. Contact may cause burn or electrical shock.

- Ensure proper grounding. For more information, refer to the Installation Requirements document.
- Do not operate the microscope without the separate ground connection.

### WARNING

**Residual voltage at the mains plug**

After unplugging the mains plug residual voltage is present at the pins of the plug which may cause electrical shock.

- After unplugging the mains plug wait at least 5 s before touching the pins of the mains plug.

#### 2.3.5 High Pressure Hazards

### WARNING

**High pressure in gas cylinders**

Gas cylinders containing for example nitrogen or compressed air have a high internal pressure of approximately 200 bar. If not properly handled, the contained gas can abruptly escape and cause the gas cylinder to move in an uncontrollable manner.

- Observe all safety labels on the gas cylinders and all safety instructions given by the gas cylinder manufacturer.
- Always operate gas cylinders in an upright position and secure them so they will not tip over.
- Before transporting gas cylinders, place protective caps on them.

#### 2.3.6 Magnetic Field Hazards

### WARNING

**Malfunction of medical devices near ion getter pumps**

Magnetic fields present at the ion getter pumps may disturb the function of medical devices. The magnetic fields are also present if the microscope is switched off.

If you wear medical implants that are susceptible to magnetic fields (e.g. cardiac pacemakers), do the following:

- Keep a distance of at least 30 cm from the ion getter pumps.
- Follow the safety instructions provided by the pump manufacturer.
### 2.3.7 Mechanical Hazards

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Crushing hazard when lowering the microscope</strong></td>
</tr>
<tr>
<td>The microscope and its components are heavy. When the load is lowered during transport and positioning, body parts can be crushed.</td>
</tr>
<tr>
<td>- Maintain a safe distance.</td>
</tr>
<tr>
<td>- Do not walk or place your hands or feet under the load while it is being lowered.</td>
</tr>
<tr>
<td>- Wear safety shoes and gloves.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Crushing hazard when moving ancillary equipment</strong></td>
</tr>
<tr>
<td>The microscope and its components are heavy. When the load is lowered during transport and positioning, body parts can be crushed.</td>
</tr>
<tr>
<td>Ancillary equipment associated with the microscope is very heavy. When the chiller, the rotary pump(s), or the vibration block is moved, body parts can be crushed.</td>
</tr>
<tr>
<td>- Take care when moving ancillary equipment.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Moving the specimen stage</strong></td>
</tr>
<tr>
<td>Fingers can be trapped by the moving specimen stage.</td>
</tr>
<tr>
<td>- Always close the chamber door before moving the specimen stage.</td>
</tr>
<tr>
<td>- To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Closing the chamber door</strong></td>
</tr>
<tr>
<td>Fingers can be pinched when closing the chamber door.</td>
</tr>
<tr>
<td>- Use the door handle to close the chamber door.</td>
</tr>
<tr>
<td>- Ensure not to get your fingers caught in the chamber door gap.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fingers between isolated table and plinth</strong></td>
</tr>
<tr>
<td>Fingers can be crushed in the gap between isolated table and plinth. The gap varies during operation and while the air feet are adjusted.</td>
</tr>
<tr>
<td>- Do not place your fingers between isolated table and plinth.</td>
</tr>
</tbody>
</table>
2 Safety | 2.3 Prevention of Hazards

**NOTICE**

**Short working distance**

When opening the chamber door, the microscope or specimen can be damaged if the specimen stage is at a short working distance. If a BSD detector is inserted, it can be damaged as well.

- Always retract any retractable detectors before opening the chamber door.
- Always move the specimen stage to a long working distance before opening the chamber door.

**NOTICE**

**Contamination caused by fingerprints**

Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping times.

- Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

2.3.8 Radiation Hazards

**CAUTION**

**Laser radiation class 1M**

If the optional Raman Spectrometer is installed, then diffuse laser reflection may be visible when the chamber door is open.

- Do not view directly with optical instruments into the laser reflection.

**WARNING**

**Radiation hazard due to X-rays**

X-rays are generated inside the microscope during operation. This is unavoidable because electrons are accelerated by voltages up to 30 kV.

- Do not remove any parts around the column and chamber that are essential for radiation protection.
- Use genuine ZEISS parts exclusively.
- Ensure that all local safety and X-ray protection regulations are met.
- Only authorized ZEISS service representatives are allowed to service the microscope.

The microscope is equipped with several radiation protection devices, which, under regular operating conditions, ensure that the microscope operates in accordance with the German X-ray protection regulation (RöV), the German radiation protection regulation (StrSchV) as well as with the EC Directive 2013/59/EURATOM.

In the EU, the operation of the microscope is permission-free as the following requirements are fulfilled:

- The acceleration voltage is limited to 30 kV.
- The local dose rate at a distance of 0.1 m from the accessible surface of the microscope does not exceed 1 μSv/h.
- A respective label is attached to the microscope.

Outside the EU, the user of the microscope has to comply with the local regulations of the country where the microscope is operated.
Contact Radiation Protection

For questions regarding radiation protection, contact the ZEISS Radiation Safety Officer, Carl Zeiss AG, 73447 Oberkochen, Germany
phone: +49 (0) 7364 20 0

2.3.9 Suffocation Hazards

WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.

- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

Concerning the hazards of nitrogen installations and associated safety precautions refer to the current version of the guideline IGC Doc 44/18: Hazards of Oxygen-Deficient Atmospheres, published by EIGA (European Industrial Gases Association).

To download the document:
1. Go to EIGA homepage www.eiga.eu.
2. Select Publications > EIGA Documents.
3. From the list, select Doc. 44/18.
4. Click Download.
2.4 Warning Labels and Lights

All locations that may pose specific hazards are marked with additional warning labels (pictograms) on the Microscope System. These warning labels indicate potential hazards and form part of this Instruction Manual. They are to be kept in clean and easily legible condition. Damaged or illegible warning labels must be replaced immediately. Always observe all warning labels on the complete Microscope System.

2.4.1 Warning Labels

Appropriate safety labels on the microscope warn operators of hazards. Each safety label is affixed close to the point where a particular hazard exists. Several labels also provide legal information.
The safety labels always need to be attached to the correct spots at the microscope. If a safety label is lost or unreadable, it needs to be reordered via the following reorder numbers:

<table>
<thead>
<tr>
<th>Position and Figure of the Safety Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 At the front of the chamber door.</td>
<td>Only present if the optional Raman Spectrometer is installed. Laser Radiation Class 1M laser product Do not view directly with optical instruments. Diffuse laser reflection possible when chamber door is open. Reorder no. 34700-0033-000-15en</td>
</tr>
<tr>
<td>2 At the front of the chamber door.</td>
<td>Nitrogen Hazard Danger of suffocation Ensure area around instrument is sufficiently ventilated Reorder no. 347800-0007-000</td>
</tr>
<tr>
<td>3 At the front of the chamber door.</td>
<td>Risk of injury Fingers could be trapped. Always close the chamber door before you move the stage. Reorder no. 347800-0033-000-02en</td>
</tr>
<tr>
<td>4 At the front of the chamber door.</td>
<td>Risk of damage The FESEM or specimen could be damaged if specimen stage is at a short working distance. Move the specimen stage to a long working distance before opening the chamber door. Reorder no. 347800-0033-000-04en</td>
</tr>
<tr>
<td>5 At the front of the plinth</td>
<td>Avoid injury Make sure you have read and understood the instruction manual before operating this product. Reorder no. 347800-0033-000-01en</td>
</tr>
<tr>
<td>6 At the rear of the microscope</td>
<td>Magnetic Field Interaction with metallic objects may produce Pinch Hazards. Persons with Medical Implants KEEP BACK 12 inches. Reorder no. 347800-0018-000</td>
</tr>
<tr>
<td>Position and Figure of the Safety Label</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| 7 At the rear of the microscope         | **HAZARDOUS VOLTAGE INSIDE**  
Contact may cause electric shock or burn.  
Disconnect power before opening.  
Reorder no. 347823-0016-000 |
| 8 At the rear side of the plinth        | Radiation hazard  
X-rays are generated inside the electron microscope during operation.  
Do not remove any parts.  
Use genuine ZEISS parts exclusively.  
Observe local safety and X-ray protection regulations.  
Reorder no. 347800-0016-100 |
| 9 At the rear side of the plinth        | **CAUTION:**  
X-rays are produced within the EVO/SIGMA instrument  
The acceleration voltage is limited to 30 kV. Dose rates around the microscope are less than the maximum permissible values. |
| 10 At the rear side of the plinth       | **HAZARDOUS VOLTAGE INSIDE**  
Contact may cause electric shock or burn.  
Disconnect power before opening.  
Reorder no. 347823-0016-000 |
| 12 At the rear side of the plinth       | Risk of electrical shock  
Residual voltage at the mains plug after unplug-  
ging.  
Wait at least 5 s after unplugging the mains plug before touching the pins of the mains plug.  
Reorder no. 344700-0033-000-11en |
| 13 At the rear side of the plinth       | High leakage current ensure proper grounding  
Instrument can be damaged  
Instrument must not be operated without separate ground connection  
Reorder no. 347800-0004-000 |
2.5 Safety Devices and Interlocks

In order to prevent injuries and/or property damage, the Microscope System is equipped with several safety devices and interlocks. Defects and other damaged safety devices may cause injuries and property damage. In case of damage or defect, the affected parts of the Microscope System must be taken out of operation immediately and be secured against unintentional use.

For verifying the safety of the Microscope System, please contact your ZEISS service representative. Please keep the service logs and logbooks.
2.5.1 Protective Cover Panels

Due to hazardous voltages and X-rays inside the microscope, the microscope is equipped with protective cover panels.

![Fig. 1: Protective cover panels](image)

- 1 Electron optical column protective cover panels
- 2 Specimen chamber protective cover panels
- 3 Plinth protective cover panels

Operation of the microscope is only allowed with attached protective cover panels.

2.5.2 Main Disconnect Device

To disconnect the microscope with all its components from the mains supply, unplug the CEE connector (blue for 208–230 VAC).

![Fig. 2: CEE connector](image)

If the Emergency Off (EMO) Option is installed, the Main Switch of the EMO Option may be used as Main Disconnect Device for the microscope and its components, refer to *Emergency Off (EMO) Option External* [24].
2.5.3 Circuit Breaker

The circuit breaker (F10) at the rear of the plinth will disconnect the mains power from the electronics in the plinth in case of an over-current (including the first pre-vacuum pump and PC). The other circuit breaker (F11) disconnects mains power from the heaters and the second pre-vacuum pump.

However, some other components will still be connected to mains power.

![Circuit breaker](image)

*Fig. 3: Circuit breaker*

The circuit breaker does not completely isolate the plinth from the mains power. This can only be done using the Main Disconnect Device.

2.5.4 Emergency Off (EMO) Option External

The Emergency Off Circuit with the Main Switch is essential for compliance with the SEMI standard.

The Emergency Off Circuit is mounted at the wall near the mains power supply and connects the mains power supply to the microscope and all its accessories.

![Emergency Off (EMO) Circuit](image)

*Fig. 4: Emergency Off (EMO) Circuit*

With the optional Emergency Off Circuit, the microscope is equipped with the following additional safety equipment.
2.5.4.1 Main Switch

If the Emergency Off Circuit is installed, the Main Switch of the EMO Circuit shall be used as **Main Disconnect Device** for the microscope and its components.

In its OFF position the Main Switch cuts off both phases of the mains power from the microscope and all devices directly connected to the EMO Circuit.

The Main Switch can be locked in the OFF position to keep it from being switched on, e.g. during repair and maintenance work.

The Main Switch is located at the front of the EMO Circuit.

The Main Switch of the external EMO box guarantees an ampere interrupting capacity (AIC) of at least 10,000 A rms.

![Main Switch](image)

*Fig. 5: Main Switch*

2.5.4.2 Start Button

The green Start button is located at the front of the EMO Circuit below the Main Switch.

The Start button must be pushed to switch the mains power to the outputs of the EMO Circuit if the Main Switch is in the ON position and no EMO button is pressed.

![Start button](image)

*Fig. 6: Start button*
2.5.4.3 Emergency Off (EMO) Button

The EMO button is located on the plinth adjacent to the specimen chamber. The EMO button must be pressed in an emergency to cut off mains power from the microscope and all devices connected to the AC Unit. The EMO button must always be readily accessible and operable.

![EMO button](image)

**Fig. 7: EMO button**

<table>
<thead>
<tr>
<th>Info</th>
</tr>
</thead>
</table>

Possible loss of data if any of the safety features are activated.
If the microscope is switched off using one of the safety devices, then the programs running on the computer are not properly closed. Any unsaved changes to files are lost.
The Emergency Off function ensures that all power to the microscope is safely cut off.
The Emergency Off is not appropriate for shutting down the microscope in normal operation.
- If the EMO button is pressed in the event of an emergency the button will remain in its depressed position.
- Once the emergency situation has been resolved, the EMO button is released by pulling it out.
- The microscope can then be restarted, refer to *Energizing the Microscope* [78].

2.5.5 Vacuum Locking Device

The vacuum locking device ensures that gun vacuum and system vacuum are better than the required thresholds.
2.5.6 Interlock System of Optional Airlock

The interlock function ensures that the gate valve can only be operated if the chamber door and the airlock door are properly closed.

Additional blocking functions ensure that the specimen can only be transferred if the following conditions are fulfilled:
- The airlock rod is retracted.
- The specimen stage is in transfer position.
- The EHT (Extra high tension) is off.
- The column chamber valve is closed.

This is to prevent any risk of damaging the airlock rod or the gate valve.

2.5.7 Energy Isolating Devices

At the site of installation, the electrical power connection and the fluid connections must be equipped with energy isolating devices.

As energy isolating devices, the following main shut-off valves are required:
- Water supply
- Water runback
- Nitrogen supply
- Compressed air supply

The energy isolating devices
- must be easily accessible
- must be mounted near the microscope in such a way that the person actuating or inspecting an energy isolating device is not be exposed to serious risks
- must close off the connections to the corresponding media when needed
- must be lockable in their off position in order to prevent accidental re-activation
3 Product and Functional Description

Info

Additional information and detailed descriptions are available in the further applicable documents, or ask your ZEISS Sales & Service Partner.

Info

This chapter describes only the overall product and its functionality. The microscope must not be operated before this manual has been fully read and understood. Also refer to manuals of accessories if applicable. Especially the chapters “Installation” and “Commissioning and First Operating Steps” are important.

3.1 System Overview

Main Components

Fig. 9: Main components of the microscope

1 Electron optical Gemini column
   Refer to Electron Optical Column | Gemini 1 [32]

2 Specimen chamber with door handle

3 Plinth with ON/STANDBY/OFF buttons

4 Monitors

5 Control panel (optional)

6 Work desk

7 Dual joystick (optional)

8 Personal Computer (PC)
**Optional Components and Accessories**

A range of options and accessories is available for the microscope. Examples of available options and accessories are the following:

| Detectors | BSD detectors for high efficiency and angle selective material characterization.  
Refer to *BSE Detectors* [57], *HDAsB Detector* [64], and *YAG BSD Detector* [65] |
|-----------|----------------------------------------------------------------------------------------------------------------------------------|
| CL detector | CL detector for the analysis of cathodoluminscent materials  
Refer to *CL Detector* [67] |
| STEM detector | STEM detector for transmission imaging of ultrathin sections  
Refer to *STEM Detector* [65] |
| VPSE detector | VPSE detector  
Refer to *VPSE Detector* [49] |
| C2D detector | C2D detector  
Refer to *C2D Detector* [52] |
| Specimen Current Detector (SCD) | Specimen Current Detector (SCD)  
Refer to *SCD Detector* [67] |
| Stage accessories | Coolstage |
| | Faraday cup |
| | Right-hand tilt (Sigma 300) |
| Further options | Additional chamberscope, stubscope, and external navigation camera  
Column maintenance kit, O-ring kit  
Airlock for quick specimen transfer without breaking the system vacuum  
Refer to *Using the Optional Airlock* [110]  
Plasma cleaner for the decontamination of specimens and the specimen chamber  
Refer to *Using the Optional Plasma Cleaner* [118]  
Raman spectroscopic microscope for material characterization  
Refer to *Using the Optional Raman Spectroscopic Microscope* [122]  
Dual joystick for stage control and specimen navigation  
Refer to *Dual Joystick* [68]  
Control panel that allows direct access to the most frequently used functions  
Refer to *Control Panel* [69]  
Software add-ins and enhancements |

For full details about the available options and accessories, please contact your local ZEISS service representative, or sales representative.
3.2 Main Components

3.2.1 Vacuum System

**Purpose** For operation of the microscope, the gun head, the column, and the specimen chamber have to be evacuated. The vacuum is essential to operate the gun and to prevent collisions of electrons with gas molecules.

![Schematics of the vacuum system](image)

**Fig. 10: Schematics of the vacuum system**

1. Gun with filament
2. Gun head
3. Multihole aperture
4. Column chamber valve
5. Turbo pump
6. Ion getter pump (IGP)
7. Specimen chamber
8. Penning gauge
9. Vent valve
10. Pre-vacuum pump

**System Vacuum**

The pre-vacuum pump 10 and the turbo pump 5 evacuate the specimen chamber 7. The vacuum in the specimen chamber is measured by a Penning gauge 8. The detected vacuum values are displayed as **System vacuum** in the SmartSEM user interface. As long as the detected pressure in the specimen chamber is not ready for operation, the column chamber valve 4 is closed in order to separate the specimen chamber from the column.

**Gun Vacuum**

In the gun head, an ultra high vacuum is maintained by ion getter pumps 6. The vacuum in the gun head is displayed as **Gun vacuum** in the SmartSEM software. It should be below $1 \times 10^{-8}$ mbar.

**Venting**

The specimen is located in the evacuated specimen chamber. To open the specimen chamber for specimen exchange, you have to break the vacuum in a controlled manner. This is done by the **Vent** command via the SmartSEM user interface or by pressing the **Exchange** push button on the optional control panel.
When the **Vent** command is received, the column chamber valve closes and gaseous nitrogen flows into the specimen chamber via the vent valve 9. As soon as the pressure equilibrium is obtained, the chamber door can be opened to change the specimen.

**Evacuating** In order to continue operation, the **Pump** command makes the pre-vacuum pump and the turbo pump evacuate the specimen chamber.

As soon as the vacuum in the specimen chamber is ready for operation, the column chamber valve opens and the **EHT Vac ready** message is displayed in the SmartSEM user interface. Gun and EHT can be switched on.

**Quiet Mode** The automatically controlled **Quiet Mode** is optionally available. This option allows switching off the pre-vacuum pump after specimen exchange when the vacuum threshold is achieved.

### 3.2.2 Vacuum System Pressure Modes

**Purpose** For operation of the microscope, the gun head, the column, and the specimen chamber have to be evacuated. The vacuum is essential to operate the gun and to prevent collisions of electrons with gas molecules.

With the variable pressure mode option, the microscope can be operated in different vacuum modes:

- High vacuum (HV) mode
- Variable pressure (VP) mode

#### 3.2.2.1 HV Mode

**Purpose** When changing to HV mode, the acceleration voltage decreases to zero and the column chamber valve closes. The GFV closes and as soon as the chamber pressure drops below the minimum chamber pressure (MCP = 15 Pa) the RBV closes and the TIV opens. Then the column chamber valve opens and the acceleration voltage is turned on again.

The booster voltage is turned on in this mode.

#### 3.2.2.2 Variable Pressure Mode

**Purpose** The variable pressure (VP) mode enables you to use the scanning electron microscope to image specimens that are non-conducting, strongly gassing, or humid, without the need for vapor deposition or other preparation procedures.

A differential pumping system makes it possible to set partial pressures above 10 Pa in the specimen chamber while maintaining a high vacuum or ultra-high vacuum in the gun area and in the beam path.

When changing to VP mode, the acceleration voltage decreases to zero, the column chamber valve closes, the turbo isolation valve (TIV) closes, the Roughing backing valve (RBV) and the gas flow valve (GFV) open. As soon as the chamber pressure has reached the user value, acceleration voltage switched on again and the column chamber valve opens.

The booster voltage is turned off in this mode.

**Function** The residual gas atmosphere in the specimen chamber creates an interaction region of electrons and residual gas molecules between the objective lens and the specimen. In this region, high-energy electrons in the primary electron beam hit the residual gas molecules and ionize them. The ions generated in these collisions contribute to the compensation of negative charge on the specimen.

However, another effect of these collisions is to scatter the electron beam. This is called the “skirt effect”. The electrons that are lost from the primary beam as a result of this effect provide only a resolution-limited background signal for imaging purposes. Although it is possible to tolerate these leakage losses at chamber pressures up to a few hundred Pa, it is necessary to carefully se-
lect and control the important factors such as acceleration voltage, chamber pressure, and beam path. The signal-to-noise ratio in variable pressure mode can also be improved via the noise reduction features of SmartSEM. For details refer to the Software manual SmartSEM.

Fig. 11: Non-conducting specimen imaged with an acceleration voltage of 20 kV and a 30 μm aperture. Left: High vacuum (HV) mode, showing strong charging effects. The electron beam is distorted and high-quality imaging is not possible. Right: VP mode at 21 Pa. Charges are completely compensated, allowing easy imaging of the specimen.

3.2.3 Electron Optical Column | Gemini 1

**Purpose**  The Gemini 1 column is the part of the microscope, where electrons are emitted, accelerated, deflected, focused, and scanned. Main characteristics of the Gemini optics are the beam booster and an objective lens that consists of a combined electrostatic/electromagnetic lens doublet.

Fig. 12: Schematics of the electron optics

1. Gun
   Generates the electron beam.

2. Extractor
   Positive electrode that extracts electrons from the filament.

3. Anode aperture
4. Multihole aperture (aperture changer)
5. Condenser
   Collects and focuses the electron beam onto the specimen.
6. InLens SE detector / InLens Duo detector
Objective lens
Focuses the electron beam on to the specimen surface.

Scanning coils
Deflect the beam across the specimen surface in what is usually referred to as a raster scan.

Specimen

Suppressor voltage

Extractor voltage

Acceleration voltage

Liner tube voltage

A Schottky field emitter serves as gun. The filament is heated by applying the filament current. Electrons are emitted from the heated filament while an electrical field, called extractor voltage ($U_{\text{Ext}}$), is applied. To suppress unwanted thermionic emission from the shank of the Schottky field emitter, a suppressor voltage ($U_{\text{Sup}}$) is applied as well.

The emitted electrons are accelerated by the acceleration voltage ($U_{\text{EHT}}$), for example 10 kV.

The beam booster is a feature of the electron optical column and has the following functions:
- It minimizes beam widening that may occur due to stochastic electron-electron interactions. Consequently there is almost no loss in beam brightness, even at low acceleration voltages.
- It enhances protection against external stray fields.

Anode and liner tube are connected mechanically and electrically and form the beam booster. A booster voltage ($U_B$, liner voltage) of +8 kV is applied to the beam booster in addition to the acceleration voltage, so that a high beam energy is maintained throughout the entire column. The function of the beam booster depends on the acceleration voltage $U_{\text{EHT}}$:
- $U_{\text{EHT}} \leq 20$ kV: liner tube/beam booster is connected to +8 kV
- $U_{\text{EHT}} > 20$ kV: liner tube/beam booster is connected to ground, i.e. is switched off

Because of the danger of arcing, the beam booster function is not available in variable pressure (VP) mode.

The electron beam passes through the anode aperture first, afterwards through the multihole aperture.

The anode aperture defines the maximum possible probe current.

The multihole aperture is the final beam limiting aperture. It is decisive for the probe current. The standard is the 30 μm aperture hole that is the central aperture. Other aperture sizes are selectable to meet the requirements of a wide range of applications.

For the Gemini 1 column, two types of multihole aperture are available:
- 20 nA high resolution configuration
- 100 nA high current configuration

<table>
<thead>
<tr>
<th>Anode aperture diameter</th>
<th>Multihole aperture type</th>
<th>Probe current</th>
<th>Typical application</th>
</tr>
</thead>
<tbody>
<tr>
<td>40 μm</td>
<td>7 hole aperture</td>
<td>3 pA to 20 nA</td>
<td>High resolution</td>
</tr>
<tr>
<td></td>
<td>30, 7, 10, 15, 20, 60, 120 μm</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Anode aperture diameter</th>
<th>Multihole aperture type</th>
<th>Probe current</th>
<th>Typical application</th>
</tr>
</thead>
<tbody>
<tr>
<td>90 μm</td>
<td>6 hole aperture</td>
<td>6 pA to 100 nA</td>
<td>High current</td>
</tr>
<tr>
<td></td>
<td>30, 10, 20, 60, 120, 300 μm</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3 Product and Functional Description | 3.2 Main Components

**Condenser**

The condenser is used for aperture matching of the objective lens in order to guarantee optimum resolution at each probe current and EHT setting. Together with the multihole aperture, the condenser allows to regulate the probe current.

**Stigmator**

The stigmator is located inside the condenser and compensates for astigmatism so that the electron beam becomes rotationally symmetrical.

**Objective Lens and Deflection System**

The objective lens focuses the electron beam onto the specimen. The objective lens consists of an electromagnetic lens and an electrostatic lens, which reduce spherical and chromatic aberrations, especially at low acceleration voltages. The electromagnetic lens is water cooled.

The deflection system consists of a set of scan coils that move the electron beam in a point-to-point scan across the specimen. The scan coils deflect the beam in the X and Y directions relative to the electron-optical axis.

Before the electron beam exits the objective lens, the electrostatic lens creates an opposing field which reduces the potential of the electrons by +8 kV. The energy of the electrons reaching the specimen surface therefore corresponds to the set acceleration voltage (EHT).

**Signal Detection**

When the primary electron beam hits the specimen, certain interaction products are released, which can be recorded by specific detectors, e.g. the InLens SE detector. For more information refer to Principle of Signal Detection.

### 3.2.4 Gun Modes

The microscope can operate in different gun modes:

- Imaging
- Analytic

**Imaging Gun Mode**

In Imaging gun mode, the temperature of the Schottky emitter and the extraction voltage are reduced in comparison to the Analytic gun mode. This leads to a reduction of the energy spread of the primary electrons.

Imaging gun mode is suitable for lower probe currents. Imaging gun mode is especially useful at low kV to reduce chromatic aberration and to achieve a better resolution.

**Analytic Gun Mode**

Analytic gun mode is suitable for higher probe currents. Overall, the probe current in Analytic gun mode is about twice the probe current in Normal gun mode.

### 3.2.5 Detectors

This chapter describes the generation of secondary and backscattered electrons, and describes how the detector types, that are available for use with the microscope, use these electrons to provide imaging, topographical, and other information. It also lists some characteristics of each detector type.

For more information about any of the detectors, contact your local ZEISS service representative.

#### 3.2.5.1 Principle of Signal Detection

When a primary electron (PE) beam hits a specimen, certain electron beam interaction processes occur. The interaction products most frequently used for the generation of images in scanning electron microscopy are secondary electrons (SEs) and backscattered electrons (BSEs).

Specific types of detectors are able to detect the SEs and BSEs. The detector signals can be used to create images and produce information about the properties of the specimen.
Fig. 13: Interaction between primary electron beam and specimen

1. Objective lens
2. Interaction volume
3. Specimen

Fig. 14: Interaction between primary electron beam and specimen

1. Primary electrons
2. Auger electrons
3. Secondary electrons
4. Backscattered electrons
5. Characteristic X-rays
6. Continuum X-rays
7. Fluorescent X-rays

**Primary Electrons** Primary Electrons (PEs) are electrons forming the scanning beam before hitting the specimen.

**Secondary Electrons** Secondary electrons are emitted from the topmost layer of the specimen.
- SE1 Electrons
Electrons emitted at the point of impact between the beam and the specimen are known as SE1 type electrons. The amount of electrons emitted at the point of impact is related to the shape of the specimen.

Secondary electron detectors, such as the InLens SE detector, collect SE1 type electrons from the surface layer of the specimen and are thus ideal for displaying surface structures.

- **SE2 Electrons**

  The emergence of backscattered electrons from the specimen excites further emission of secondary electrons. These are known as SE2 type electrons.

  Detectors that collect SE2 type electrons are especially suitable where the working distance is large. Surface detail as the effect of “lateral illumination” emphasizes the topography of the specimen.

**Backscattered Electrons**

All electrons with energy higher than 50 eV are known as backscattered electrons (BSEs). BSEs are generated by elastic scattering in a much deeper range of the interaction volume (up to 1 µm) and carry depth information. The backscatter coefficient increases with increasing atomic number of the elements within the specimen. This allows the BSE detector to generate atomic number contrast, or compositional contrast images.

*Fig. 15: Backscattered electron coefficient against atomic number*

BSE detectors are used to display the materials contrast because the backscatter coefficient is dependent on the mean atomic number of the material under investigation.

**Transmitted Electrons**

This comprises primary electrons that are transmitted through an ultrathin specimen and weakly scattered primary electrons with a small range of angles. Depending on the material, primary electrons are scattered under different angles and can be detected by a STEM detector placed below the specimen. Unscattered electrons are detected in the center of the STEM detector and give a bright field image. Electrons scattered under higher angles are detected by outer areas of the STEM detector and produce dark field images.

**Cathodoluminescence**

Electrons impacting on luminescent materials cause the emission of photons (Cathodoluminescence, CL) which may have wavelengths in the visible spectrum and can be imaged by specialized detectors.

### 3.2.5.2 Detectors Overview

The beam scans the specimen and initiates particles to be emitted. A detector collects the emission and produces an electric signal with an amplitude proportional to the number of particles at any given time.

<table>
<thead>
<tr>
<th>Standard Detectors</th>
<th>Detected Signals</th>
<th>Typical Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>InLens SE Detector [38]</td>
<td>SE1</td>
<td>Surface structure</td>
</tr>
<tr>
<td>annular SE detector</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SE Detector [44]</td>
<td>SE2</td>
<td>Topography</td>
</tr>
<tr>
<td>Standard Detectors</td>
<td>Detected Signals</td>
<td>Typical Application</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Everhart-Thornley type</td>
<td></td>
<td>Surface structure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Compositional contrast</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Optional Detectors</th>
<th>Detected Signals</th>
<th>Typical Application</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VPSE Detector [49]</strong></td>
<td>SE2</td>
<td>Variable pressure</td>
</tr>
<tr>
<td>optional, on VP systems only</td>
<td></td>
<td>Topography and surface structure in VP mode</td>
</tr>
<tr>
<td><strong>C2D Detector [52]</strong></td>
<td>SE</td>
<td>Variable pressure</td>
</tr>
<tr>
<td>optional, on VP systems only</td>
<td></td>
<td>Topography and surface structure in VP mode</td>
</tr>
<tr>
<td><strong>InLens Duo Detector [56]</strong></td>
<td>SE1, BSE</td>
<td>Surface structure</td>
</tr>
<tr>
<td>optional, only Sigma 500</td>
<td></td>
<td>Material contrast</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Compositional contrast</td>
</tr>
<tr>
<td><strong>BSE Detectors [57]</strong></td>
<td>BSE</td>
<td>Topographical (crystal orientation)</td>
</tr>
<tr>
<td>including HDBSD, aBSD1-LH Detector [63], and HDAsB Detector [64]</td>
<td>BSE</td>
<td>Compositional contrast</td>
</tr>
<tr>
<td><strong>YAG BSD Detector [65]</strong></td>
<td>BSE</td>
<td>Compositional contrast</td>
</tr>
<tr>
<td>Electron backscatter diffraction (EBSD) detector</td>
<td>BSE camera</td>
<td>Metallurgy, geology, and electronics</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Kikuchi patterns, crystallographic orientation and texture, grain size</td>
</tr>
<tr>
<td><strong>STEM Detector [65]</strong></td>
<td>Transmitted electrons</td>
<td>Transmission imaging of ultrathin sections in biological and mineralogical examinations</td>
</tr>
<tr>
<td>Scanning Transmission Electron Microscopy detector</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CL Detector [67]</strong></td>
<td>Light photons</td>
<td>Mineralogy</td>
</tr>
<tr>
<td>Cathodoluminscence detector</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SCD Detector [67]</strong></td>
<td>Absorbed electrons</td>
<td>Electron beam induced current (EBIC)</td>
</tr>
<tr>
<td>Specimen current detector (SCD)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wavelength dispersive X-ray detector (WDX)</td>
<td>X-ray</td>
<td>Materials elemental composition evaluation</td>
</tr>
<tr>
<td>Energy dispersive X-ray detector (EDX)</td>
<td>X-ray</td>
<td>Materials elemental composition evaluation</td>
</tr>
</tbody>
</table>

For more details, refer to the document Product Specification of the microscope.
### 3.2.5.3 InLens SE Detector

**Purpose** The InLens SE detector is a high-efficiency detector for high resolution SE imaging and detects secondary electrons directly in the beam path. The very high detection efficiency of this detector results from its geometric position in the beam path and from the combination with the electrostatic/electromagnetic lens.

**Position** The annular shaped in-column detector is located above the objective lens.

Function

The primary electrons \(1\) are accelerated by the acceleration voltage at the anode and, up to an acceleration voltage of 20 kV, by an additional beam booster \(3\) voltage of 8 kV at the liner tube. To ensure that the electrons reach the specimen surface \(7\) with the energy set as acceleration voltage, an opposing electrostatic field of the same magnitude as the beam booster voltage (8 kV) is generated at the end of the objective lens by the electrostatic lens \(10\). This electrostatic field acts as acceleration field for the SEs generated on the specimen surface. The secondary electrons are absorbed, re-accelerated, and focused through the electromagnetic field to the InLens SE detector \(8\).

At the InLens SE detector, the electrons hit a scintillator. This generates a flash of light that is led out of the beam path and onto a photomultiplier by means of a lightguide. The photomultiplier converts the light information into an electronic signal, which can be displayed on the monitor. The interaction between the primary electron beam and the specimen generates a large number of SEs.
The efficiency of the InLens SE detector is mainly determined by the electric field of the electrostatic lens, which decreases exponentially with the distance. Thus, the working distance (WD) is one of the most important factors affecting the signal-to-noise ratio of the InLens SE detector.

As the tilt angle of the specimen surface affects the emission angle of the electrons, you should avoid strong specimen tilting.

**Info**

The InLens SE detector can be used up to an acceleration voltage of 20 kV. At higher acceleration voltages, the beam booster and thus the field of the electrostatic lens are switched off. Without the field of the electrostatic lens, which attracts the secondary electrons, the efficiency of the InLens SE detector is reduced.

### 3.2.5.3.1 Detector Efficiency and Working Distance

**Working Distance**

The efficiency of the InLens SE detector mainly depends on the electric field of the electrostatic lens, which decreases exponentially with the distance. Thus, the working distance (WD) is one of the most important factors that affects the signal-to-noise ratio and therefore the efficiency of the InLens SE detector.

For different imaging applications, the working distance needs to be selected depending on the geometry of the specimen and depending on the acceleration voltage.

- At acceleration voltages in the range of 1 kV to 5 kV, the working distance should be as low as possible.
- At very low interaction energies in the range of 100 V to 1 kV, the working distance should not be greater than 4 mm. Often it is reasonable to set the working distance to 2 mm. This allows the SE1 electrons to be efficiently attracted by the 8 kV voltage from the beam booster towards the InLens SE detector.

**Tilted Specimen**

The signal from the InLens SE detector can also be affected by the direction of the specimen surface. Large angles of specimen tilt affect the emission angle of the secondary electrons, and fewer electrons are emitted in the direction of the final lens. This reduces the detection efficiency.

Large angles of specimen tilt also prevent the use of very short working distances.

It is therefore recommended to avoid large angles of tilt when using the InLens SE detector.

*Fig. 17: Changed SE distribution when using a tilted specimen*
Effect BSE Detector  The BSE detector is located directly below the objective lens. The BSE detector may therefore influence the electrostatic field of the objective lens and affect the efficiency of the InLens SE detector.

The presence of a BSE detector may also prevent imaging at very short working distances, which reduces the efficiency of the InLens SE detector (this applies only to the retractable BSE detectors). When using only the InLens SE detector for imaging, it is recommended to move the BSE detector to its parking position in order to reduce the working distance and to increase the efficiency of the InLens SE detector.

3.2.5.3.2 Benefits of the InLens SE Detector

The main benefit of the InLens SE detector is its high detection efficiency, particularly at very low acceleration voltages, and the almost pure detection of secondary electrons.

Surface Detail  The InLens SE detector is an ideal tool to map the surface of a specimen: Even at high acceleration voltages, the images include more surface information than would be possible with the SE detector. This is because of the pure SE detection capability of the InLens SE detector.

Fig. 18: Effect on electrostatic field by the BSE detector

Fig. 19: Comparison of surface information at high acceleration voltages. InLens SE detector (left): Clear edge effect with good imaging of the surface structures. SE detector (right): Little surface information. Acceleration voltages: 10 kV.
The InLens SE detector is frequently used at lower acceleration voltages. At low acceleration voltages, the primary electrons carry less energy and have a smaller interaction volume and a lower depth of penetration. The secondary electrons are generated in the upper layers of the specimen and enable good imaging of surface structures and contaminations.

At higher acceleration voltages, the penetration depth of the primary electrons increases. More information stems from the bulk of the material.

These effects of acceleration voltage are visualized in the following images:

---

**Fig. 20:** Comparison of surface information with contamination. InLens SE detector (left): Imaging of thin layers on the specimen surface. SE detector (right): Layers are not detected. Acceleration voltages: 10 kV.

**Influence Acceleration Voltage**

---

**Fig. 21:** Comparison of surface information at different acceleration voltages. 0.2 kV acceleration voltage (top left): Homogenous illumination, mapping of actual surface. 1 kV acceleration voltage (top right): Increasing edge effect. 5 kV acceleration voltage (bottom left): Increasing edge effect, reversed contrast of some structures. 10 kV acceleration voltage (bottom right): Transparent surface due to increased penetration depth.
The effects of the acceleration voltage also are dependent on the atomic number of the material:

**Fig. 22:** Comparison of surface information at 1 kV and 5 kV – low atomic number. 1 kV acceleration voltage (left): Good surface imaging. 5 kV acceleration voltage (right): Transparent surface due to increased penetration depth.

**Fig. 23:** Comparison of surface information at 1 kV and 15 kV – high atomic number, 1 kV acceleration voltage (left): Good surface-sensitive imaging. 15 kV acceleration voltage (right): Transparent surface due to increased penetration depth.

**Charging Effects**  Another reason to use low acceleration voltages is to minimize and compensate the local charging on the surface of the specimen. If electrons hit a non-conducting or a partially-conducting specimen, they accumulate on the surfaces and cannot discharge. Generated local charges affect the electron beam and can significantly reduce the image quality. It is possible to reduce or compensate for this effect by reducing the primary energy of the electrons and reducing the probe current (aperture size).

**Fig. 24:** Compensation for charging using lower acceleration voltage. 7 kV acceleration voltage (left): Poor image quality due to charging effects. 1 kV acceleration voltage (right): No charging effects.
Topographic Contrast  Because the InLens SE detector views the specimen from directly above, images obtained by this detector seem to be “flat” and contain only little information about the topography. However, surface-specific information is detected sufficiently well. In comparison to the InLens SE detector, the SE detector emphasizes topography. The electrons penetrate deeper into the specimen and a large number of backscattered electrons contribute to the image information. Generally, more signal can be obtained from surfaces that are tilted towards the detector.

Fig. 25: Comparison of topographic contrast of a fracture surface. InLens SE detector (left): Significant edge effect, low topographic contrast. SE detector (right): Good topographic imaging. Acceleration voltages: 15 kV

Fig. 26: Comparison of topographic contrast of an integrated circuit: InLens SE detector (left): Good imaging of surface structures, low topographic contrast. SE detector (right): Good topographic imaging. Acceleration voltages: 15 kV

The InLens SE detector is not always the appropriate detector for image navigation at low magnifications:
- It requires the use of a small working distance, which limits the smallest possible magnification.
- A small spot can appear in the center of the image field at very low magnifications. Whether or not such a spot appears strongly depends on the geometry of the specimen, on the working distance, and on the selected acceleration voltage.

The SE detector is most suitable for generating images with a large field-of-view for navigating on the specimen surface and for using long working distances.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Recommended conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceleration voltage</td>
<td>0.02 kV to 20 kV Suitable up to 20 kV, at more than 20 kV the beam booster is switched off</td>
</tr>
<tr>
<td>Parameter</td>
<td>Recommended conditions</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>0.02 kV to 3 kV</td>
<td>Low-voltage applications for the compensation of charges and for surface-sensitive imaging</td>
</tr>
<tr>
<td>3 kV to 10 kV</td>
<td>The average voltage range is suitable for many different applications</td>
</tr>
<tr>
<td>10 kV to 20 kV</td>
<td>Voltage range frequently used for analytical purposes</td>
</tr>
</tbody>
</table>

**Working distance**

<table>
<thead>
<tr>
<th>Distance</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 10 mm</td>
<td>Due to the dependence on the electrostatic field of the objective lens, the working distance should be as small as possible</td>
</tr>
<tr>
<td>2 mm to 3 mm</td>
<td>For low-voltage applications (100 V to 3 kV)</td>
</tr>
<tr>
<td>3 mm to 6 mm</td>
<td>Useful for the average voltage range (3 kV to 10 kV)</td>
</tr>
</tbody>
</table>

**Aperture**

<table>
<thead>
<tr>
<th>Aperture</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 μm</td>
<td>The standard aperture is recommended for many applications</td>
</tr>
<tr>
<td>7.0 μm to 20 μm</td>
<td>Limitation of the probe current for the compensation of charges, or for the analysis of beam-sensitive specimens</td>
</tr>
<tr>
<td>60 μm and 120 μm</td>
<td>Only recommended for analytical purposes</td>
</tr>
</tbody>
</table>

**Specimen tilt**

<table>
<thead>
<tr>
<th>Specimen tilt</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Avoid large angles of tilt, if possible</td>
</tr>
</tbody>
</table>

**Operation mode**

<table>
<thead>
<tr>
<th>Operation mode</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Only suitable in high vacuum, because the beam booster is switched off in the VP mode</td>
</tr>
</tbody>
</table>

*Tab. 3: Summary of InLens SE detector characteristics*

### 3.2.5.4 SE Detector

**Purpose**
The SE detector is an Everhart-Thornley type detector. It detects SEs as well as BSEs.

**Position**
The SE detector is mounted on the wall of the specimen chamber, and is therefore classified as a “chamber detector”. Due to its position in the chamber, the SE detector views the specimen laterally.

*Fig. 27: Schematics of the SE detector*

1. Preamplifier
2. Photomultiplier
3. Light guide
4. Scintillator
5. Collector grid
6. Specimen
**Function**
Electrons moving to the detector are attracted/repelled by the collector grid and directed to the scintillator. The electrons gain energy from the scintillator and thus are able to interact with a phosphor layer, which generates photons (light). The light travels up a light pipe to a photomultiplier. The photomultiplier multiplies the flashes of light and outputs a signal that can be used for imaging.

The collector voltage can be varied in the range between −250 V and +400 V.

A positive collector voltage generates an electrical field in front of the detector, thus directing the low energy SEs towards the scintillator.

A negative collector voltage generates a field deflecting the low energy SEs so that they cannot reach the scintillator and do not contribute to the signal. Only high-energy BSEs reach the scintillator contributing to the image generation. This produces a pseudo-backscattered image, which shows pronounced material contrast, but largely cancels surface properties and topography.

**Fig. 28:** Comparison of SE detector images using positive and negative collector bias voltage: SE detector using +300 V collector bias: Good display of surface structures and topography (left), SE detector using −150 V collector bias: Extremely strong topography, including shadow generation (right)

- **Positive collector bias voltage**
  
  When using a positive collector bias voltage, surfaces that are tilted in the direction of the detector are emphasized, but there are no shadowing effects.

- **Negative collector bias voltage**
  
  When using a negative collector bias voltage, the image shows enhanced topographical contrast, which arises mainly from the extreme shadowing effects. However, the fine surface details are less visible.

**Info**

For all standard applications, the collector bias should be set to +300 V.

Surface images that show enhanced topographical information can also be generated using BSE detectors, but they do not show the shadows that can be created using the SE detector.

**Applications**

Unlike the InLens SE detector, which can be used only with acceleration voltages up to 20 kV, the SE detector can be used in the complete high-voltage range.
The working distance has a significant effect on the efficiency of the SE detector. Shadowing effects occur when the working distance is too short. If the specimen is too close to the objective lens, most of the electrons will be deflected by the field of the electrostatic lens or move to the objective lens itself. This means they cannot be detected by the SE detector. Depending on the specimen material and on the specimen geometry, a minimum working distance of approximately 4 mm should be used. Extreme signal loss is likely to occur if shorter working distances than this are used. Conversely, the SE detector is very good when used for imaging at long working distances. This is particularly important for low magnification imaging that is necessary for adjusting the orientation of the specimen holder or locating a specific area on the specimen.

**Optimal Initial Settings**

The following settings provide a good field of view for navigating on the specimen at low magnifications:

- Initial working distance in the range of 10 mm to 20 mm.
- Acceleration voltage of approximately 10 kV.

The imaging conditions can be readjusted for a desired application after identifying the area of interest on the specimen.
Although images produced by the SE detector always include some backscattered electron components, most of the signal is generated by the secondary electrons and the fraction of backscattered signal is negligible. The images obtained by the SE detector are therefore primarily secondary electron images.

In the previous figure the SE image taken at 5 mm working distance shows relatively poor material contrast. In this example the reduced yield of secondary electrons is caused by the specimen preparation technique of polishing the specimen surface. The ratio of SE to BSE electrons is therefore altered in favor of backscattered electrons.

Because the SE detector is mounted on the chamber at a certain angle to the specimen, the specimen is always viewed laterally. The SE detector, therefore, provides good surface information. All other detectors (InLens SE and BSE) view the specimen from above, providing only limited information about the topography of the specimen. Surfaces tilted towards the detector provide more surface detail with brighter edges; specimens tilted away from the detector display shadowing effects and less surface detail.
Some imaging applications require both, compositional and topographical details. The generation of mixed SE and BSE images is recommended for such applications. The signal mixing option is available in the Detector tab in the SEM Controls panel.

Tilting the specimen increases the signal in the SE detector and sometimes improves the topographical information. Tilting the specimen towards the SE detector also results in a change of the solid angle in which both the backscattered and secondary electrons are emitted from the specimen.

### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Acceleration voltage</strong></td>
<td></td>
</tr>
<tr>
<td>0.02 kV to 30 kV</td>
<td>In principle suitable for the entire high-voltage range</td>
</tr>
<tr>
<td>1 kV to 5 kV</td>
<td>Low-voltage applications for the compensation of charges and for surface-sensitive imaging</td>
</tr>
<tr>
<td>5 kV to 20 kV</td>
<td>The average voltage range is suitable for many different applications</td>
</tr>
<tr>
<td>20 kV to 30 kV</td>
<td>Voltage range frequently used for analytical purposes</td>
</tr>
<tr>
<td><strong>Working distance</strong></td>
<td></td>
</tr>
<tr>
<td>≥ 4 mm</td>
<td>If the working distance is too short, shadowing effects occur which diminish the efficiency of the detector. Below 20 kV, the SEs are absorbed by the field of the electrostatic lens</td>
</tr>
<tr>
<td>4 mm to 6 mm</td>
<td>For low-voltage applications (1 kV to 5 kV)</td>
</tr>
<tr>
<td>6 mm to 12 mm</td>
<td>Useful for the average voltage range (5 kV to 20 kV)</td>
</tr>
<tr>
<td>12 mm to 30 mm</td>
<td>Recommended only for low magnifications and to increase the depth of field</td>
</tr>
<tr>
<td><strong>Collector voltage</strong></td>
<td></td>
</tr>
<tr>
<td>300 V</td>
<td>Standard value of the collector voltage</td>
</tr>
<tr>
<td>0 V to 400 V</td>
<td>Variation of the collector voltage at high magnifications to obtain the mixed signal</td>
</tr>
<tr>
<td>−150 V to 0 V</td>
<td>For pseudo-BSE images</td>
</tr>
</tbody>
</table>
### 3.2 Main Components

#### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aperture</td>
<td>30 μm The standard aperture is recommended for many applications</td>
</tr>
<tr>
<td></td>
<td>7.0 μm to 20 μm Limitation of the probe current for the compensation of charges, or for the analysis of beam-sensitive specimens</td>
</tr>
<tr>
<td></td>
<td>60 μm and 120 μm Only recommended for analytical purposes</td>
</tr>
<tr>
<td>Specimen tilt</td>
<td>Tilting the specimen towards the detector increases collection efficiency</td>
</tr>
<tr>
<td>Operation mode</td>
<td>Only suitable in high vacuum</td>
</tr>
</tbody>
</table>

#### 3.2.5.5 VPSE Detector

**Purpose**

The Variable Pressure Secondary Electron (VPSE) detector is a specific type of SE detector for use in Variable Pressure mode where a standard SE detector cannot be used. The VPSE detector is not usable and will not operate in HV mode.

The Variable Pressure mode enables analyzing and imaging of non-conducting specimens without charging artefacts. This is possible, because positively ionized gas molecules stabilize local charging. Variable Pressure mode can also be used for strongly gassing or moist specimens without any need for specimen preparation.

**Position**

The VPSE detector is attached to the MP-Port 1.

**Function**

The collector electrode mounted on the light guide is held on a positive potential forming a collecting field for SEs. Thus, SEs move towards the detector. In VP mode gas molecules are present in the specimen chamber. The accelerated SEs excite gas molecules, which emit a photon when they de-excite to the ground state. Although BSEs also cause collisions, their contribution is less than 1 % because of the lower ionizing cross section.

The emitted photons are detected by the rod-like light guide pointing at the specimen. The photomultiplier amplifies the light signal and converts it into an electron current. The degree of amplification is depending on the photomultiplier voltage, which regulates the contrast. The preamplifier amplifies the signal and regulates the brightness.

**Chamber Pressure**

For an optimum use of the VPSE detector, the pressure in the specimen chamber must be high enough. If the pressure is too low, then too few gas molecules are present and the collision probability is too low. This reduces the efficiency of the detector.
The optimum chamber pressure depends on the specimen and the operating parameters. It is usually in the range between 20 Pa and 60 Pa.

**Info**

If the chamber pressure rises, then the scattering of electrons is increased and the resolution of the microscope is reduced. Try to find the optimal chamber pressure for each individual application.

**Dwell Time**

The dwell time is the amount of time that the electron beam stays at one position on the specimen before it moves to the next position.

If the dwell time is too short (i.e. the scan rate is too fast), then there is not enough time for an “ion cascade” to develop and to create the imaging photons. This reduces the efficiency of the detector.

If the dwell time is too long (i.e. the scan rate is too slow), then the electron beam delivers a large amount of energy to each individual spot on the specimen. This may result in charging artifacts on the images.

The optimal dwell time depends on the specimen and needs to be determined by experiment.

**Info**

To reduce charging effects, use the Frame Averaging function of SmartSEM. Use fast scan speeds and increase the number of frames (N).

**Collector Bias**

The collector bias corresponds to the voltage that is applied to the VPSE collector. The collector bias accelerates the secondary electrons from the specimen surface towards the VPSE detector.

Typical VPSE collector bias values are between 50 % and 80 %.

If the collector bias is too low, the efficiency of the detector is reduced.

If the collector bias is too high, the VPSE detector may receive too much signal and may get saturated. In this case, very bright lines are visible on the image in periodic intervals and proper imaging is no longer possible. Whether a given value for the collector bias is too high, depends on the specimen, the acceleration voltage, the probe current, and the pressure in the specimen chamber.

*Fig. 35: Saturation of the VPSE detector. Bright lines become visible in the microscope image*

To eliminate the bright lines in the images, either reduce the collector bias or reduce the chamber pressure. However, the detector efficiency is reduced by either of these adjustments. You need to find the optimum parameters for imaging different specimens. It is generally better to reduce the collector bias, because reducing the chamber pressure can cause new charging effects.
Fig. 36: Charge compensation by adjusting chamber pressure and collector bias. Left: Reducing the collector bias from 82% to 78% results in the elimination of banding effects at 40 Pa. Right: Reducing the pressure in the specimen chamber from 40 Pa to 20 Pa results in the elimination of banding effects at a collector bias of 79%.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Acceleration voltage</strong></td>
<td></td>
</tr>
<tr>
<td>3 kV to 30 kV</td>
<td>Possible application range for VPSE G4 detector. However, sufficient contrast can be obtained only at higher voltages.</td>
</tr>
<tr>
<td>3 kV to 7 kV</td>
<td>Low voltage application with VPSE G4 detector.</td>
</tr>
<tr>
<td>7 kV to 25 kV</td>
<td>Standard application for VPSE G4 detector.</td>
</tr>
<tr>
<td><strong>Working distance</strong></td>
<td></td>
</tr>
<tr>
<td>6 mm to 8 mm</td>
<td>For low voltage applications (3 kV to 7 kV)</td>
</tr>
<tr>
<td>8 mm to 15 mm</td>
<td>For standard applications (7 kV to 25 kV)</td>
</tr>
<tr>
<td><strong>Aperture</strong></td>
<td></td>
</tr>
<tr>
<td>30 μm</td>
<td>The standard aperture is recommended for many applications.</td>
</tr>
<tr>
<td>7.0 μm to 20 μm</td>
<td>With these apertures, the probe current is frequently too low to obtain a sufficient signal-to-noise ratio and the required contrast.</td>
</tr>
<tr>
<td>60 μm</td>
<td>Higher probe currents frequently improve the contrast.</td>
</tr>
<tr>
<td>120 μm</td>
<td>Only recommended for analytical applications.</td>
</tr>
<tr>
<td><strong>Specimen tilt</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Avoid large angles of tilt, if possible. Slight tilting can improve efficiency.</td>
</tr>
<tr>
<td><strong>Operation mode</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The VPSE G4 detector is used mainly in the VP mode.</td>
</tr>
<tr>
<td></td>
<td>As the VPSE G4 detector detects light, it can be used as a simple cathodoluminescence (CL) detector in high-vacuum mode.</td>
</tr>
</tbody>
</table>
### 3.2.5.6 C2D Detector

**Purpose**

The cascade current detector (C2D) is a special type of detector that you can use instead of the SE detector to create a secondary electron image under variable pressure conditions.

The SE detector cannot be used under variable pressure conditions: The high potential at the scintillator would cause an electrical breakdown with a lightning flash that runs from the scintillator to the outer body.

---

**Function**

On the surface of the specimen, secondary electrons are created. The secondary electrons accelerate towards the C2D detector due to the potential that is applied to the detector electrode.

On their way to the detector, the secondary electrons collide with residual gas molecules (nitrogen, air molecules, or water). The collisions ionize the residual gas molecules and create additional electrons, as well as cations. The additional electrons also accelerate towards the detector and collide with further gas molecules, which are ionized.

The result is a charge cascade that amplifies the original SE signal by a factor of up to 1000.

The electrons that result from the charge cascade are all collected by the electrode of the C2D detector and the current is further amplified by the detector.

The cations that result from the charge cascade neutralize any negative charge on the specimen that may have been created by the primary electron beam.

---

### 3.2.5.7 Chamber CCD Camera

**Purpose**

The microscope contains a CCD camera (charge-coupled device camera) inside the specimen chamber. It is referred to as the chamber CCD camera or chamberscope. It allows you to monitor the position of the specimen stage and particularly the distance between the objective lens and the specimen holder.

**Position**

The chamber CCD camera is located at the backside of the specimen chamber.

---

*Fig. 37: C2D image of radiolaria*

*Fig. 38: Sample image from chamber CCD camera.*
**NOTICE**

**Risk of collision**

Use the chamber CCD camera to monitor the position of the specimen holder during stage movements. Pay particular attention to the distance between the objective lens and the top of the specimen. This applies to vertical movements, but also to horizontal movements, because a thick specimen may collide with the objective lens from the side.

Depending on the selected detector, the chamber CCD camera is capable of acquiring black-and-white images or colored images.

The performance of the diode detectors is negatively effected by the illumination that is required for the camera. If a diode detector is selected, then by default the chamber CCD camera is disabled:

![Fig. 39: Chamber CCD camera disabled as indicated by a pause sign (e.g. if a diode detector is selected).](image)

### 3.2.6 Specimen Stage | Sigma 300

**WARNING**

**Suffocation hazard due to lack of oxygen**

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.

- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

**CAUTION**

**Moving the specimen stage**

Fingers can be trapped by the moving specimen stage.

- Always close the chamber door before moving the specimen stage.
- To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.
**CAUTION**

**Closing the chamber door**
Fingers can be pinched when closing the chamber door.
- Use the door handle to close the chamber door.
- Ensure not to get your fingers caught in the chamber door gap.

**Purpose**
The 5-axes motorized Cartesian specimen stage is used to navigate the specimen inside the specimen chamber.

**Position**
The specimen stage is mounted on the chamber door. If the chamber door is closed, the specimen stage is inside of the specimen chamber.

**Fig. 40: Specimen stage with dovetail fitting for precise fitting**

1. Specimen holder
2. Specimen stage

**Function**
The stage can be operated using the dual joystick or using the SmartSEM software.

<table>
<thead>
<tr>
<th>Axis</th>
<th>Description</th>
<th>Movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-axis</td>
<td>Movement towards or away from the chamber door (horizontal movement in the image)</td>
</tr>
<tr>
<td>Y</td>
<td>Y-axis</td>
<td>Movement to the left or right seen from the chamber door (horizontal movement in the image)</td>
</tr>
<tr>
<td>Z</td>
<td>Height</td>
<td>Vertical movement (movement towards or away from the focal plane of the image)</td>
</tr>
<tr>
<td>R</td>
<td>Rotation</td>
<td>Stage rotation parallel to the X-Y plane</td>
</tr>
<tr>
<td>T</td>
<td>Tilt</td>
<td>Stage tilt about an axis parallel to the X axis</td>
</tr>
</tbody>
</table>

The focus on the stage is not maintained when the specimen is tilted. This can be compensated for by using the **Compucentric** function in SmartSEM.
3.2.7 Specimen Stage | Sigma 500

**WARNING**

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.
- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

**CAUTION**

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.
- Always close the chamber door before moving the specimen stage.
- To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.

**CAUTION**

Closing the chamber door
Fingers can be pinched when closing the chamber door.
- Use the door handle to close the chamber door.
- Ensure not to get your fingers caught in the chamber door gap.

**Purpose**
The 5-axes motorized eucentric specimen stage is used to navigate the specimen inside the specimen chamber.

**Function**
The specimen stage is mounted on the chamber door. If the chamber door is closed, the specimen stage is inside of the specimen chamber.

![Specimen stage with dovetail fitting for precise fitting](image)

**Fig. 41: Specimen stage with dovetail fitting for precise fitting**

1. Specimen holder
2. Specimen stage

**Function**
The stage can be operated using the dual joystick or using the SmartSEM software.
### Axis Description Movement

<table>
<thead>
<tr>
<th>Axis</th>
<th>Description</th>
<th>Movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-axis</td>
<td>Movement towards or away from the chamber door (horizontal movement in the image)</td>
</tr>
<tr>
<td>Y</td>
<td>Y-axis</td>
<td>Movement</td>
</tr>
<tr>
<td>Z</td>
<td>Height</td>
<td>Vertical movement (movement towards or away from the focal plane of the image)</td>
</tr>
<tr>
<td>R</td>
<td>Rotation</td>
<td>Stage rotation parallel to the X-Y plane</td>
</tr>
<tr>
<td>T</td>
<td>Tilt</td>
<td>Stage tilt about an axis parallel to the X axis</td>
</tr>
</tbody>
</table>

The stage is eucentric, which means that the tilt axis intersects the beam axis. The specimen surface is located in the eucentric point, where the tilt axis meets the beam axis. This guarantees that the focus and the point of interest are maintained when the specimen is tilted at a certain working distance.

### 3.3 Optional Components and Accessories

#### 3.3.1 Optional Detectors

**3.3.1.1 InLens Duo Detector**

**Purpose**
The InLens Duo detector allows imaging and mixing of high contrast topography (SE) as well as clear compositional contrast (BSE).

The InLens Duo Detector is only available for Sigma 500.

**Position**
The annular shaped in-column detector is located above the objective lens and replaces the InLens SE detector.

![Fig. 42: Schematics of the InLens Duo detector](image)

**Function**
The SEs and BSEs generated at the impact point of the primary electron beam are intercepted by the low electrical field of the Gemini column. These electrons are accelerated by the field of the electrostatic lens.
3.3 Optional Components and Accessories

Filtering Grid
Without switching on the filtering grid voltage, the InLens Duo detector has the same characteristics as the InLens SE Detector. The InLens Duo detector primarily detects secondary electrons (SEs).

By switching on the filtering grid voltage, the SEs will be rejected and only backscattered electrons (BSEs) will be detected.

Below a landing energy of 1.5 kV the filtering grid has the additional function of selecting the desired energy of the BSEs. The operator can select the threshold energy of inelastically scattered BSEs to enhance contrast and resolution.

3.3.1.2 BSE Detectors

Purpose
A signal source commonly used in electron microscopy are backscattered electrons (BSE). The use of this type of signal makes it possible to effectively display compositional differences in the specimen. There are different types of detectors for backscattered electrons. Most of these detectors use semiconductor diodes for signal detection. The following semiconductor detectors are available:

- Backscattered electron detectors (BSD):
  - aBSD1-LH
  - 5-segment HDBSD
- Angle-selective backscattered (AsB) detectors (lens mounted):
  - HDAsB

Another type of detector is the YAG BSD. For more information on this detector, refer to YAG BSD Detector.

Position
Whereas the SE detector views the specimen from the side (refer to SE Detector), BSE detectors view the specimen from above. This position offers a very large solid angle that can be used for the detection of backscattered electrons.

BSD Detectors
BSD detectors are located in the specimen chamber and is usually moved into a “parked” position when it is not being used. When needed, the detector is moved into its “active” position either manually (HDBSD) or automatically (aBSD).

Fig. 43: Location of the HDBSD detector
**Optional Components and Accessories**

1. Primary electron (PE) beam
2. Filtering grid
3. Beam booster
4. Magnetic lens
5. SE detector
6. Backscattered electron paths
7. Specimen
8. InLens SE detector
9. Scan coils
10. Electrostatic lens
11. Retractable HDBSD detector
12. Interaction volume

**HDAsB Detector**

The HDAsB detector is an integral part of the objective lens and cannot be moved.

![Location of the HDAsB detector](image)

**NOTICE**

**Collision between specimen and detector**

The diodes can be damaged easily by contact with hard objects.

- When you move the detector below the objective lens, make sure the specimen stage cannot hit the semiconductors.
- If you need to change the working distance, use the TV camera mode to view the specimen and help avoid a collision between the specimen and the detector.

**Info**

Risk of malfunction: The diode segments are sensitive to the light that is used for illumination in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If the CCD Mode is set to *Auto Detect*, then the TV illumination is automatically switched off when a diode detector is used.

**Position**

Although BSE detectors can be used to image various types of specimen (crystal orientation contrast; magnetic contrast type II and so on), their main application is the display of material contrast (compositional differences). Their performance with respect to contrast is based on the backscattering coefficient, which increases with increasing atomic number. A higher backscattering coefficient results in an increase in the number of backscattered electrons generated by the primary electron beam, which are then made available for detection.

If different phases exist on the specimen, those with a higher average atomic number display higher brightness than those with a small atomic number.
3.3.1.2.1 BSE Detector Efficiency

The efficiency of BSE detectors (aBSD1-LH, HDBSD, HDAsB) is determined mainly by three factors:

- **Acceleration voltage**
  
  Since BSE detectors only use the energy of the generated backscattered electrons, the efficiency of the detector therefore increases with increasing acceleration voltage.

- **Working distance**
  
  Since the BSE detectors are positioned directly below the objective lens, a hole exists in the center of the detector through which the electron beam scans the specimen. The active layer (top layer of the semiconductor diodes) is arranged around this hole. If the working distance is too long, many electrons miss the detector, which also reduces the efficiency. If the selected working distance is too short, only few backscattered electrons hit the detector and most electrons pass through the hole without contributing to the signal. The optimum solid angle for detection of the backscattered electrons exists only in a relatively small range of working distances centered at approximately 9 mm.

- **Specimen tilt**
  
  Because of the viewing angle of the BSE detectors (directly from above), the specimen orientation towards the detector has an effect on the detector efficiency. Whereas the SE detector responds very well when the specimen is tilted towards it, tilting degrades the detector response when using a BSE detector.

  Tilting also distributes the generated backscattered electrons in different directions. Larger angles of tilt mean that more electrons are scattered in the forward direction and fewer are available to contribute to the signal of the BSE detector. Low angles of tilt should therefore be used with the BSE detector.
Fig. 47: The effects of working distance: WD too long (left), WD optimal (center), WD too short (right)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Acceleration voltage</strong></td>
<td></td>
</tr>
<tr>
<td>1 kV to 30 kV</td>
<td>Use of very low and very high acceleration voltages is possible</td>
</tr>
<tr>
<td><strong>Working distance</strong></td>
<td></td>
</tr>
<tr>
<td>7 mm to 12 mm</td>
<td>If the working distance is too short or too long, the solid angle available for detection deteriorates away from the optimum</td>
</tr>
<tr>
<td><strong>Aperture</strong></td>
<td></td>
</tr>
<tr>
<td>30 μm</td>
<td>The standard aperture is recommended for many applications</td>
</tr>
<tr>
<td>7.0 μm to 20 μm</td>
<td>With these apertures, the probe current is frequently too low to obtain a sufficient signal-to-noise ratio and the required contrast</td>
</tr>
<tr>
<td>60 μm</td>
<td>Higher probe currents frequently improve the contrast</td>
</tr>
<tr>
<td>120 μm</td>
<td>Often only recommended for analytical applications</td>
</tr>
<tr>
<td><strong>Specimen tilt</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Avoid large angles of tilt, if possible</td>
</tr>
<tr>
<td><strong>Operation mode</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use of the BSE detector is possible in high vacuum and VP mode</td>
</tr>
</tbody>
</table>

### 3.3.1.2.2 BSE Detector Segments

The HDBSD detector has five silicon diode segments:

Fig. 48: HDBSD detector with five segments

The HDAsB detector has four diode segments.

On the surface of the specimen, some of the primary electrons are backscattered. The backscattered electrons then move towards the silicon segments of the detector, which are covered by a thin layer of additional material. If the energy of the backscattered electrons is high enough, then they can pass through the thin layer of material and create electron-hole pairs in the silicon segments.
In each individual segment, the charge separation due to the electron-hole pairs is measured as a current, which is used as a signal for image generation. Only electrons that have a high enough energy can create electron-hole pairs and can contribute to image generation. Electrons that have a lower energy (e.g. secondary electrons) are not detected.

The emission of backscattered electrons from a specimen is related to the atomic number of the involved material: Elements with high atomic numbers generate more backscattered electrons (i.e. the backscatter coefficient is higher). When imaging, regions that contain elements with higher atomic numbers appear brighter. Regions that contain elements with lower atomic numbers appear darker.

These semiconductor detectors have a relatively small bandwidth and a high capacitance (relatively long discharge time), and therefore a reduced scan rate is recommended when using them. The SE detector can initially be used to adjust the electron-optical parameters (focus, stigmation), then the signal source can be switched to the BSE detector to generate the image.

By selecting and combining different diode segments, it is possible to generate images with both topographical and compositional information.

The following figure shows an example comparing the compositional contrast (COMPO) and topographic contrast (TOPO) modes when using a BSD.

Fig. 49: COMPO mode image (left) and TOPO mode image (right) acquired with a BSD

The following figures show more examples of shadow mode images created using compositional contrast and topographic contrast modes with a BSD.

Fig. 50: Compositional contrast image (left) and “Shadow mode” image (right) acquired using a BSD
Fig. 51: Compositional contrast image (left) and “Shadow mode” image (right) acquired using a BSD

Fig. 52: Compositional contrast image (left) and “Shadow mode” image (right) acquired using a BSD
3.3.1.2.3 aBSD1-LH Detector

**Purpose**
The aBSD1-LH (large hole) detector is a pneumatically retractable, annular backscattered electron detector (BSD). It is used for high efficiency material characterization even at low-kV applications. It has five separate diode segments, one inner concentric ring and four outer quadrants. The inner segment S1 provides mostly material contrast whereas the four outer quadrants S2 to S5 provide more topographical contrast.

![aBSD1-LH detector with one inner concentric segment and four outer quadrants](image)

**NOTICE**

**Motorized specimen stage**
Risk of damaging the detector when operating the motorized specimen stage.
- Retract the detector head completely after you have finished the work with the detector.

**Info**
Risk of malfunction: The diode segments are sensitive to the light that is used for illumination in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If the CCD Mode is set to **Auto Detect**, then the TV illumination is automatically switched off when a diode detector is used.

The BSD detector has applications mainly in materials analysis and in the life sciences.

Material analysis:
- Metallurgical sections
- Geological sections
- Complex materials
- Printed circuit boards
- Semiconductors
- Bond pads

---

**Fig. 53:** aBSD1-LH detector with one inner concentric segment and four outer quadrants
Life sciences:
- Mineral deposits in plant structures
- Biological sections
- Bone structures

The detector has one video output channel. The detector has a relatively large central hole and therefore has the advantage that it does not limit the field of view of the SEM and does not influence the electron optical properties of the objective lens. A disadvantage is that especially at low kV a lot of backscattered electrons are lost in the central hole and cannot be detected.

**Function**
On the surface of the specimen, some of the primary electrons are backscattered. The backscattered electrons then move towards the silicon segments of the BSD detector. If the energy of the backscattered electrons is high enough, then the electrons pass through the very thin dead layer of the diode and create electron-hole pairs in the silicon segments.

In each individual segment, the charge separation due to the electron-hole pairs is measured as a current, which is used as a signal for image generation. Only electrons that have a high enough energy can create electron-hole pairs and can contribute to image generation. Electrons that have a lower energy (e.g. secondary electrons) are not detected by the BSD detector.

The emission of backscattered electrons from a specimen is related to the atomic number of the involved material: Elements with high atomic numbers generate more backscattered electrons (i.e. the backscatter coefficient is higher). When imaging, regions that contain elements with higher atomic numbers appear brighter. Regions that contain elements with lower atomic numbers appear darker.

Since the detector has a limited speed, it is recommended to use scan speed 6 or higher (slower), especially at small magnifications. The lower the gain is, the faster is the detector.

### 3.3.1.2.4 HDAsB Detector

**Purpose**
The HDAsB is an improved version of the angular-selective backscattered electron (AsB) detector. It is integrated into the objective lens and therefore also referred to as cap-mounted BSD.

**Function**
In comparison to the retractable BSD, the HDAsB detector allows operation at shorter working distances. The HDAsB detector is equipped with four diode quadrants that can be controlled independently using a dedicated menu. The HDAsB detector offers improved low kV capability because it has a thinner oxide layer than older versions of the AsB.

**Info**
The HDAsB detector enables BSE imaging at acceleration voltages above 1 kV.

The HDAsB detector has two operating modes:
- Compositional mode:
  produces images showing the atomic contrast of the specimen
- Topography mode:
  produces images showing the surface details of the specimen
3.3.1.3 YAG BSD Detector

**Purpose**  The YAG BSD detector is a scintillation type detector for backscattered electrons. The YAG BSD detector has a high sensitivity and is specifically designed for high speed imaging. It can be used in HV mode and in VP mode.

**Function**  The YAG BSD detector uses yttrium aluminum garnet (YAG) as a fast scintillation material that is mechanically and chemically resistant. Since it is a scintillation type detector, the YAG BSD detector does not have segments with changeable polarity and you can only use this detector for composition imaging. In comparison to segment based BSD detectors, the YAG BSD detector has a faster response time.

![YAG BSD detector](image)

*Fig. 54: YAG BSD detector*

![YAG BSD image of sandstone](image)

*Fig. 55: YAG BSD image of sandstone*

3.3.1.4 STEM Detector

**Purpose**  The optional STEM (Scanning Transmission Electron Microscopy) detector is an electron detector that can be used to detect transmitted and scattered electrons underneath an ultrathin specimen. The STEM unit is equipped with diodes that are switched on or off in order to allow dark field and bright field imaging.
**Product and Functional Description | 3.3 Optional Components and Accessories**

**Fig. 56: STEM detector**

1. Incident electron beam (primary electrons)
2. Thin specimen
3. Dark-field STEM detector; detector-to-specimen distance (2 to 4 mm recommended)
4. Bright-field STEM detector

**Info**

Risk of malfunction: The diode segments are sensitive to the light that is used for illumination in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If the CCD Mode is set to Auto Detect, then the TV illumination is automatically switched off when a diode detector is used.

**Function**

The STEM detector is a pneumatically retractable multi-mode detector with a 12-stub specimen holder for bright-field and dark-field detection. The STEM unit is equipped with semiconductor diodes that are switched on or off in order to allow dark-field and bright-field imaging. The diode area consists of four quadrants for the dark-field (DF) and one diode for the bright field (BF) imaging.

The “cone angles” of the BF and DF signals depend on the specimen as well as the illumination aperture. The center hole separates the DF and the BF signals, and the arrangement of the diodes allows simultaneous detection of the bright-field and dark-field signals without the need for realignment. Moving the detector in the Z-axis and changing the working distance makes it possible to obtain optimum separation of the signal. A detector-to-specimen distance in the range of 2 mm to 4 mm is recommended for optimum imaging results.

The STEM detector is used in cases where the thickness of a specimen is similar to or less than the dimensions of the interaction volume. The specimen must be mounted on a TEM grid with a thin carbon-film support (approximately 10 nm thick). Electrons that pass through the target can then be collected by the detector and used to form an image. The SmartSEM user interface allows to select different imaging modes (DF or BF). It is also possible to mix the DF and BF signals.
3.3.1.5 SCD Detector

Purpose  The specimen current detector (SCD) detects the current absorbed in the specimen.

Function  A highly sensitive amplifier is connected to the sample, measuring the sum of incoming PEs and outgoing SEs and BSEs for each image pixel.

Fig. 57: Silicon chip

3.3.1.6 CL Detector

Purpose  The Cathodoluminescence (CL) detector is an inclined detector that allows efficient visible or ultraviolet light collection. The CL detector is ideal for use in geology, mineralogy, and materials science applications where it can help in internal structural examination of rocks, ceramics, and semiconductors.

Function  The prerequisite for using this detector is that the specimen emits light when interacting with the primary electron beam. Differences in crystal structure or the presence of impurities in a cathodoluminescent material result in variations in the energy gap between the filled valence bands and the empty conduction bands, and consequently a change in the CL emission.

The light (photons) emitted by the specimen is collected by the CL detector and converted into a signal for imaging.

The CL detector is fully integrated into the automatic brightness and contrast control of the microscope and can be used simultaneously with any of the detectors without degrading their performance.

The detector can be used during energy-dispersive X-ray spectrometer (EDS) measurements and wavelength-dispersive spectrometer (WDS) measurements at any valid magnification.
### 3.3.2 Dual Joystick

**Purpose** The dual joystick is used for stage control and specimen navigation.

**Position** The dual joystick is placed on the microscope desk.

**Function**

All axes are deflection-compensated. When the joystick is moved only slightly, the respective axis moves slowly. Larger movements of the joystick result in a faster movement of the stage.

The X-, Y-, and Z-axes are magnification-compensated. When working at a low magnification, the stage moves relatively fast. At higher magnifications the stage movement is slower. The stage is moving with its maximum speed when viewing the specimen with the CCD (Charge Coupled Device) camera.

The different axes can also be moved simultaneously.
3.3.3 Control Panel

**Purpose**  The control panel allows direct access to 14 of the most frequently used functions. It integrates a full sized keyboard, 11 turning knobs, and 8 push buttons.

**Info**  The control panel facilitates daily routine tasks. All the functions can be applied by using the mouse and by macro execution also.

**Position**  The control panel is placed on the work desk.

![Control panel](image)

*Fig. 61: Control panel*

1. **Stigmator X | Stigmator Y**  
   Shapes the beam roundness by changing the stigmation deflectors.

2. **Aperture X | Aperture Y**  
   Adjusts the mid column shift and tilt deflectors for aligning the beam along the column axis.

3. **Scan Rotate**  
   Rotates the scanning pattern 360° continuously.  
   This turning knob has a push button function to deactivate the scan rotate function and reset the scan rotation to 0°.

4. **Shift X | Shift Y**  
   Shifts the scanned region of the specimen in the X and Y directions.

5. **Brightness | Contrast**  
   - **Brightness**  
     Adjusts the image acquisition chain offset for the currently selected detector. Each configured detector stores its own brightness.  
   - **Contrast**  
     Adjusts the gain of the currently selected detector.
6 Magnification | Reduced
   - Magnification
     Adjusts the magnification of the system.
   - Reduced
     Changes the scan field to a reduced area. The size of the area is determined by the current sub scan area settings.

7 Wobble
   Sweeps the acceleration voltage. If the aperture is slightly misaligned, a shift in X and/or Y direction can be observed.

8 Freeze
   Stops the scan and grabs one complete frame at the current imaging conditions.

9 Exchange | Resume
   - Exchange
     Starts the pre-defined macro for specimen exchange with the airlock.
   - Resume
     Starts the pre-defined macro to finish specimen exchange with the airlock.

10 Camera
   Switches to chamber view.

11 Focus | Scan Speed +/−
   - Focus
     Changes the focal point of the column by adjusting the magnitude of the objective lens.
   - Scan Speed +/−
     Increases (+) or decreases (−) the scan speed by doubling or halving the beam dwell time with each click step.
3.4 Software Description

3.4.1 SmartSEM User Interface

The SmartSEM software graphical user interface (GUI) allows you to monitor and operate most of the active components of the microscope.

The following screenshot indicates the main elements of the SmartSEM user interface:

![SmartSEM User Interface Screenshot]

1. **Title Bar**
   - Displays the name of the user interface and the logged-on user.

2. **Menu Bar**
   - Enables you to access to SmartSEM features via sub-menus.

3. **AVI Toolbar**
   - Contains the controls to set up, record, and playback video sequences of scanned images.

4. **Toolbar**
   - Provides quick access to SmartSEM tools.

5. **Image Area with Data Zone**
   - Displays image information and acquisition parameters from the microscope.

6. **Thumbnails Panel**
   - Displays thumbnail views of the contents of the eight image buffers.

---

*Fig. 62: Screen layout of the user interface*
### Status Bar
Displays the current machine state and contains the **SEM Control Buttons**.

### Data Zone
Displays image information and acquisition parameters from the microscope.

### Annotation Bar
Enables you to add information to the SEM image and provides several measurement functions.

### Panel Configuration Bar
Enables you to choose the panels to be placed in the **Docking Panel**.

### Docking Panel
Enables you to arrange frequently used SmartSEM panels for convenient access.

### Mini Bar
Provides quick access to recently used dialogs and to the recipe management.

#### 3.4.2 Graphical Control Elements

The following graphical control elements are used in the SmartSEM GUI.

<table>
<thead>
<tr>
<th>Screenshot</th>
<th>Control Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Tab](Screenshot Tab.png)</td>
<td>Tab</td>
<td>Provides a group of graphical control elements.</td>
</tr>
<tr>
<td>![Section](Screenshot Section.png)</td>
<td>Section</td>
<td>Forms a group of control elements with related functions.</td>
</tr>
<tr>
<td>![Button](Screenshot Button.png)</td>
<td>Button</td>
<td>Enables you to start an action.</td>
</tr>
<tr>
<td>![Checkbox](Screenshot Checkbox.png)</td>
<td>Checkbox</td>
<td>Enables you to activate or deactivate a function.</td>
</tr>
<tr>
<td>![Dropdown](Screenshot Dropdown.png)</td>
<td>Dropdown List</td>
<td>Enables you to select the desired element.</td>
</tr>
<tr>
<td>![Radio Button](Screenshot Radio Button.png)</td>
<td>Radio Button</td>
<td>Enables you to activate the desired option.</td>
</tr>
<tr>
<td>![Scrollbar](Screenshot Scrollbar.png)</td>
<td>Scroll Bar</td>
<td>Enables you to adjust a value by moving the scroll bar or pressing the arrow button until the desired value is set.</td>
</tr>
<tr>
<td>![Readout](Screenshot Readout.png)</td>
<td>Readout</td>
<td>Displays the status of a system entity. Enables you to select an action or a value by opening a dialog with an input field.</td>
</tr>
</tbody>
</table>
### Screenshot Control

<table>
<thead>
<tr>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input field</td>
<td>Enables you to enter the desired value.</td>
</tr>
<tr>
<td>Progress bar</td>
<td>Displays the progress of an action.</td>
</tr>
<tr>
<td>Slider</td>
<td>Enables you to adjust the corresponding function.</td>
</tr>
<tr>
<td>Navigation box</td>
<td>Provides visual indication of the range and current value of one- and two-dimensional parameters such as <strong>Beam Shift</strong> or <strong>Stigmation</strong>.</td>
</tr>
</tbody>
</table>

### 3.4.3 User Access Levels and User Privileges

The user access level defines which parameters are displayed for selection purposes, e.g. in the status window or annotation parameter selection.

SmartSEM distinguishes different user access levels. Depending on the user access level, different parameters are accessible. User profiles are defined by the administrator.

**Access:** *Menu Bar > Tools > Administrator*

<table>
<thead>
<tr>
<th>User Access Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Novice</td>
<td>Only the items assigned to the novice category are accessible. These include most frequently used parameters.</td>
</tr>
<tr>
<td>Expert</td>
<td>Items assigned to the novice and expert category are accessible. These include parameters useful for advanced operators.</td>
</tr>
<tr>
<td>Service</td>
<td>All items are accessible, also including infrequently used items and calibrations.</td>
</tr>
</tbody>
</table>

Additional to the user access levels there are user privileges which are part of the user profile:

<table>
<thead>
<tr>
<th>User Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration</td>
<td>Enables the user to perform instrument calibration operations.</td>
</tr>
<tr>
<td>Change Image Directory</td>
<td>Enables the user to change the location where all images are saved.</td>
</tr>
<tr>
<td>Change Toolbar</td>
<td>Enables the user to change the toolbar.</td>
</tr>
<tr>
<td>Change User Directory</td>
<td>Enables the user to change the location where all user specific parameters and configurations are saved.</td>
</tr>
<tr>
<td>Extractor</td>
<td>Enables the user to change the extractor voltage.</td>
</tr>
</tbody>
</table>
3.4 Software Description

### User Privilege Description

<table>
<thead>
<tr>
<th>User Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gun Align</td>
<td>Enables the user to modify the alignment of the electron beam.</td>
</tr>
<tr>
<td>Gun Off</td>
<td>Enables the user to switch off the field emission filament.</td>
</tr>
<tr>
<td>Stage Initialise</td>
<td>Enables the user to initialize the motorized stage.</td>
</tr>
</tbody>
</table>
| Supervisor     | Enables the user to perform the following actions:  
  - Start the Administrator, create and edit users  
  - Set User Max EHT  
  - Modify the filament current  
  - Set up, edit, and delete global stage coordinates  
  - Save common macros and toolbars  
  - Save common recipes  
  - Activate Partial Vent on Standby, Z Move on vent, Protect Z, Go to HV@Shutdown, EHT Off & Log Off, and Leave Gun ON at Shutdown.  
  - Use the bakeout function |
| Vent           | Enables the user to vent the specimen chamber. |

### 3.4.4 SmartSEM Program Suite

The SmartSEM Program Suite comprises the EM server, which implements the internal communication between control software and microscope hardware, plus several programs and utilities. The main purpose of the SmartSEM Program Suite is to access all necessary microscopy parameters and software features to capture SEM data and optimize image acquisition.

**Access:** Windows start menu > SmartSEM

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
</table>
| ChamberScope             | Enables you to display the chamberscope image and the detector image at the same time.  
  Option, requires particular hardware. |
| OptiProbe Calibration    | Calibration of OptiProbe after cathode replacement or realigning of the electron optical column |
| ReadMe                   | Contains important information on the currently installed version. |
| Release Notes            | Contains an overview of all SmartSEM versions including new developments and specific details. |
| RemCon32                 | Serial interface for remote operation via RS232, e.g. for EDX  
  License: REMCON |
| SampleHolder-Gallery     | Enables you to inspect the dimensions of all possible specimen holders as well as to set the dimensions of the custom specimen holders.  
  Enables you to activate the available specimen holders for SmartSEM. |
| SEM Drift Correction     | Enables you to compensate for the drift of the specimen by using a reference image and by controlling the beam shift.  
  License: DRIFT-CORR |
### Program Description

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slideshow speed setting</td>
<td>Enables you to adjust the slideshow speed for the Windows Photo Viewer.</td>
</tr>
<tr>
<td>SmartSEM Administrator</td>
<td>Enables you to manage user profiles and configure instruments.</td>
</tr>
<tr>
<td>SmartSEM User Accounting</td>
<td>Enables you to record important information during individual working sessions, e.g. logon/logoff time, number of TIFF files exported etc.</td>
</tr>
<tr>
<td>SmartSEM User Interface</td>
<td>Main software application</td>
</tr>
</tbody>
</table>

**Access:** Windows start menu > SmartSEM Service

### Program Description (Service activities, for ZEISS service representatives only)

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration Wizard</td>
<td>Service activities, for ZEISS service representatives only</td>
</tr>
<tr>
<td>Gun Monitor</td>
<td>Enables you to monitor important parameters of the microscope.</td>
</tr>
<tr>
<td>GUN Service</td>
<td>Service activities, for ZEISS service representatives only</td>
</tr>
<tr>
<td>Multi GIS Service</td>
<td>Service activities, for ZEISS service representatives only</td>
</tr>
<tr>
<td>Service Centre</td>
<td>Provides an overview of the state of the microscope.</td>
</tr>
<tr>
<td>Smart Stage Mapping</td>
<td>Service activities, for ZEISS service representatives only</td>
</tr>
<tr>
<td>SmartBackup Tool</td>
<td>Enables you to back up configuration and calibration data</td>
</tr>
<tr>
<td>Stage Administrator</td>
<td>Service activities, for ZEISS service representatives only</td>
</tr>
<tr>
<td>Upgrade Server Database</td>
<td>Service activities, for ZEISS service representatives only</td>
</tr>
</tbody>
</table>
4 Installation

Installation and commissioning are carried out by authorized ZEISS service representative. The installation requirements are to be observed and adhered to. After installation or retrofitting, thoroughly check that the Microscope System is in a safe operational state, making sure in particular that all protective covers (e.g. protection against laser radiation) have been installed.
5 Commissioning and First Operating Steps

This chapter describes the commissioning and the first operating steps of the Microscope System. Further information on operation is available in the Online Help of your software.

⚠️ WARNING

Tilting hazard when removing the microscope from the crate
When removing the microscope from the wooden crate, it can tilt and crush a person.
- Use a forklift to remove the microscope from the wooden crate.

⚠️ WARNING

Crushing hazard when lowering the microscope
The microscope and its components are heavy. When the load is lowered during transport and positioning, body parts can be crushed.
- Maintain a safe distance.
- Do not walk or place your hands or feet under the load while it is being lowered.
- Wear safety shoes and gloves.

Before the microscope is being unpacked the following safety warning have to be read and fully understood. These safety warnings have to be obeyed at any time by every person in the same room as the microscope.

⚠️ WARNING

Radiation hazard due to X-rays
X-rays are generated inside the microscope during operation. This is unavoidable because electrons are accelerated by voltages up to 30 kV.
- Do not remove any parts around the column and chamber that are essential for radiation protection.
- Use genuine ZEISS parts exclusively.
- Ensure that all local safety and X-ray protection regulations are met.
- Only authorized ZEISS service representatives are allowed to service the microscope.

⚠️ WARNING

Malfunction of medical devices near ion getter pumps
Magnetic fields present at the ion getter pumps may disturb the function of medical devices. The magnetic fields are also present if the microscope is switched off.
If you wear medical implants that are susceptible to magnetic fields (e.g. cardiac pacemakers), do the following:
- Keep a distance of at least 30 cm from the ion getter pumps.
- Follow the safety instructions provided by the pump manufacturer.
NOTICE

Damage during transport
Sensitive components of the microscope can get damaged during transport.
- The microscope may only be transported in air-suspended vehicles.
- Moving parts must be secured during transport to prevent them from slipping or tipping over.
- Install shock/tilt watches.
- Avoid rocking the crates back and forth.
- Devices for transporting the microscope must be rated to handle its full weight and dimensions. Note the weight information on the package and on the shipping document.
- Check that none of the items has been damaged during shipment.
- Otherwise contact your local ZEISS service representative.

5.1 Prerequisites for Commissioning and Operation

Read the instruction manual carefully before commissioning and keep the manual for further use.
- Basic training and safety briefing successfully completed.
- Chapter Safety read and understood.
- Familiar with general Windows® based programs.

5.2 Switching On the Microscope System

5.2.1 Energizing the Microscope

Before energizing the microscope make sure that the following safety warnings have been read and fully understood by each person who is in the same room as the microscope at any time:

WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.
- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

WARNING

Reaction products
Dangerous reaction products can be present in the specimen chamber during or after operation.
- Ensure that there is an appropriate exhaust gas line to remove the waste gas of the pre-vacuum pump and to transmit it to the outside.
- Wear lint-free gloves when touching the inner parts of the specimen chamber or the specimen.
Before energizing the microscope make sure that the following safety warnings have been read and fully understood by the person operating the microscope:

**WARNING**

**Residual voltage at the mains plug**

After unplugging the mains plug residual voltage is present at the pins of the plug which may cause electrical shock.

- After unplugging the mains plug wait at least 5 s before touching the pins of the mains plug.

**WARNING**

**High leakage current**

High leakage currents are present in the microscope. Contact may cause burn or electrical shock.

- Ensure proper grounding. For more information, refer to the Installation Requirements document.
- Do not operate the microscope without the separate ground connection.

**WARNING**

**Hazardous voltages inside the microscope**

Contact may cause electrical shock or burn.

Hazardous voltages are present inside the microscope as long as the power cord is plugged in or as long as the Main Switch of the EMO Circuit is in the ON position.

To completely cut off the microscope from any mains power:

- with installed EMO Circuit set the Main Switch to the OFF position.
- without EMO Circuit unplug the power cord by unplugging the CEE connector from the CEE FEMALE RECEPTACLE of the mains supply.

**WARNING**

**Restart after emergency off**

If the reason for the emergency off is not eliminated, it may be dangerous to restart the microscope.

- If the microscope has been de-energized due to an emergency, ensure that the reason for the emergency off does not exist anymore.
- Make sure it is safe to energize the microscope.

**Prerequisite**

- If the Emergency OFF (EMO) circuit is not installed:
  The microscope was de-energized by unplugging the CEE connector from the mains supply.
- If the EMO circuit is installed:
  The microscope was de-energized either by turning the Main Switch to the OFF position or by pressing the EMO button.

**Procedure**

1. Verify that the main shut-off valves for nitrogen at the facility installation are operable.
   - Otherwise unlock and open the main shut-off valves.
2. Make sure the circuit breakers (F10, F11) are in the upper position.

3. If the EMO circuit is not installed, plug the CEE connector into the CEE FEMALE RECEPTACLE of the mains supply.

4. If the EMO circuit is installed, pull the EMO button to release it.

5. Turn the Main switch counter-clockwise to the Reset position and then back via OFF to the ON position.

6. Press the green Start button.

5.2.2 Starting the Microscope

**Info**

If the system was powered off for a longer time period, the ion getter pump might fail to start. In this case, bake-out the gun head (supervisor user rights required) or contact your local service center. Refer to *Baking out the Gun Head* [138].
To start the microscope, you need to use the buttons at the front of the plinth and follow a defined procedure.

**Prerequisite**

The microscope is energized. The procedure depends on the mode in which the microscope is before the start-up:

- **OFF**: Only used if a reset was necessary
- **STANDBY**: If not in use, the microscope should be in this mode

**Procedure**

1. If the microscope is in the OFF mode, press the yellow STANDBY button at the front of the plinth.
   - The microscope goes into STANDBY mode.
   - The yellow STANDBY button lights up.

2. Press the green ON button.
   - The ON button blinks green while the system is activated.
   - When all subsystems are fully activated, the ON button lights up green permanently.

### 5.3 Starting the Software

**Procedure**

1. Power up the computer and log in.
2. Start the SmartSEM user interface via the ZEISS SmartSEM icon on the desktop. Alternatively, select Windows start menu > SmartSEM > SmartSEM User Interface.
   - The EM Server opens while loading various drivers. The EM Server implements the internal communication between software and hardware of the microscope.
   - The EM Server Log On dialog is displayed.
3. Enter the user name and password.
4. Click OK.
   - The SmartSEM user interface opens and is ready to operate the microscope.

#### 5.3.1 Calling up the Help

There are different ways to access topics in the Online Help.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut</th>
<th>Control Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup page</td>
<td>Help</td>
<td>F1</td>
<td>–</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Help &gt; Contents</td>
<td>Ctrl+F1</td>
<td>–</td>
</tr>
<tr>
<td>Context-sensitive</td>
<td>–</td>
<td>–</td>
<td>Question mark icon in the main window and in modal dialogs</td>
</tr>
</tbody>
</table>
Detailed information about using the help system is given in the Online Help directly.

### 5.3.2 Keyboard Shortcuts

The following keys are shortcut keys and have special meaning.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;F2&gt;</td>
<td>Toggles Tool Bar on/off</td>
</tr>
<tr>
<td>&lt;F2 + SHIFT&gt;</td>
<td>Hysteresis removal</td>
</tr>
<tr>
<td>&lt;F3&gt;</td>
<td>Closes all windows except the Tool Bar and Status Bar</td>
</tr>
<tr>
<td>&lt;F3 + SHIFT&gt;</td>
<td>Toggles PC Plane ON/OFF</td>
</tr>
<tr>
<td>&lt;F4&gt;</td>
<td>Step to next Magnification Table entry, or Undo Centre Feature Magnification</td>
</tr>
<tr>
<td>&lt;F4 + CTRL&gt;</td>
<td>Step to previous Magnification table entry</td>
</tr>
<tr>
<td>&lt;F4 + SHIFT&gt;</td>
<td>Exit from Magnification Table mode</td>
</tr>
<tr>
<td>&lt;F5&gt;, &lt;F5 + SHIFT&gt;</td>
<td>User defined macros</td>
</tr>
<tr>
<td>&lt;F6&gt;, &lt;F6 + SHIFT&gt;</td>
<td>User defined macros</td>
</tr>
<tr>
<td>&lt;F7&gt;, &lt;F7 + SHIFT&gt;</td>
<td>User defined macros</td>
</tr>
<tr>
<td>&lt;F8&gt;, &lt;F8 + SHIFT&gt;</td>
<td>User defined macros</td>
</tr>
<tr>
<td>&lt;F9&gt;</td>
<td>Keys help (displays this information)</td>
</tr>
<tr>
<td>&lt;F11&gt;, &lt;F11 + SHIFT&gt;</td>
<td>User defined macros</td>
</tr>
<tr>
<td>&lt;F12&gt;, &lt;F12 + SHIFT&gt;</td>
<td>Aborts Stage Movement</td>
</tr>
<tr>
<td>TAB</td>
<td>Toggle coarse/fine</td>
</tr>
<tr>
<td>CTRL + TAB</td>
<td>Performs Centre Point</td>
</tr>
<tr>
<td>CTRL + SHIFT + TAB &gt;</td>
<td>Performs Centre Feature</td>
</tr>
<tr>
<td>HOME</td>
<td>Resets Beam Shift to zero</td>
</tr>
<tr>
<td>SCROLL LOCK</td>
<td>Toggles Freeze/Unfreeze</td>
</tr>
<tr>
<td>PAUSE</td>
<td>Causes currently executing macro to continue</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Performs Find Image function</td>
</tr>
<tr>
<td>CTRL + 2&gt;</td>
<td>Loads Second Image Window from display</td>
</tr>
<tr>
<td>CTRL + A&gt;</td>
<td>Switches Annotation panel ON</td>
</tr>
<tr>
<td>CTRL + B&gt;</td>
<td>Display Toolbar View dialog</td>
</tr>
<tr>
<td>CTRL + D&gt;</td>
<td>Toggle Data Zone ON/OFF</td>
</tr>
<tr>
<td>CTRL + E&gt;</td>
<td>Calls the Export TIFF dialog</td>
</tr>
</tbody>
</table>
5.4 Acquiring an Image

Info

Mobile phones in the microscope room can cause image quality infringements and in worst case workflow interruptions.

This section describes basic procedures to obtain an image using the SE detector. To simplify the procedure, the description uses the SEM Controls panel and status bar functions in the SmartSEM software.

The procedure consists of the following steps:

- **Preparing the Specimen Holder** [84]
- **Loading the Specimen Chamber** [85]
- **Locating the Specimen** [89]
- **Switching on the Gun** [90]
- **Switching on the EHT** [90]
- **Acquiring an Image** [91]
5.4.1 Preparing the Specimen Holder

**Parts and Tools**

<table>
<thead>
<tr>
<th>Designation</th>
<th>Part no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hex key, 1.5 mm</td>
<td>Delivered with the microscope</td>
</tr>
<tr>
<td>Stub</td>
<td>Delivered with the microscope</td>
</tr>
<tr>
<td>Tweezers for specimen</td>
<td>Delivered with the microscope</td>
</tr>
<tr>
<td>Specimen holder</td>
<td>Delivered with the microscope</td>
</tr>
<tr>
<td>If necessary: carbon tape, conductive carbon,</td>
<td>–</td>
</tr>
<tr>
<td>adhesive metal tape, or similar</td>
<td></td>
</tr>
<tr>
<td>Appropriate specimen (with conducting properties,</td>
<td>–</td>
</tr>
<tr>
<td>e.g. gold on carbon)</td>
<td></td>
</tr>
<tr>
<td>Lint-free gloves</td>
<td>–</td>
</tr>
</tbody>
</table>

**WARNING**

**Biological hazards**

Biological substances may pose a threat to the health of humans and other living organisms.

- Keep a logbook of the biological substances loaded into the microscope and show it to the ZEISS service representatives before they perform any work on the microscope.

**WARNING**

**Aggressive or toxic chemicals**

Aggressive or toxic chemicals can cause chemical burns.

- When handling aggressive or toxic chemicals, wear suitable protective clothing, gloves, and eye/face protection.
- Do not eat, drink, or smoke while handling toxic chemicals.
- Refer to local safety regulations.
- Read and follow the instructions in the material safety data sheet of the chemical. The material safety data sheet can be obtained from the supplier of the chemicals.

**NOTICE**

**Environmental risk due to disposal of aggressive or toxic chemicals**

When disposing of aggressive or toxic chemicals, there is a threat of damage to the environment.

- When disposing of waste that has been generated during a service operation (e.g. used rotary pump oil), comply with all national and local safety and environmental protection regulations.
**NOTICE**

**Contamination caused by fingerprints**
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping times.
- Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

---

**Procedure**

1. To attach a specimen to the stub, use conductive carbon, adhesive metal tape, carbon tape, or similar. Ensure that the specimen area that you want to analyze is in proper contact with the stub.

2. To insert the stub into the specimen holder, use tweezers.

3. To fix the stub to the specimen holder, tighten the location screw with the hex key.

4. Note down which fix position is occupied by the specimen.

---

**5.4.2 Loading the Specimen Chamber**

**Info**

If your microscope is equipped with the optional airlock, use the airlock for loading the specimen chamber. For more information refer to the respective instruction manual.

The procedure consists of the following steps:
- *Displaying the SEM Control Panel* [86]
- *Driving the Stage to a Low Position* [86]
- *Venting the Specimen Chamber* [87]
- *Mounting the Specimen Holder* [87]
- *Evacuating the Specimen Chamber* [89]
5.4.2.1 Displaying the SEM Control Panel

**Prerequisite**
- The SmartSEM user interface is started.

**Procedure**
1. From the Menu Bar, select **Tools > Goto panel**.
   - The **Panel Configuration Bar** is displayed. It contains an alphabetical list of functions.
2. Double-right-click SEM Controls.
   - The SEM Controls panel is added to the docking panel.

5.4.2.2 Driving the Stage to a Low Position

⚠️ **CAUTION**

**Moving the specimen stage**
- Fingers can be trapped by the moving specimen stage.
  - Always close the chamber door before moving the specimen stage.
  - To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.

**Procedure**
1. In the toolbar, click the **TV** icon.
   - The inside of the specimen chamber is visible in the *Image Area*.

2. In the SEM Controls panel, select the **Stage** tab.
3. Activate the **Track Z** checkbox.
   - The current working distance (WD) is displayed in the **Data Zone**.
4. If the **Data Zone** is disabled, enable it via **Menu Bar > View > Data Zone > Show Data Zone**.
5. Use the dual joystick to drive the specimen stage downwards to a low position.
   - **NOTICE** Observe the stage movement via camera to avoid crashing.
5.4.2.3 Venting the Specimen Chamber

**WARNING**

**Suffocation hazard due to lack of oxygen**

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.

- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

**Procedure**

1. In the SEM Controls panel, select the **Vacuum** tab.
2. Click **Vent**.
   - The **Vent** message box is displayed.
3. To start venting, click **Yes**.

   **INFO:** If the **Stage is not initialized** system message is displayed, refer to *Initializing the Stage* [134].

   - The specimen chamber is purged with gaseous nitrogen.

5.4.2.4 Mounting the Specimen Holder

**WARNING**

**Suffocation hazard due to lack of oxygen**

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.

- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

**CAUTION**

**Moving the specimen stage**

Fingers can be trapped by the moving specimen stage.

- Always close the chamber door before moving the specimen stage.
- To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.

**CAUTION**

**Closing the chamber door**

Fingers can be pinched when closing the chamber door.

- Use the door handle to close the chamber door.
- Ensure not to get your fingers caught in the chamber door gap.
Driving the stage
While the stage is driven manually, there is a risk of damaging the objective lens and/or the specimen.

- Ensure not to hit the objective lens while driving the stage.
- Monitor the moving stage in TV mode.
- To stop the moving stage immediately, press F12 or press the Break push button of the dual joystick panel.
- Manually lower the stage before you open the chamber door. Alternatively, activate the Z move on Vent checkbox in the Stage tab of the SEM Controls panel.

Contamination caused by fingerprints
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping times.

- Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

Procedure
1. Carefully open the chamber door.

2. If a specimen holder is mounted onto the specimen stage, remove it by sliding it out of the dovetail rails.

3. Mount the prepared specimen holder by sliding it into the dovetail rails. Make sure that the dovetail is placed in the correct orientation so that the flat side of the dovetail of the specimen holder is flush with the milled edge of the specimen stage.

4. Check the chamber view to ensure the specimen does not hit any components when it is introduced into the specimen chamber.

5. Carefully close the chamber door.
   → The specimen holder and the specimen inside the chamber are visible in the Image Area.
5.4.2.5 Evacuating the Specimen Chamber

**Procedure**
1. In the SEM Controls panel, select the **Vacuum** tab.
2. Click **Pump**.
   \(\rightarrow\) Several vacuum status messages display the current vacuum levels.

5.4.3 Locating the Specimen

The procedure consists of the following steps:

- **Positioning the Stub under the Electron Beam** [89]
- **Moving the Specimen to the Proper Height** [89]

5.4.3.1 Positioning the Stub under the Electron Beam

**NOTICE**

**Driving the stage**

While the stage is driven manually, there is a risk of damaging the objective lens and/or the specimen.

- Ensure not to hit the objective lens while driving the stage.
- Monitor the moving stage in TV mode.
- To stop the moving stage immediately, press F12 or press the Break push button of the dual joystick panel.
- Manually lower the stage before you open the chamber door. Alternatively, activate the Z move on Vent checkbox in the Stage tab of the SEM Controls panel.

**Procedure**
1. In the **Stage Navigation Bar**, select **Stage Sideview** from the upper drop-down list and **Stage Topview** from the lower drop-down list.
   INFO: To open the Stage Navigation Bar, navigate to View > Toolbars and activate Stage Navigation Bar (for Widescreen users). Alternatively, you can access the Stage Navigation Bar via Stage > Navigation.
2. Click **Settings**.
   \(\rightarrow\) The Stage Navigation Settings dialog is displayed.
3. In the Stage Navigation Settings dialog, click **Show Holder Gallery**.
   \(\rightarrow\) The Sample Holder Gallery dialog is displayed.
4. In the Sample Holder Gallery dialog, click the specimen holder you are using.
5. Activate the Is Available checkbox.
6. Close the Sample Holder Gallery dialog.
8. In the Stage Topview section of the Stage Navigation Bar, spot the stub with the specimen you want to observe.
9. To drive the stub directly under the electron beam, double-click the stub.

5.4.3.2 Moving the Specimen to the Proper Height

**Procedure**
1. In the **Stage Navigation Bar**, drag the Zoom View slider to the right end, so that the schematics are zoomed in.
2. In the SEM Controls panel, select the Detectors tab.
3. In the Detectors section, select **USB TV1** from the Signal A drop-down list.
   \(\rightarrow\) The inside of the specimen chamber is visible in the Image Area.
4. Use the dual joystick to carefully move up the stage so that the stub you are using is in the center of the upper schematic.

**NOTICE** Observe the camera image in order not to crash into the pole piece.

### 5.4.4 Switching on the Gun

**NOTICE**

**Schottky field emitter**

If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime is reduced.

- Avoid switching off the gun during the working week.
- Use Standby mode for the weekend or a break of up to a week.
- When using the Standby mode, activate the Partial Vent on Standby function.

**Prerequisite** ✓ The chamber and the gun head have been evacuated.

**Procedure**

1. In the right part of the **Status Bar**, verify whether the gun is switched on or off.
   - If ✓ or ✓ is displayed, the gun is already switched on and you can skip the following steps.
   - If ✗ is displayed, the gun is switched off. Follow the operating steps within this chapter.
2. In the SEM Controls panel, select the **Vacuum** tab.
3. Verify that the **EHT Vac ready** readout is **EHT Vac ready = Yes**.
   - If not, the correct vacuum is not achieved. Check if the **Pump** procedure has been completed.
4. In the right part of the **Status Bar**, click ✗.
   - The pop-up menu for vacuum, gun, and EHT activation is displayed.
5. Click **Gun On** and monitor the gun vacuum.
   - The gun runs up.
   - This may take up to 5 minutes.

### 5.4.5 Switching on the EHT

When you switch on the EHT, the gun starts emitting electrons.

**WARNING**

**Radiation hazard due to X-rays**

X-rays are generated inside the microscope during operation. This is unavoidable because electrons are accelerated by voltages up to 30 kV.

- Do not remove any parts around the column and chamber that are essential for radiation protection.
- Use genuine ZEISS parts exclusively.
- Ensure that all local safety and X-ray protection regulations are met.
- Only authorized ZEISS service representatives are allowed to service the microscope.

**Prerequisite** ✓ The chamber and the gun head have been evacuated.

✓ The gun has been switched on.
**Procedure**

1. In the SEM Controls panel, select the **Vacuum** tab.
2. Check that **Vac Status = Ready** is displayed.
3. In the SEM Controls panel, select the Gun tab.
4. Double-click the **EHT Target** readout.
   - The **EHT Target** window is displayed.
5. In the input field, enter the required acceleration voltage in kV (e.g. 10) and click **OK**.
6. In the right part of the **Status Bar**, click **EHT: X**.
   - The pop-up menu for vacuum, gun, and EHT activation is displayed.
7. Click **EHT On**.
   - The EHT runs up to the set voltage.
   - In the right part of the **Status Bar**, the vacuum, gun, and EHT status buttons merge to **All**.

### 5.4.6 Acquiring an Image

**Info**

The following procedure describes the best way to quickly obtain an image without the control panel. You can also use the control panel to adjust aperture alignment, magnification/focus and brightness/contrast.

The procedure consists of the following steps:
- **Selecting the SE Detector** [91]
- **Setting a Fast Scan Speed** [92]
- **Setting a Low Magnification** [92]
- **Adjusting Brightness and Contrast** [92]
- **Visualizing Details on the Specimen Surface** [92]

#### 5.4.6.1 Selecting the SE Detector

**Procedure**

1. In the SEM Controls panel, select the Detectors tab.
2. In the Detectors section, select **Signal A = SE2** from the **Signal A** drop-down list.
   - **INFO**: We recommend using the SE detector to obtain the first image. This detector provides a good signal-to-noise ratio even at long working distances.
5.4.6.2 Setting a Fast Scan Speed

Procedure
1. In the SEM Controls panel, select the Scanning tab.
2. From the Scan Speed drop-down list, select a fast scan speed, e.g. Scan Speed = 3.
INFO: The lower the scan speed number, the faster the electron beam scans across the specimen. Scan Speed = 3 allows you to get an image quickly.

5.4.6.3 Setting a Low Magnification

Procedure
1. In the Toolbar, select the MAGFOC icon.
   ➔ In the Status Bar, the current magnification and working distance are displayed.
2. Hold down the left mouse button and drag the mouse within the Image Area to adjust the magnification to 500 x.
3. Hold down the mouse wheel and drag the mouse within the Image Area to adjust the working distance and focus the image.

5.4.6.4 Setting a Long Working Distance

Procedure
1. In the Status Bar, click Mid: WD =.
   ➔ The WD window is displayed.
2. In the WD input field, enter 10.
3. Click OK.
   ➔ The working distance is set to WD = 10 mm.

5.4.6.5 Adjusting Brightness and Contrast

Procedure
1. In the SEM Controls panel, select the Detectors tab.
2. In the Signal Adjust section, use the scroll bars to adjust brightness and contrast.

5.4.6.6 Visualizing Details on the Specimen Surface

Procedure
1. Select a detail on the specimen surface.
2. Verify the Magnification/Focus function is activated.
3. To adjust the magnification, hold down the left mouse button and drag the mouse within the **Image Area** in left/right direction.
   → The current magnification is indicated in the **Status Bar**.

4. To adjust the focus, change the working distance. Hold down the mouse wheel and drag the mouse within the **Image Area** in left/right direction.
   → The current working distance is indicated in the **Status Bar**.

5. Adjust contrast and brightness again.

### 5.4.7 Optimizing the Image

Once you have generated an initial image, you can adjust various parameters to optimize the image.

**Info**

The following procedure describes the best way to quickly optimize the image without the control panel. You can also use the control panel to adjust aperture alignment, magnification/focus and brightness/contrast.

The procedure consists of the following steps:
- **Adjusting the Magnification** [93]
- **Moving the Field of View at High Magnifications** [93]
- **Limiting the Scan Field** [94]
- **Aligning the Aperture** [94]
- **Selecting the Scan Speed** [95]
- **Correcting Astigmatism** [95]

#### 5.4.7.1 Adjusting the Magnification

**Procedure**

1. To switch to the Coarse mode, in the **Status Bar**, click ![Fine](Image)
   → The ![Fine](Image) button changes to ![Coarse](Image).

2. Step by step, raise the magnification to 50,000 x and focus in between.
   To adjust the magnification and the focus, hold down the left mouse button or the mouse wheel, respectively, and drag the mouse within the **Image Area**.

#### 5.4.7.2 Moving the Field of View at High Magnifications

If you want to move the field of view at high magnifications, use the **Beam Shift** function instead of moving the stage.

**Procedure**

1. In the SEM Controls panel, select the Apertures tab.
2. Click **Beam Shift**.
3. To shift the beam, in the Beam Shift navigation box, use the scroll bars or the red marker.
5.4.7.3 Limiting the Scan Field

Prerequisite ✓ Adjusting the size and position of the small frame (reduced raster) requires the license REDUCED.

Procedure 1. In the Toolbar, click the REDUCE icon.
   A small scan frame is displayed. This frame defines the specimen area to be scanned by the electron beam.
   The image outside the scan frame is frozen.

2. To change the position of the scan frame, click on the green border line and use the mouse to drag and drop the frame.
3. To change the size of the scan frame, click on the small blue squares on the green border line and drag them to the desired size.
4. Focus the image in the reduced raster.

5.4.7.4 Aligning the Aperture

Info Alternatively to aligning the aperture manually, use the Auto Wobble function via toolbar icon.

Procedure 1. In the SEM Controls panel, select the Apertures tab.
2. Activate the Focus Wobble checkbox.
   INFO: Focus wobble is a function that sweeps the acceleration voltage. If the aperture is misaligned, a lateral and vertical shift can be observed.
3. To adjust the wobble intensity, use the Wobble Amplitude scroll bar.
4. To accelerate the wobble speed, activate the Wobble Fast checkbox.
5. Click Aperture Align.
6. In the Aperture Align navigation box, use the scroll bars or the red marker to adjust the aperture alignment until there is no movement of the detail in X- and Y-direction.
   INFO: The specimen detail should just be pulsating without shifting.
7. Deactivate the **Focus Wobble** checkbox.

8. Refocus the image.

**5.4.7.5 Selecting the Scan Speed**

**Procedure**

1. In the **Toolbar**, from the **Faster/Slower** drop-down list, select **Scan Speed = 7**.
   
   Alternatively, in the SEM Controls panel, select the Scanning tab, and from the **Scan Speed** drop-down list, select **Scan Speed = 7**.
   
   The scan speed is set to **Scan Speed = 7**.

2. Bring the image into focus.

3. Toggle between Coarse and Fine mode in the **Status Bar**, as appropriate.

**5.4.7.6 Correcting Astigmatism**

**Procedure**

1. Ensure that the **Reduced Raster** function is active.

2. Select a detail (e.g. a mark or an edge) on the specimen surface. Ensure that the selected detail is in the raster. You can move the stage or shift the beam for this purpose.

3. In the SEM Controls panel, select the Apertures tab.

4. Click Stigmation.

5. In the **Stigmation** navigation box, use the scroll bars or the red marker to obtain the sharpest possible image.
   
   **INFO:** The specimen detail should just be pulsating without shifting.
   
   **INFO:** To obtain optimum results, alternately correct focus and astigmatism.

6. To deactivate the reduced raster, in the **Toolbar**, click the **REDUCE** icon.
5.4.8 Saving the Image

**Procedure**

1. In the SEM Controls panel, select the **Scanning** tab.
2. Select **Freeze on = End Frame** from the drop-down list.
3. Click **Freeze**.
   - A red dot at the right bottom of the **Image Area** indicates that the image is frozen.
4. From the **Menu Bar**, select **File > Save Image**.
   - The **Export TIFF** dialog is displayed.
5. To change the save path, click **Change Directory**.
   - A file explorer window is displayed.
6. To confirm the selected path, click **Select Folder**.
7. Enter the filename in the **Filename** input field.
8. Click **Save <file name>.tif**.
9. To continue imaging, click **Unfreeze** in the **Scanning** tab.

5.5 Modifying Gun Parameters

5.5.1 Selecting the Gun Mode

The microscope can operate in different gun modes:

- **Imaging**
- **Analytic**

**Imaging Gun Mode**

In Imaging gun mode, the temperature of the Schottky emitter and the extraction voltage are reduced in comparison to the Analytic gun mode. This leads to a reduction of the energy spread of the primary electrons.

Imaging gun mode is suitable for lower probe currents. Imaging gun mode is especially useful at low kV to reduce chromatic aberration and to achieve a better resolution.
Analytic Gun Mode

Analytic gun mode is suitable for higher probe currents. Overall, the probe current in Analytic gun mode is about twice the probe current in Normal gun mode.

**Info**

After switching the gun mode, you can immediately work with the selected gun mode. For applications, which require a high probe current stability, wait 24 hours until a stability of 0.2 %/h is reached. It is recommended not to change the gun mode during quantitative specimen analysis.

**Procedure**

1. In the SEM Controls panel, select the **Gun** tab.
2. To switch to Imaging mode, click **Imaging**.
3. To return to Analytic mode, click **Analytic**.

### 5.5.2 Measuring the Probe Current

The probe current is the current that flows through the specimen. It corresponds to the total number of electrons that hit the specimen.

Measuring the probe current using the Faraday cup ensures that the current displayed in the software equals the incident probe current. The Faraday cup consists of a strongly absorbing material with a cavity covered by a small aperture. If the beam is focused in this cavity, no secondary electrons and no backscattered electrons leave the Faraday cup.

**Parts and Tools**

<table>
<thead>
<tr>
<th>Designation</th>
<th>Part no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faraday cup</td>
<td>348342-8055-000</td>
</tr>
</tbody>
</table>

**Procedure**

1. Load the Faraday cup into the specimen chamber. Refer to *Loading the Specimen Chamber [85]*.
2. Evacuate the specimen chamber.
3. Switch on the gun. Refer to *Switching on the Gun [90]*.
4. Switch on the EHT. Refer to *Switching on the EHT [90]*.
5. Set a magnification that allows transmission of the complete electron beam into the cavity of the Faraday cup through the aperture of the Faraday cup.
6. From the **Panel Configuration Bar**, select **Specimen Current Monitor**.
   → The **Specimen Current Monitor** window is displayed.
7. Activate the **SCM On** checkbox.

   ![Specimen Current Monitor](image)

   **Specimen I**

   **SCM Status**

   [SCM On] [Spot]

8. Activate the **Spot** checkbox.
   → Green crosshairs are displayed on the image. The crosshairs indicate the position of the beam spot.
9. Grab the crosshairs and move them into the hole of the Faraday cup.
   → The probe current is measured continuously.
   → The measured probe current is displayed in the **Specimen I** readout.
5.5.3 Setting the Probe Current

You can set a lower probe current to analyze surface details at a high resolution or higher probe currents for analytical purposes, e.g. to analyze the material of the specimen.

**Info**

The maximum achievable probe current depends on the currently selected EHT and the installed aperture configuration.

**Procedure**

1. In the SEM Controls panel, select the Gun tab.
2. Activate the **OptiProbe** checkbox.
3. Double-click the **I Probe** readout.
   - The **I Probe** window is displayed.
4. In the input field, enter the desired value.

5.5.4 Continuously Modifying the Probe Current (License: OPTIPROBE)

**Info**

OptiProbe allows you to continuously adjust the probe current. The function automatically selects a suitable aperture and the current mode while the extractor voltage is adjusted to meet the probe current selected by the user.

**Info**

After cathode replacement or after re-alignment of the electron optical column, OptiProbe has to be calibrated.

**Prerequisite**

- Requires the licenses OPTIPROBE and HIGH VOLTAGE
- Particular hardware and the specimen current amplifier are installed.

**Procedure**

1. In the SEM Controls panel, select the Gun tab.
2. Activate the **OptiProbe** checkbox.
3. Use the **I Probe** slider to set the desired probe current.
   - As soon as the probe current adjustment is finished, the **OptiProbe Status** readout changes from **Busy** to **Ready**.
   - The probe current displayed in the **I Probe** readout corresponds to the actual probe current (± 15 %).
4. To deactivate the function, deactivate the **OptiProbe** checkbox.
   
   **INFO:** If **OptiProbe** is deactivated, the **I Probe** readout continues to indicate the actual probe current (± 15 %).

5.5.5 Changing the Extractor Voltage

The Extractor voltage is preset by the factory or by the ZEISS service representative. Within certain limits, the operator may carefully increase the extractor voltage in order to optimize the probe current for particular applications.

**Info**

Use a Faraday cup to measure the probe current when changing the extractor voltage.
5.6 Finding Appropriate Detector Settings

5.6.1 Selecting a Detector

You need to select an appropriate detector depending on the application and the pressure mode. In addition to the standard SE detector, several optional detectors are available.

For information on special set-up procedures for the detectors, refer to:

- Setting up the InLens SE Detector [100]
- Setting up the InLensDuo Detector [100]
- Setting up the SE Detector [101]
- Setting up the VPSE Detector [102]
- Setting up the C2D Detector [103]
- Setting up the HDAsB Detector [105]
- Setting up the aBSD1-LH Detector [104]
- Setting up the Manually Insertable BSD Detector [107]
- Setting up the YAG BSD Detector [108]
- Setting up the CL Detector [108]
5 Commissioning and First Operating Steps | 5.6 Finding Appropriate Detector Settings

**Procedure**
1. Select the Detectors tab of the SEM Controls panel.
2. Select the detector from the **Signal A** dropdown list.

**5.6.2 Setting up the InLens SE Detector**

The InLens SE detector collects the SE signal, acquiring mainly information about surface topography.

![Silver nanoparticles embedded in zeolite, imaged at 1.5 kV.](image)

The following settings are recommended for the InLens SE detector:

<table>
<thead>
<tr>
<th>EHT</th>
<th>Typical WD</th>
<th>Recommended WD</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 V – 10 kV</td>
<td>0–5 mm *</td>
<td>Short working distances are preferable for good detection efficiency</td>
</tr>
<tr>
<td>10 kV – 20 kV</td>
<td>2–5 mm</td>
<td></td>
</tr>
</tbody>
</table>

* At EHTs between 20 V and 0.5 kV, a WD of exactly 0 is not possible.

**Info**

Avoid strong specimen tilting for the InLens SE detector.

**Procedure**
1. In the SEM Controls panel, select the Detectors tab.
2. From the **Signal A** drop-down list, select **InLens**.
3. Adjust the EHT and the working distance (WD) according to the suggestions in the table in order to optimize the image.

**5.6.3 Setting up the InLensDuo Detector**

The InLens Duo detector allows imaging and mixing of a high contrast topography (SE) as well as clear compositional contrast (BSE). In the BSE image, heavy elements are represented by brighter pixels and light elements are represented by darker pixels. By adjusting the filtering grid, energy-selected BSE images can be obtained. If the filtering grid voltage is set to 0, SE and BSE mixed images can be acquired.
The following settings are recommended for the InLensDuo detector:

<table>
<thead>
<tr>
<th>EHT</th>
<th>Typical WD</th>
<th>Filtering Grid</th>
</tr>
</thead>
<tbody>
<tr>
<td>500 V – 10 kV</td>
<td>0–5 mm</td>
<td>BSE Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>InLensDuo Grid &gt; 400 V to filter out the SE signal</td>
</tr>
<tr>
<td>20 V – 500 V</td>
<td>0–3 mm</td>
<td>SE Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>InLensDuo Grid = 0 V for the use as an additional SE detector, like an InLens SE detector, refer to Setting up the InLens SE Detector [100]</td>
</tr>
</tbody>
</table>

**Info**

- Short working distances are preferable for good detection efficiency.
- Avoid strong specimen tilting for the InLens Duo detector.

**Procedure**

1. In the SEM Controls panel, select the Detectors tab.
2. From the **Signal A** drop-down list, select **InLensDuo**.
3. To work in BSE mode, activate **BSE Mode**.
   To work in SE mode, deactivate **BSE Mode**.
4. Adjust the EHT, the working distance (WD) and the InLens Duo grid voltage according to the suggestions in the table in order to optimize the image.

**5.6.4 Setting up the SE Detector**

The SE detector collects the SE signal, highlighting the topography of the specimen.
The following settings are recommended for the SE detector:

<table>
<thead>
<tr>
<th>EHT</th>
<th>Typical WD</th>
<th>Collector Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>500 V – 5 kV</td>
<td>2–8 mm</td>
<td>Adjustable from −250 V to +400 V</td>
</tr>
</tbody>
</table>
| 5 kV – 30 kV | min. 6 mm  | Standard applications: +300 V  
At a high magnification, you can optimize the image by varying the collector voltage.  
Pseudo-backscattered (BSE) image: −250 V to −50 V  
This produces a topographic image of the sample with no material contrast. |

**Procedure**

1. In the SEM Controls panel, select the Detectors tab.
2. From the **Signal A** drop-down list, select **SE2**.
3. Adjust the EHT, working distance (WD), and collector voltage according to the suggestions in the table in order to optimize the image.

**Info**

For detailed information on working with the SE detector refer to *Acquiring an Image* \(^83\).

### 5.6.5 Setting up the VPSE Detector

The VPSE detector is designed for VP applications. The VP mode enables analyzing and imaging of non-conducting, strongly gassing or moist specimens without any need for specimen preparation.

**Fig. 67: A rosemary leaf.**
The following settings are recommended for the VPSE detector:

<table>
<thead>
<tr>
<th>EHT</th>
<th>Typical WD</th>
<th>VPSE Bias</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 kV – 30 kV</td>
<td>7–10 mm</td>
<td>Adjustable from 0 to 100 %</td>
</tr>
</tbody>
</table>

**Prerequisite**  
The microscope is operating in VP vacuum mode

**Procedure**
1. In the SEM Controls panel, select the Detectors tab.
2. From the **Signal A** drop-down list, select **VPSE G4**.
3. Adjust the EHT, working distance (WD), and VPSE bias according to the suggestions in the table in order to optimize the image.

### 5.6.6 Setting up the C2D Detector

![C2D image of radiolaria](image)

**Procedure**
1. In the SEM Controls panel, select the **Detectors** tab.
2. From the **Signal A** drop-down list, select **C2D**.
3. Open the **Panel Configuration Bar**.
4. Double-click **C2D Control** to open the **C2D Control** panel.
5. Select **C2D Gain = Low**.
6. Adjust the **C2D Bias** scroll bar until you reach saturation.
7. Click **C2D Auto Level**.
   - If you are unable to reach saturation or if the image quality is not good, repeat the procedure in high gain.
5.6.7 Setting up the aBSD1-LH Detector

The aBSD1-LH detector is a pneumatically retractable backscattered electron detector which is inserted below the objective lens and is used for high efficiency and angle selective material characterization.

![Fig. 69: BSE images of NdFeB magnet surface showing different contrast on different segments of the aBSD1-LH detector. The inner segment S1 shows combined material contrast and topography (left). The outer segment S2-S5 shows mainly topography (right).]

The following settings are recommended for the aBSD1-LH detector:

<table>
<thead>
<tr>
<th>EHT</th>
<th>Typical WD</th>
<th>Detector Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5–30 kV</td>
<td>5–12 mm</td>
<td>Compositional mode for obtaining an image that is high in atomic number contrast</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use topographic mode for showing surface details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use individual settings for channeling contrast</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make use of different concentric rings of the detector to get angular resolved BSE images</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use high or very high detector gain for low accelerating voltage and/or low beam current</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The EHT should be bigger than 2 kV to achieve a significant detection efficiency.</td>
</tr>
</tbody>
</table>

Procedure

1. From the Panel Configuration Bar, select BSD Control.
   The BSD Control panel enables you to change the polarity of the segments, select BSD modes, and set the BSD gain.
   → The BSD Control panel is displayed.
2. In the BSD Control panel, click BSD in to insert the detector.
   → The stage is lowered by 20 mm to give space for the detector to be inserted.
   → The detector is inserted.
3. In the SEM Controls panel, select the Detectors tab.
4. From the Signal A drop-down list, select BSD1 or BSD4 A depending on your detector type and configuration.
   INFO: A refers to the video channel. B, C, and D are also available if you have the four-channel version.
5. Adjust the EHT and the working distance (WD) according to the suggestions in the table in order to optimize the image.
6. In the BSD Control panel, click a quadrant symbol to toggle its status between on (white), inverted (black), and off (gray).
7. To choose the respective mode, click BSD: COMPO or BSD: TOPO. The default setting for aBSD1-LH is BSD: COMPO. All five segments (S1–S5) are set to on and an image that is high in atomic number contrast is obtained. The default mode for BSD: TOPO is S1 off, S2 on, S3 on, S4 inv and S5 inv.

8. If you want to change the default setting to BSD: TOPO, click BSD: Set TOPO.

9. From the BSD Gain drop-down list, select Low, Medium, High, or Very High. INFO: Since the detector has a limited speed, it is recommended to use scan speed 6 or higher (slower), especially at small magnifications. The lower the gain is, the faster is the detector.

5.6.8 Setting up the HDAsB Detector

The HDAsB detector is optionally available.

The HDAsB detector enables four outputs that can be used either for compositional imaging or for topographical imaging.

---

**Fig. 70: The crystalline structure of a silicon device**

The following settings are recommended for the HDAsB detector:

<table>
<thead>
<tr>
<th>EHT</th>
<th>Typical WD</th>
<th>Detector Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5 kV – 30 kV</td>
<td>3–10 mm</td>
<td>- Use compositional mode for obtaining an image that is high in atomic number contrast.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Use topography mode for showing surface details.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Use individual settings for channeling contrast.</td>
</tr>
</tbody>
</table>
Procedure

1. In the SEM Controls panel, select the Detectors tab.

2. From the Signal A drop-down list, select HDAsB.

3. To open the Panel Configuration Bar, from the Menu Bar, select Tools > Goto Panel. → The Panel Configuration Bar is displayed. It contains an alphabetical list of functions.

4. Double-click BSD Control. → The BSD Control dialog is displayed. → In the upper section, the BSD Control dialog displays the four quadrants/outputs.

5. Click a quadrant symbol to toggle its status between on (white), inverted (black), and off (gray).

6. To confirm the settings, click Apply.

7. To choose the respective mode, click BSD: COMPO or BSD: TOPO. The default setting for HDAsB is BSD: COMPO. All four segments are set to on and an image is obtained, which is high in atomic number contrast.

8. If you want to change the default setting to BSD: TOPO, click BSD: Set TOPO.

9. From the BSD Gain drop-down list, select the appropriate BSD Gain: Low, Medium, High, or Very High. The BSD Gain depends on the signal strength.
5.6.9 Setting up the Manually Insertable BSD Detector

This procedure applies to all manually insertable BSD detectors apart from the YAG BSD detector.

**Procedure**

1. Pull up the pin at the detector.

2. Carefully push in the detector while checking with the chamber scope camera to make sure there is nothing in the way.

3. Release the pin.

4. In the **Detectors** tab of the **SEM Controls** panel, select the respective detector from the **Signal A** drop-down list.

5. Open the **Panel Configuration Bar**.

6. Double-click **BSD Control** to open the **BSD Control** panel.

   **INFO:** The **BSD Control** panel allows you to change the polarity of the segments, select BSD modes and set the BSD gain.

7. Click a segment symbol to change its status between on (white), inverted (black), or off (gray).

8. To select compositional mode, click **BSD: COMPO**.

9. To select topography mode, click **BSD: TOPO**.

10. Select the **BSD Gain** from the drop-down list.
5.6.10 Setting up the YAG BSD Detector

**NOTICE**

**Inserting the YAG BSD detector**

When you manually insert the detector, there is a risk to damage the YAG BSD detector.

- Use the chamberscope image to observe if there is enough space between the objective lens and the specimen.
- If there is not enough space between the objective lens and the specimen, then lower the stage position before you insert the detector.
- Insert the YAG BSD detector carefully and observe the moving YAG BSD detector via the chamberscope.

**Procedure**

1. Insert the detector.
   - If there is any resistance, make sure the silver knob is untightened.

2. In the SEM Controls panel, select the **Detectors** tab.
3. From the **Signal A** drop-down list, select **YAG BSD**.
4. To optimize the image, adjust brightness and contrast. There are no further parameters to change.
5. After use, retract the detector.
   - **INFO**: Because of the detector’s weight, there is only little risk for it to accidentally slide in. Therefore, you do not have to fix the silver knob.

5.6.11 Setting up the CL Detector

The CL detector is optionally available.

The CL detector collects visible or ultraviolet light and is especially useful for internal structural examinations of rocks, ceramics, and semiconductors.

*Fig. 71: Zircon grains*
The CL signal is usually very weak and the resolution of the CL image is much worse than an SE image. Use the SE detector to navigate and focus before acquiring CL images.

The following settings are recommended for the CL detector:

<table>
<thead>
<tr>
<th>EHT</th>
<th>Typical WD</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 kV – 30 kV</td>
<td>6–10 mm (min. 4 mm)</td>
</tr>
</tbody>
</table>

**Procedure**

1. In the SEM Controls panel, select the Detectors tab.
2. From the Signal A drop-down list, select CL.
3. Adjust the EHT and the working distance (WD) according to the suggestions in the table in order to optimize the image.

### 5.7 Working with Variable Pressure

VP mode offers the possibility of analyzing and mapping non-conducting, strongly gassing or moist specimens without any need for specimen preparation.

**Info**

In VP mode, the InLens SE detector, the InLensDuo detector, and the SE detector cannot be used.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Booster</th>
<th>Chamber Pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Vacuum HV</td>
<td>On</td>
<td>&lt; 10⁻² Pa</td>
</tr>
<tr>
<td>Variable Pressure VP</td>
<td>Off</td>
<td>2–133 Pa</td>
</tr>
</tbody>
</table>

*Tab. 4: VP configuration*

#### 5.7.1 Changing to Standard VP Mode

**Info**

If the VP system has not been used for several days, start with moderate pressure up to 30 Pa for the first 10 minutes. Afterwards the vacuum system is conditioned and the VP mode can be used with its full range.

**Info**

A higher pressure can be set within a few seconds. Achieving a lower pressure may require some more time, because the specimen chamber has to be evacuated by the pre-vacuum pump.

**Prerequisite**

- The microscope is operating in HV vacuum mode

**Procedure**

1. In the SEM Controls panel, select the Vacuum tab.
2. In the Variable Pressure section, click VP.
   - The system sets the chamber pressure to the value displayed in the VP Target field. If you have not changed it, it is the value of the last VP session.
3. Wait until the system is ready for VP operation and Chamber Status = At VP is displayed.
   → This takes approximately 20 s.
4. To change the chamber pressure, use the VP Target scroll bar. Alternatively double-click into the VP Target field, enter desired pressure value and click OK.
   Refer to Working with Variable Pressure [109] to determine the correct pressure value.

5.7.2 Returning to HV Mode

HV mode is the standard mode of a FESEM. It offers the possibility of analyzing and mapping conducting specimens. In HV mode, the pressure in the specimen chamber is less than $10^{-6}$ mbar.

Info

When switching from VP to HV mode, the column chamber valve closes automatically, as a relatively poor vacuum is available in the specimen chamber when opening the TIV.

Prerequisite
→ The microscope is operating in VP vacuum mode

Procedure
1. In the SEM Controls panel, select the Vacuum tab.
2. In the Variable Pressure section, click HV.
   → The transition is indicated in the status bar of the SmartSEM software. This takes approximately 20 s.

5.8 Working with Optional Accessories

5.8.1 Using the Optional Airlock

5.8.1.1 Unloading the Specimen Using an Airlock

You can unload the specimen either manually or with pre-defined airlock macros to simplify the specimen exchange.

This procedure consists of the following steps:
- Driving the specimen holder to the transfer position.
  Either refer to Driving to Transfer Position via Airlock Macros [110] or to Driving to Transfer Position without Airlock Macros [111].
- Unloading the Specimen Holder from the Airlock [112]

5.8.1.1.1 Driving to Transfer Position via Airlock Macros

Prerequisite
→ A specimen is loaded in the specimen chamber and is to be exchanged for another specimen.

Procedure
1. To open the Stage Navigation Bar, navigate to View > Toolbars and activate Stage Navigation Bar (for Widescreen users). Alternatively, you can access the Stage Navigation Bar via Stage > Navigation.
   → The Stage Navigation Bar is displayed.
2. From the Panel Configuration Bar, select Airlock.
3. Click Specimen Change to start the pre-defined macro.
   INFO: The airlock macros can be modified according to your individual requirements. Contact your local ZEISS service representative for assistance.
   The macro automatically performs the following actions:
   → The EHT is switched off.
The column chamber valve is closed in order to separate gun head area and specimen chamber.

The specimen stage is driven to the transfer position.

The airlock is evacuated.

The gate valve opens.

The illumination is turned on in the airlock chamber.

5.8.1.1.2 Driving to Transfer Position without Airlock Macros

**Prerequisite**

- A specimen is loaded in the specimen chamber and is to be exchanged for another specimen.

**Procedure**

1. Switch off the EHT.

2. To open the Stage Navigation Bar, navigate to View > Toolbars and activate Stage Navigation Bar (for Widescreen users). Alternatively, you can access the Stage Navigation Bar via Stage > Navigation.

   - The Stage Navigation Bar is displayed.

3. From the Panel Configuration Bar, select Airlock.

4. Click Close Column Chamber Valve.

   - The column chamber valve is closed in order to separate gun head area and specimen chamber.

5. Select Stage Points List from the Panel Configuration Bar.
6. Double-click **$Exchange**.

**NOTICE** If the stage is at a short working distance, there is a risk to damage the microscope or the specimen. Ensure there is enough space between objective lens and specimen before moving the specimen stage.

- The specimen stage is driven to the transfer position.

7. To change to **Transfer** mode, click **Transfer** in the **Airlock** panel. Alternatively, on the control panel, press **Transfer**.

- The airlock is evacuated.
- The gate valve opens.
- The illumination is turned on in the airlock chamber.

### 5.8.1.1.3 Unloading the Specimen Holder from the Airlock

**WARNING**

Suffocation hazard due to lack of oxygen

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.

- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

**Procedure**

1. To transfer the specimen holder from the specimen chamber into the airlock, insert the airlock rod.

2. Turn the knob clockwise to attach the specimen holder to the airlock rod.

3. Retract the airlock rod.
4. On the control panel, press **Vent**, to change to **Vent** mode. Alternatively, click **Vent** in the **Airlock** panel.

5. Take hold of the airlock handle and open the airlock door.

6. To exchange the whole specimen holder, Turn the knob counter-clockwise and detach the specimen holder from the airlock rod.

7. Remove the specimen holder from the dovetail.

8. Mount the exchange specimen holder onto the dovetail. Ensure that the airlock rod mount faces the threaded rod.
9. Attach the specimen holder to the airlock rod by turning the knob clockwise.

### 5.8.1.2 Loading the Specimen Using an Airlock

You can load the specimen either manually or with pre-defined airlock macros to simplify the specimen exchange.

**Info**

If you want to use a navigation camera at the airlock to navigate the stage, you have to acquire an overview image before the sample holder is introduced into the specimen chamber.

This procedure consists of the following steps:
- **Loading the Specimen Holder into the Airlock**
- Closing the gate valve and opening the column chamber valve
  
  Either refer to *Controlling the Valves via Airlock Macros* [p. 116] or to *Controlling the Valves without Airlock Macros* [p. 117].

### 5.8.1.2.1 Loading the Specimen Holder into the Airlock

**WARNING**

*Suffocation hazard due to lack of oxygen*

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.
- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

**Prerequisite**

- The airlock is vented
- The correct specimen holder is mounted and is retracted into the airlock
- The specimen chamber is unloaded

**Procedure**

1. Insert the stub with the new specimen into the specimen holder and fix the stub to the specimen holder.
2. Check that the airlock rod is fully retracted.
3. To use an airlock camera for navigation, acquire an overview image with the airlock camera:
Press the button of the navigation camera at the airlock.
Wait until the image is acquired and displayed in the Image Navigation section of the Stage Navigation Bar.

4. Close the airlock door.
5. On the control panel, press Transfer, to change to Transfer mode.
   Alternatively, click Transfer in the Airlock panel.

→ The airlock is evacuated, the gate valve opens, and the illumination is turned on in the airlock chamber.
6. To transfer the specimen holder, insert the airlock rod into the specimen chamber.
   → The specimen holder slides into the dovetail at the specimen stage.
7. Turn the knob counter-clockwise in order to detach the specimen holder from the airlock rod.

8. Retract the airlock rod.

5.8.1.2.2 Controlling the Valves via Airlock Macros

Procedure

1. In the Airlock panel, click Resume Exchange to start the pre-defined macro. The macro automatically performs the following steps:
   - The gate valve is closed.
   - The column chamber valve is opened.
   INFO: The airlock macros can be modified according to your individual requirements. Contact your local ZEISS service representative for assistance.

2. Switch on the EHT. Refer to Switching on the EHT [90].
   - You can now continue working with the microscope.
   - If you acquired an overview image with an airlock camera, you can now navigate the stage by double-clicking in the overview image.
5.8.1.2.3 Controlling the Valves without Airlock Macros

Procedure 1. On the control panel, press **Vent**, to change to **Vent** mode. Alternatively, click **Vent** in the **Airlock** panel.

- The gate valve is closed.
- The airlock chamber is vented with nitrogen.

2. Click **Open Column Chamber Valve**.

- The column chamber valve is opened.

3. Switch on the EHT. Refer to *Switching on the EHT* [90].

You can now continue working with the microscope.

If you acquired an overview image with an airlock camera, you can now navigate the stage by double-clicking in the overview image.
5.8.2 Using the Optional Plasma Cleaner

5.8.2.1 Activating the Plasma Cleaner

The Plasma Cleaner is an optional accessory that allows you to decontaminate the specimen chamber and any loaded specimens. The plasma is fully contained in the Plasma Cleaner unit. The radicals migrate into the specimen chamber and chemically react with unwanted hydrocarbons. After a plasma cleaning cycle, the specimen surface provides optimal imaging conditions even at very low imaging voltages.

**Info**

Depending on the plasma cleaner model, T pump mode and purging are available and the Plasma Cleaning panel looks different.

**Info**

You can view a log file that contains all relevant events concerning the Plasma Cleaner via Panel Configuration Bar > Plasma Cleaning > View Log. The log file can be used for troubleshooting and to determine when the next plasma cleaning process should be scheduled.

![Fig. 72: Plasma Cleaner.Log](image)

**NOTICE**

**Gases**

Unstable pressure or unwanted reactions between the plasma and gases injected into the chamber can damage the specimen or the vacuum system.

If a gas injection system or the charge compensation function are active, the gas injection affects the pressure range and can create unwanted reactions between the plasma and the injected gas.

- Make sure the chamber pressure is stable during plasma cleaning.
- Do not use the GIS or the charge compensator when using the plasma cleaner.

**NOTICE**

**Plasma cleaning**

Plasma can damage sensitive specimens.

- Always test the plasma cleaner on specimens of the same material before cleaning any important specimen.

**Procedure**

1. If your microscope is equipped with the airlock, make sure that the gate valve of the airlock is closed. Do not use the airlock while using the Plasma Cleaner. For more information refer to the instruction manual of the airlock.

2. Switch off the EHT.

**NOTICE** The pressure range applied during plasma cleaning can damage the electron source. To protect the electron source from the harmful pressure range, close the column chamber valve.
3. From the Panel Configuration Bar, select Plasma Cleaning.
   → The Plasma Cleaning panel is displayed.

4. Check that the Plasma Cleaner controller hardware is switched on and the Connected LED is active in the software.

5. From the Recipe drop-down list, select a recipe.
   INFO: There are several preset recipes for different purposes that cannot be edited. Additionally, you can create custom recipes.

6. To start the plasma cleaning, click Start cleaning.
   → The current status is displayed in the Plasma Cleaning Sequence section.
   → If the selected recipe involves nitrogen purges, the number of purge cycles is displayed next to the flow chart. The arrow indicates which steps will be repeated.

7. Wait until the Finished LED is active.
   This indicates that the plasma cleaning process is complete.
   INFO: If you wish to abort the cleaning cycle while it is still running, click Stop cleaning.
   → The chamber is pumped.

8. Wait until Vac Status = Ready is displayed in the Vacuum tab of the SEM Controls panel.
   → The gun and the EHT can then be switched back on and you can return to regular microscope operation. Refer to Switching on the Gun (90) and Switching on the EHT (90).

5.8.2.2 Creating Custom Recipes

There are several preset recipes for different purposes that cover most applications. Additionally, you can create custom recipes for special purposes.

Procedure
1. From the Panel Configuration Bar, select Plasma Cleaning.
   → The Plasma Cleaning panel is displayed.
2. Click Edit Recipes.
   → The Plasma Cleaning Recipe List is displayed and displays the available recipes.
   INFO: The preset recipes are marked as Fixed in the Type column and cannot be edited or deleted.
3. To create a new recipe, click **Add**.

   → The **Cleaning Recipe** window is displayed.

4. Enter a name for the cleaning recipe.

5. Select the desired values according to your specific application.
   In particular, the plasma power and the plasma time can be changed for the customized recipes.

6. If a plasma cleaner with purge option is installed and if nitrogen purge cycles are necessary, activate the **Purge** checkbox.
   → This adds additional values that can be edited.

7. If required, activate **T pump mode**.
   This option provides a faster cleaning at better vacuum.

8. Once the settings are complete, click **Ok**.

   → The recipe is added to the list of available recipes.
   → In the **Type** column, the new recipe is displayed as **User**, which tells you that the recipe can be edited or deleted.
5.8.2.3 Setting up the Schedule

If you want to schedule the next plasma cleaning, you can set up a date and time for an automated decontamination cycle.

**NOTICE**

**Plasma cleaning**
Plasma can damage sensitive specimens.
- Always test the plasma cleaner on specimens of the same material before cleaning any important specimen.

**NOTICE**

**Gases**
Unstable pressure or unwanted reactions between the plasma and gases injected into the chamber can damage the specimen or the vacuum system.
If a gas injection system or the charge compensation function are active, the gas injection affects the pressure range and can create unwanted reactions between the plasma and the injected gas.
- Make sure the chamber pressure is stable during plasma cleaning.
- Do not use the GIS or the charge compensator when using the plasma cleaner.

**Procedure**
1. From the **Panel Configuration Bar**, select **Plasma Cleaning**.  
   → The **Plasma Cleaning** panel is displayed.
2. To select a date for your cleaning schedule, click the **Calendar** icon.
3. In the input field on the left side of the **Calendar** icon, enter a time.
4. Activate the **Schedule cleaning cycle at:** checkbox.  
   → The cleaning cycle schedule is now active. 30 seconds before the scheduled cleaning cycle, a countdown will be displayed to inform you that a cleaning cycle is about to start.
5. To abort the countdown and start the cleaning cycle right away, click **Start Now**.
6. To abort the countdown and cancel the scheduled cleaning cycle, click **Cancel**.
7. To start the cleaning cycle as scheduled, no action needs to be taken.

5.8.2.4 Returning to Regular Operation

**Procedure**
1. If a cleaning cycle is currently running, click **Stop cleaning** to abort the cleaning cycle.
2. Close the **Plasma Cleaning** window.  
   → The chamber is pumped.
3. Wait until **Vac Status = Ready** is displayed in the **Vacuum** tab of the SEM Controls panel.
4. Switch on gun and EHT. Refer to **Switching on the Gun** [90] and **Switching on the EHT** [90].
5.8.3 Using the Optional Raman Spectroscopic Microscope

5.8.3.1 Acquiring an Image with the Optional Raman Spectroscopic Microscope

Raman spectroscopy is a non-destructive analytical technique that can be used to identify and image various material parameters, such as chemical composition and crystallographic orientation. The specimen is illuminated with a monochromatic laser beam, which interacts with the molecules of the specimen. The spectrum of the scattered light is analyzed.

The stage position and working distance of the SEM and the Raman spectroscopic microscope are not identical:

![Diagram of SEM and Raman working distance](image)

**Prerequisite** ✓ SmartSEM is started

**Procedure**

1. Open the **SEM Raman Correlation** window.
   - **INFO:** The scan rotation is automatically adjusted to match the different rotations of the Raman microscope and the SEM. Do not change the scan rotation.
2. Activate the **Use auto calibration data** checkbox.
3. Use the dual joystick to shift the specimen in X direction and in Y direction until the region of interest on the specimen is centered.
4. Use the dual joystick to shift the specimen in Z direction until the image is roughly in focus.
5. Use the buttons in the Manual stage control section of the SEM Raman Correlation window to refine the adjustment.

**INFO:** If you use the Manual stage control, then the backlash correction is automatically activated. The backlash correction ensures the required relative accuracy of the stage.

6. Save the SEM image.
   - In the Raman Correlation tab, a message is displayed that asks you to focus the image.

7. Focus the image.

8. In the Raman Correlation tab of the SEM Raman Correlation window, click **Move to Raman**
   The following steps are executed automatically:
   - The image of the USB TV camera is automatically displayed to let you see the movement towards the Raman objective and the Raman working distance.
     **INFO:** The speed of the dual joystick depends on the magnification. If the image of the USB TV camera is displayed, then the stage travels with maximum speed.
   - The stage moves the specimen to the Raman position.
   - After the movement is finished, the SEM image is displayed again.
     **INFO:** Not all stage positions are within the reach of both, the SEM and the Raman microscope. In this case, a message is displayed in the message field. Often a rotation of the specimen towards the Raman microscope helps. Use the compucentric rotation to rotate the specimen.

9. Check that the objective is in the position \( x = 0, y = 0, \) and \( z = 0 \).
10. Use the dual joystick to shift the specimen in Z direction until the image is in focus.

   ➔ The image becomes brighter.

11. To correlate the Raman microscope with the electron microscope, overlay the Raman image to the SEM image:

   Import the SEM image via **File > Import > Import SEM Image**

12. In the **Project Manager** window, drag the light microscope image and drop it on the SEM image.

   ➔ A menu is displayed.

13. Select **Use as Overlay** in the menu.

   ➔ The light microscope image is overlaid to the SEM image.

   ➔ The **Image Transform and Overlay** window is displayed.
14. In the **Transformation** tab of the **Image Transform and Overlay** window, activate the **Listen (Click and Move)** checkbox.

15. Click on the light microscope image and accurately align it with the SEM image. 
   ➔ The Raman microscope is correlated with the electron microscope.

16. To extract a bitmap image, click **Extract Bitmap**.
   ➔ **INFO:** For bigger fields of view, use stitching.

17. Acquire Raman spectra or Raman maps.
18. When you are finished acquiring the Raman spectra, then move the stage back to the position \( x = 0, y = 0, \) and \( z = 0. \)

INFO: The position \( x = 0, y = 0, \) and \( z = 0 \) is the reference position for the correlating SEM position.

19. To go back to SEM imaging, click Move to SEM in the Raman Correlation tab of the SEM Raman Correlation window.

5.9 Shutting down the System

5.9.1 Finishing the Work Session

To finish your work session, you need to switch off the EHT.

Change to STANDBY mode when the microscope is not operated, even for longer periods. The filament will continue to be heated, and the vacuum in the electron optical column and in the specimen chamber will be maintained.

The STANDBY mode is also the recommended mode to store the microscope. In this case, activate the Partial Vent on Standby checkbox in the Vacuum tab of the SEM Controls panel. This can help to prevent oil vapors from penetrating into the specimen chamber during the period of storage.

NOTICE

Schottky field emitter

If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime is reduced.

- Avoid switching off the gun during the working week.
- Use Standby mode for the weekend or a break of up to a week.
- When using the Standby mode, activate the Partial Vent on Standby function.

Prerequisite ✓ The microscope is in ON mode.

Procedure

1. Click the All: button in the status bar.

2. Select EHT Off from the pop-up menu.

3. Only when interrupting work for longer periods between 2 and 7 days: In the Vacuum tab activate the Partial Vent on Standby checkbox.

   ➔ This maintains the gun vacuum, and switches off and protects the turbo pump.

4. Exit the SmartSEM user interface. Refer to Exiting the SmartSEM User Interface [127].

5. Close all programs and software.

6. Select Windows start button > Power icon > Shut down.

7. At the front of the plinth, press the Standby button.
The microscope switches to Standby mode.

5.9.2 Closing the SmartSEM User Interface

5.9.2.1 Logging off from the SmartSEM User Interface

**Procedure**
1. From the Menu Bar, select File > Log Off.
   → A system message is displayed.
2. Click Yes.
3. Close the EM Server.
   → A system message is displayed.
4. Click Yes.
   INFO: The EM server remains active.

5.9.2.2 Exiting the SmartSEM User Interface

**Procedure**
1. From the Menu Bar, select File > Exit.
   → A system message is displayed.
2. Click Yes.
3. Close the EM Server.
   → A system message is displayed.
4. Click Yes.
5.9.3 De-energizing the Microscope

This procedure completely cuts off the microscope from the electrical main supply.

⚠️ WARNING

Residual voltage at the mains plug

After unplugging the mains plug residual voltage is present at the pins of the plug which may cause electrical shock.

- After unplugging the mains plug wait at least 5 s before touching the pins of the mains plug.

Prerequisite

✔️ The microscope is in Standby mode, refer to Finishing the Work Session (126), or in OFF mode

Procedure

1. If the microscope is not yet in OFF mode, press the Off button at the front of the plinth.
   - When all subsystems are fully deactivated, the Off button lights up red permanently.

2. Close and lock the main shut-off valves at the installation site.

3. If the EMO circuit is not installed, unplug the power cord by unplugging the CEE connector from the CEE FEMALE RECEPTACLE of the mains supply.

4. If the EMO circuit is installed, switch the Main Switch to its OFF position.

The microscope is completely cut off from the electrical main supply.
5.10 Performing an Emergency Shutdown

If an emergency occurs and you quickly must shut down the microscope, then you need to perform an emergency shutdown.

**WARNING**

Residual voltage at the mains plug
After unplugging the mains plug residual voltage is present at the pins of the plug which may cause electrical shock.
- After unplugging the mains plug wait at least 5 s before touching the pins of the mains plug.

**NOTICE**

Components in the high voltage circuitry
When the microscope, especially the gun, is fully on, an abrupt shutdown of all electrical supplies may damage some components in the high voltage circuitry, mainly the cathode.
- Use the emergency off only in an emergency situation with personnel injury.

**Procedure**

1. If the EMO circuit is not installed, unplug the power cord by unplugging the CEE connector from the CEE FEMALE RECEPTACLE of the mains supply.

2. If the EMO circuit is installed, press the EMO button on the top of the plinth.
6 Care and Maintenance

To ensure the best possible performance of the Microscope System, maintenance must be performed on a regular basis. To maintain operational safety and reliability of the Microscope System, we recommend entering into a ZEISS Protect service agreement. Please keep the service logs for your Microscope System.

Info

Additional information and detailed descriptions are available in the further applicable documents, or ask your ZEISS Sales & Service Partner.

6.1 Safety During Cleaning and Maintenance

Only conduct preventive measures described in the Instruction Manual. All pursuing tasks of maintenance, service and cleaning not described here must only be performed by an authorized ZEISS service representative. Any unauthorized intervention in the Microscope System or any use outside the scope of the intended use can lead to injuries and property damage, and voids all rights to warranty claims. Only original spare parts from ZEISS may be used.

6.2 Maintenance Schedule

To maintain best possible performance of the Microscope System, it is essential to perform preventive maintenance on a regular basis. The recommended intervals depend on the total uptime of the Microscope System.

- 24 hours, 7 days a week: semiannually
- 8 hours, 5 days a week: annually

Info

Keep track of maintenance work and contact the ZEISS service representative in time.

A list of ZEISS locations and authorized service partners can be found at:
http://www.zeiss.com/microscopy

6.3 Maintenance Work

Only conduct maintenance work described in this document. All tasks of maintenance, service and repair not described here must only be performed by an authorized ZEISS service representative.

6.3.1 Change of Consumables and Chemicals

The change of consumables and chemicals is a scheduled interruption of operation to replenish process consumables and chemicals.

The change of consumables and chemicals has to be performed by a ZEISS service representative at mandatory intervals.

The times scheduled are designed for the maximum equipment performance level (i.e. 24 h per day of permanent operation).

<table>
<thead>
<tr>
<th>Interval</th>
<th>Component/Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every 6000 h* (filament on)</td>
<td>Field emission gun (filament)*</td>
</tr>
</tbody>
</table>
### 6.3.2 Servicing the Pre-vacuum Pump

For maintenance of the pre-vacuum pump, refer to the instruction manual of the pump provided by the pump manufacturer.

You can find this documentation in the document folder of your microscope.

### 6.4 Care and Cleaning Work

All care and cleaning work not described here must only be performed by an authorized ZEISS service representative.

---

**NOTICE**

**Functional impairment due to dirt and moisture**

Dirt, dust and moisture can impair the Microscope System’s functionality and can cause short-circuits.

- The ventilation slots must be unobstructed at all times.
- Perform regular maintenance and cleaning according to the instructions in this document and according to the instructions in the applicable documents.
- Make sure that no cleaning liquid or moisture gets inside the Microscope System.
- In case of damage, the affected parts of the Microscope System must be taken out of operation.
6.4.1 Cleaning the Microscope

⚠️ CAUTION

Isopropanol
Isopropanol is highly flammable and irritating to the eyes. Vapors may cause drowsiness and dizziness.
- Wear suitable gloves.
- Keep away from sources of ignition.
- Do not smoke.
- In case of contact with the eyes, rinse immediately with plenty of water and seek medical advice.
- Avoid contact with skin.
- Do not breathe vapor.

In case you have to clean the microscope always use a lint-free cloth.
In case you need a cleaning liquid, only isopropanol on a lint-free cloth may be used for cleaning parts of the microscope. Where cleaning with isopropanol is allowed and necessary is mentioned in the relevant chapters of the manual.

Covers of the microscope which have been secured by a screw must not be removed. Please contact the Zeiss service in case cleaning is necessary below these covers.
# 7 Troubleshooting

The following table provides hints for solving common problems. If you cannot solve the problem or if you are unsure about a certain technical difficulty, contact your local ZEISS service representative.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drift: Specimen seems to be moving</td>
<td>▪ Charging effects&lt;br▪ Nonconductive specimen</td>
<td>▪ Ensure proper conduction of the specimen&lt;br▪ Optimize specimen preparation&lt;br▪ Apply a charge compensation method</td>
</tr>
<tr>
<td></td>
<td>Stub not correctly fixed by screw.</td>
<td>Fix the stub correctly.</td>
</tr>
<tr>
<td>Gun is switched off automatically</td>
<td>Gun has been switched off for safety reasons since gun vacuum is worse than $2 \times 10^{-8}$ mbar</td>
<td>Refer to <em>Baking out the Gun Head</em> [138]</td>
</tr>
<tr>
<td>Image is bad at low EHT (e.g. 1 kV)</td>
<td>Working distance is too long</td>
<td>Reduce the working distance to a maximum of 7 mm</td>
</tr>
<tr>
<td>Image is noisy. Noise reduction methods do not help</td>
<td>Field emission gun is used up</td>
<td>Contact your local ZEISS service representative to have the field emission gun replaced</td>
</tr>
<tr>
<td>Image quality degrades, but there is no change in total emission current</td>
<td>Field emission gun has been damaged due to arcing</td>
<td>Contact your local ZEISS service representative to have the field emission gun replaced</td>
</tr>
<tr>
<td>InLens image is noisy</td>
<td>Working distance is too long</td>
<td>Reduce the working distance to a maximum of 7 mm</td>
</tr>
<tr>
<td>No InLens image</td>
<td>EHT exceeds 20 kV</td>
<td>Reduce the EHT to a maximum of 20 kV</td>
</tr>
<tr>
<td>Microscope is dead</td>
<td>Circuit breaker is tripped (lower position)</td>
<td>Check the circuit breakers&lt;brRefer to <em>Checking the Position of the Circuit Breakers</em> [140]</td>
</tr>
<tr>
<td>Stored position of the specimen stage cannot be approached correctly</td>
<td>PC has crashed</td>
<td>Restart the PC&lt;brStage needs to be driven to a well-defined position</td>
</tr>
<tr>
<td>After a power failure, the stored stage position cannot be approached correctly</td>
<td>Stage needs to be initialized</td>
<td>Refer to <em>Initializing the Stage</em> [134]</td>
</tr>
<tr>
<td>SE image is noisy</td>
<td>Scintillator is used up</td>
<td>Contact your local ZEISS service representative to have the scintillator replaced</td>
</tr>
<tr>
<td>Specimen current is low</td>
<td>Field emission gun is used up</td>
<td>Contact your local ZEISS service representative to have the field emission gun replaced</td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause</td>
<td>Measure</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Stage does not move</td>
<td>Stage needs to be initialized</td>
<td>Refer to <em>Initializing the Stage</em> [134]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If this does not solve the problem, contact your local ZEISS service representative</td>
</tr>
<tr>
<td>Stored position of the specimen stage cannot be approached correctly</td>
<td>Absolute stage movement is required, stage needs to be driven to a well-defined position</td>
<td>Refer to <em>Initializing the Stage</em> [134]</td>
</tr>
<tr>
<td>Microscope does not vent</td>
<td>No nitrogen</td>
<td>Check nitrogen supply</td>
</tr>
<tr>
<td></td>
<td>No compressed air</td>
<td>Check compressed air supply</td>
</tr>
<tr>
<td><em>Vac ready</em> = OK is not displayed after specimen exchange</td>
<td>System vacuum is bad due to a vacuum leak at the chamber door</td>
<td>Check the chamber door seal for cleanliness</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If required, refer to <em>Replacing the Chamber Door Seal</em> [137]</td>
</tr>
<tr>
<td><em>Vac ready</em> = OK is displayed very late after specimen exchange</td>
<td>Gas ballast is activated at the pre-vacuum pump</td>
<td>Deactivate gas ballast at the pre-vacuum pump</td>
</tr>
<tr>
<td><em>Vac ready</em> = OK is displayed abnormally fast</td>
<td>Penning gauge has not been identified correctly</td>
<td>Restart the microscope</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If this does not solve the problem, contact your local ZEISS service representative</td>
</tr>
<tr>
<td>Gun vacuum is worse than $2 \times 10^{-8}$ mbar</td>
<td>The pumping capacity of the ion getter pump decreases in the course of time, thus deteriorating the gun vacuum</td>
<td>Refer to <em>Baking out the Gun Head</em> [138]</td>
</tr>
</tbody>
</table>

Tab. 6: Troubleshooting

### 7.1 Chamber

#### 7.1.1 Initializing the Stage

If a stored stage position cannot be approached or if the stage does not move or does not move accurately, the stage needs to be initialized.

**CAUTION**

**Moving the specimen stage**

Fingers can be trapped by the moving specimen stage.
- Always close the chamber door before moving the specimen stage.
- To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.

**Prerequisite**
- ✔ The specimen chamber has been evacuated, refer to *Loading the Specimen Chamber* [85]
- ✔ Requires the **Stage Initialise** privilege
No coolstage is fitted

If there are any large specimens inside the chamber, remove them before initializing

**Procedure**
1. From the **Menu Bar**, select **Stage > Stage Initialise**.
   - The **Initialise Stage** window is displayed.
2. Confirm via **Yes**.
   - The stage initialization process takes a few minutes.
   - **INFO:** If initialization of the stage does not solve the stage problem, contact your local ZEISS service representative.

### 7.1.2 Defining the Post Initialization Position of the Stage

You can configure the position to which the stage drives after the initialization procedure. Otherwise, the stage drives to the center position.

**CAUTION**

**Moving the specimen stage**

Fingers can be trapped by the moving specimen stage.
- Always close the chamber door before moving the specimen stage.
- To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.

**Prerequisite**

- Requires the **Supervisor** privilege.

**Procedure**
1. From the Windows start menu, select **SmartSEM > SmartSEM Administrator**.
   - The **SmartSEM Administrator Log on** window is displayed.
2. Enter user name and password.
3. To confirm, click **OK**.
   - The **SmartSEM Administrator** window is displayed showing the user list.
4. Click **Column/Stage**.
5. In the **Stage Post Initialisation Position** input fields, enter the desired position.
   Alternatively, use the dual joystick to navigate to the desired position and click **Set to current position**.
6. To activate the function, activate the **Post Init. Posn Valid** checkbox.

### 7.1.3 Changing the Joystick TV Angle

In TV mode (chamberscope), it can occur that dual joystick and stage seem to move to opposite directions. This is because the selected CCD camera is installed at a certain angle relative to the stage. Thus, the camera shows a side-inverted view. To remedy this, you need to change the joystick TV angle setting in the software.

**Info**

If you are working with two CCD cameras: The joystick TV angle can only be set for one CCD camera. When selecting the other CCD camera, you have to change the setting.
Moving the specimen stage

Fingers can be trapped by the moving specimen stage.

- Always close the chamber door before moving the specimen stage.
- To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.

**Prerequisite**
Requires the Supervisor privilege.

**Procedure**
1. From the Windows start menu, select SmartSEM > SmartSEM Administrator.
   - The SmartSEM Administrator Log on window is displayed.
2. Enter user name and password.
3. To confirm, click OK.
4. The SmartSEM Administrator window is displayed showing the user list.
5. Click Column/Stage.
6. In the Stage Options section, double-click the Joystick TV Angle input field.
7. Enter an angle depending on the installation location of the CCD camera.
   - If the CCD camera is installed at the back, enter 180°.
   - If the CCD camera is installed at the front, enter 0°.
   - If the CCD camera is installed at the side, enter 90°.

### 7.1.4 Resetting the Touch Alarm

To prevent damage, a touch alarm is integrated in the microscope. If the specimen or the specimen holder touches the chamber walls, the detectors, or the objective lens, the stage is stopped immediately. An audible warning sounds and an on-screen message is displayed.

**Prerequisite**
- The EM server shows the message WARNING Stage Touching.

**Procedure**
1. To accept the warning, click OK.
2. Move the stage in the reverse direction away from the touch.

### 7.1.5 Checking the Water Flow and Temperature

**Procedure**
1. In the Panel Configuration Bar, double-click Water Flow/Temperature.
   - The Water Flow/Temperature panel is displayed.
2. Check the entries.
   - If a value is critical, it is displayed in red.
7.1.6 Replacing the Chamber Door Seal

Possible reasons for replacing the chamber door seal are the following:

- Chamber door does not close tightly
- Bad chamber vacuum

The procedure consists of the following steps:

- Venting the Specimen Chamber [87]
- Replacing the O-ring [137]
- Evacuating the Specimen Chamber [89]

7.1.6.1 Replacing the O-ring

⚠️ WARNING

Suffocation hazard due to lack of oxygen

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal- ing nitrogen may cause unconsciousness.

- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional insta- bility, fatigue) leave the room immediately and inform the facility’s safety officer.

⚠️ CAUTION

Moving the specimen stage

Fingers can be trapped by the moving specimen stage.

- Always close the chamber door before moving the specimen stage.
- To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fingers.

⚠️ CAUTION

Closing the chamber door

Fingers can be pinched when closing the chamber door.

- Use the door handle to close the chamber door.
- Ensure not to get your fingers caught in the chamber door gap.

NOTICE

Contamination caused by fingerprints

Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping times.

- Always wear lint-free gloves when touching the specimen, specimen holder, or stage.
**Procedure**

1. Carefully open the chamber door.

2. On the inside of the chamber door, remove the chamber door O-ring.
   
   **NOTICE** If you use a metal tool to remove the O-ring, then you may damage the sealing surface. If necessary, then only use a plastic or wooden tool to remove the O-ring.

3. Inspect the groove that holds the O-ring and remove any contamination.
4. Insert the new chamber door O-ring.
5. Close the chamber door.

---

**7.2 Column**

**7.2.1 Baking out the Gun Head**

The gun vacuum deteriorates with time. It is possible to perform a bake-out operation as a regular maintenance procedure to restore the vacuum.

The procedure consists of the following steps:

- **Switching off the Gun [138]**
- **Starting the Bakeout [139]**
- **Switching on the Gun [90]**

---

**7.2.1.1 Switching off the Gun**

**NOTICE**

Schottky field emitter

If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime is reduced.

- Avoid switching off the gun during the working week.
- Use Standby mode for the weekend or a break of up to a week.
- When using the Standby mode, activate the **Partial Vent on Standby** function.
Procedure 1. In the right part of the Status Bar, click 

→ The pop-up menu for Vacuum, Gun and EHT activation is displayed.
2. Click Shutdown Gun.
3. Wait until the gun has ramped down.
   → This may take up to 5 minutes.

7.2.1.2 Starting the Bakeout

Info

You cannot work with the microscope while the bakeout procedure runs.

NOTICE

Hot surfaces during bakeout
Parts of the enclosure in the upper range of the column may become hot during bakeout, particularly after a long bakeout cycle.

- Do not place any combustible objects on the grids of the electron optical column during bakeout.
- After the bakeout procedure, let surfaces cool down before working around the column.
- Only advanced operators are allowed to perform the bakeout procedure.

Prerequisite ✓ Requires the Supervisor privilege and the user level Service
✓ Only advanced operators are allowed to perform the bakeout procedure

Procedure 1. In the Panel Configuration Bar, double-click Bakeout.

→ The Bakeout dialog is displayed.
2. If the Full service bakeout checkbox is available, deactivate the Full service bakeout checkbox.
INFO: Full service bakeout includes column heating that may lead to column misalignment.
3. From the Bakeout drop-down list, select a bakeout cycle.
   For 2 hours heating / 1 hours cooling, select Quick.
   For 8 hours heating / 2 hours cooling, select Overnight.
   For 40 hours heating / 3 hours cooling, select Weekend.
   For a cycle defined by the operator, select User.
   INFO: You can switch to Standby mode while the bake-out procedure is running. Before you switch to Standby mode, ensure that the Partial Vent on Standby checkbox is deactivated in the SEM Controls panel.
4. To start the bakeout procedure, click Bakeout Start.
7.2.2 Calibrating OptiProbe

After cathode replacement or after re-alignment of the electron optic column, OptiProbe has to be calibrated. A calibration wizard facilitates the calibration procedure.

<table>
<thead>
<tr>
<th>Parts and Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Designation</strong></td>
</tr>
<tr>
<td>Faraday Cup</td>
</tr>
<tr>
<td>orifice diameter at least 200 μm</td>
</tr>
</tbody>
</table>

**Procedure**
1. Load the Faraday cup into the specimen chamber.
2. Set WD = 5 mm and select spot mode.
3. Focus the spot into the orifice of the Faraday cup.
4. From the Windows start menu, select **SmartSEM > OptiProbe Calibration**.
   - The OptiProbeCal dialog is displayed.
5. Click **OK**.
   - The OptiProbeCal window is displayed.
6. To start the calibration, click **Start**.
   - The User Action window is displayed.
7. Click **OK**.
   - An automatic calibration routine is performed, which takes about fifteen minutes.
   - When the calibration procedure is finished, a message is displayed.
8. To finish the dialog, click **Yes**.
   - Now OptiProbe is ready to be used.

7.3 Power Circuit

7.3.1 Checking the Position of the Circuit Breakers

**NOTICE**

Persisting electrical problems
Tripped circuit breakers or blown fuses may be a hint for an electrical problem in the microscope.

- If a circuit breaker keeps tripping or a fuse keeps blowing, de-energize the microscope completely and contact your ZEISS service representative for assistance.

<table>
<thead>
<tr>
<th>No.</th>
<th>Value</th>
<th>Type</th>
<th>Circuit</th>
</tr>
</thead>
<tbody>
<tr>
<td>F10</td>
<td>10 A</td>
<td>Circuit breaker</td>
<td>Plinth electronics, PC</td>
</tr>
<tr>
<td>F12</td>
<td>10 A</td>
<td>Fuse</td>
<td>Rotary pump 1</td>
</tr>
</tbody>
</table>

**Procedure**
1. Check if the circuit breaker (F10) on the rear side of the plinth is tripped.
2. If the circuit breaker is tripped, push the circuit breaker upwards.
3. If the rotary pump 1 is not working, check and possibly replace the fuse (F12).
7.4 Detectors

7.4.1 Lubricating the Rod

The rod from the aSTEM, BSD4, BSD1, and BSD1-VP detector mechanics need to be lubricated once a year with TEM oil 300.

**Parts and Tools**

<table>
<thead>
<tr>
<th>Designation</th>
<th>Part no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEM oil 300</td>
<td>000000-0484-955</td>
</tr>
<tr>
<td>Isopropanol</td>
<td>–</td>
</tr>
<tr>
<td>Lint-free cloth</td>
<td>–</td>
</tr>
<tr>
<td>Lint-free gloves</td>
<td>–</td>
</tr>
</tbody>
</table>

⚠️ **CAUTION**

**Contact with TEM oil 300**

TEM Oil 300 may be irritating to the skin and mucous membranes. The separate safety data sheet contains additional information.

- Avoid contact with skin.
- Wear suitable gloves.
- In case of contact with the eyes, rinse immediately with plenty of water and seek medical advice.
- After contact with the skin, wash immediately with plenty of water and soap.

⚠️ **CAUTION**

**Isopropanol**

Isopropanol is highly flammable and irritating to the eyes. Vapors may cause drowsiness and dizziness.

- Wear suitable gloves.
- Keep away from sources of ignition.
- Do not smoke.
- In case of contact with the eyes, rinse immediately with plenty of water and seek medical advice.
- Avoid contact with skin.
- Do not breathe vapor.

⚠️ **NOTICE**

**Unsuitable lubricants**

When using unsuitable lubricants, the vacuum system may be contaminated.

- Only use TEM oil 300 for lubricating.

**Procedure**

1. Retract the respective detector.
2. Clean the rod with isopropanol with a clean, lint-free cloth.
3. Spread some drops of TEM oil 300 across the rod. Use a clean, lint-free cloth.
7.5 PC

7.5.1 Cleaning up the PC

It is important to periodically clean up the PC. This shortens the boot sequence and loading times. If necessary, refer to standard Windows manuals for instructions to do this.

Procedure
1. Backup the database to the server or to other storage.
2. Delete the temporary files.
3. Check for adequate free space on the hard drives.
4. Backup the log file (EMServer.log).
5. Erase the original log files in the LOG folders.
6. Check that Windows updates are applied and that service packs are applied.
   
   INFO: Each service pack includes all the patches since the last major release.
8 Decommissioning and Disposal

This chapter contains information on the decommissioning and disposal of the Microscope System.

8.1 Decommissioning

If the Microscope System is not used for an extended period such as several months, it should be shut down completely and secured against unauthorized access. Complete decommissioning of the Microscope System should be executed by your ZEISS service representative.

**WARNING**

Malfunction of medical devices near ion getter pumps
Magnetic fields present at the ion getter pumps may disturb the function of medical devices. The magnetic fields are also present if the microscope is switched off.
If you wear medical implants that are susceptible to magnetic fields (e.g. cardiac pacemakers), do the following:
- Keep a distance of at least 30 cm from the ion getter pumps.
- Follow the safety instructions provided by the pump manufacturer.

**WARNING**

Biological hazards
Biological substances may pose a threat to the health of humans and other living organisms.
- Keep a logbook of the biological substances loaded into the microscope and show it to the ZEISS service representatives before they perform any work on the microscope.

**WARNING**

High leakage current
High leakage currents are present in the microscope. Contact may cause burn or electrical shock.
- Ensure proper grounding. For more information, refer to the Installation Requirements document.
- Do not operate the microscope without the separate ground connection.

**WARNING**

Radiation hazard due to X-rays
X-rays are generated inside the microscope during operation. This is unavoidable because electrons are accelerated by voltages up to 30 kV.
- Do not remove any parts around the column and chamber that are essential for radiation protection.
- Use genuine ZEISS parts exclusively.
- Ensure that all local safety and X-ray protection regulations are met.
- Only authorized ZEISS service representatives are allowed to service the microscope.
WARNING

Reaction products
Dangerous reaction products can be present in the specimen chamber during or after operation.
- Ensure that there is an appropriate exhaust gas line to remove the waste gas of the pre-vacuum pump and to transmit it to the outside.
- Wear lint-free gloves when touching the inner parts of the specimen chamber or the specimen.

WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhaling nitrogen may cause unconsciousness.
- During specimen exchange, keep the chamber door open as short as possible.
- Do not inhale the air from within the specimen chamber.
- Ensure that the area around the microscope is sufficiently vented.
- If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental alertness and/or muscular coordination, depression of sensations, emotional instability, fatigue) leave the room immediately and inform the facility’s safety officer.

Procedure
1. Switch off the Microscope System.
2. Pull the mains plug.

8.2 Transport and Storage

WARNING

Tilting hazard when removing the microscope from the crate
When removing the microscope from the wooden crate, it can tilt and crush a person.
- Use a forklift to remove the microscope from the wooden crate.

WARNING

Crushing hazard when lowering the microscope
The microscope and its components are heavy. When the load is lowered during transport and positioning, body parts can be crushed.
- Maintain a safe distance.
- Do not walk or place your hands or feet under the load while it is being lowered.
- Wear safety shoes and gloves.
NOTICE

Damage during transport
Sensitive components of the microscope can get damaged during transport.
- The microscope may only be transported in air-suspended vehicles.
- Moving parts must be secured during transport to prevent them from slipping or tipping over.
- Install shock/tilt watches.
- Avoid rocking the crates back and forth.
- Devices for transporting the microscope must be rated to handle its full weight and dimensions. Note the weight information on the package and on the shipping document.
- Check that none of the items has been damaged during shipment.
- Otherwise contact your local ZEISS service representative.

The following regulations must be observed before and during transport:
- Check if there is any moving equipment available on-site that can be used to safely transport the Microscope System to the installation room. In clean-room environments, this check is mandatory.
- The Microscope System may only be transported in air-suspended vehicles.
- Moving parts must be secured during transport to prevent them from slipping or tipping over.
- Avoid rocking the crates back and forth.
- Devices for transporting the Microscope System must be rated to handle its full weight and dimensions.
- Note the weight information on the package and on the shipping document.
- Where possible, the original packaging must be used for shipping or transport.

Fork lift and a hand pallet truck
For on-site transport and unloading a fork lift and a hand pallet truck are necessary.
- Ensure all hallways and corners are wide enough to be passed with the hand pallet truck.
- Please check the location requirements for door and hallway widths.
- Check the entrance to the building and to the final site for suitable ramps and compliant elevators that can match the weights of the system where necessary.
- Some components, such as the tables, are large, heavy or bulky and may require extra assistance to get the units into the allocated site.

Maximum shock resistance
- Do not drop or bump the boxes during movement or storage. (Any acceleration shall be < 10 g.)
- Evaluate packaging shock and tilting sensors on delivery and after internal transport.

Packaging
The microscope is delivered in two wooden crates:
- Microscope plinth
  Wrapped with recyclable polyethylene-foil and shipped in a reusable wooden crate.
  Dimensions and weight of crate: 1350 × 1000 × 2000 mm³ (W × D × H), appr. 750 kg
- Microscope console and accessories
  Console, valve, damper, monitors, cables, pipes etc. are wrapped with recyclable polyethylene-foil or packed in separate cartons and shipped in a reusable wooden crate.
  1400 × 1350 × 1122 mm³ (W × D × H), appr. 350 kg
- Check that none of the items has been damaged during shipment.

Guidelines for Unpacking
Due to the heavy weight of microscopes, a forklift has to be used to remove the microscopes from the wooden crate:
- The forklift used must have a sufficient load capacity.
Guidelines for Transporting
A hand pallet truck has to be used to move the unpacked microscope:
- Ensure all hallways and corners are wide enough to be passed with the hand pallet truck.

Conditions during Storage and Transport
The packed microscope has to be stored in a dry place.
- Allowable temperature during on-site storage and transport:
  - Between −10 °C and +70 °C

Info

| 24 hours before installation of the Microscope System it is required that the boxes be at recommended room temperature to avoid ingress of humidity, which is very harmful to optical paths, and to ensure effective stability of the Microscope System during installation and testing. |

8.3 Disposal

The Microscope System and its components must not be disposed of as domestic waste or through municipal disposal companies. They must be disposed of in accordance with applicable regulations (WEEE Directive 2012/19/EU). ZEISS has implemented a system for the return and recycling of devices in member states of the European Union that ensures suitable reuse according to the EU Directives mentioned. The customer is responsible for decontamination.

NOTICE

Environmental risk due to disposal of aggressive or toxic chemicals
When disposing of aggressive or toxic chemicals, there is a threat of damage to the environment.
- When disposing of waste that has been generated during a service operation (e.g. used rotary pump oil), comply with all national and local safety and environmental protection regulations.

Info

| Detailed information on disposal and recycling is available from your ZEISS Sales & Service Partner. |

8.4 Decontamination

A decontamination statement must be submitted before returning any used objects to the ZEISS location.
If reliable decontamination cannot be guaranteed, the hazard must be marked according to applicable regulations. In general, a well-visible warning sign must be affixed to the article itself and to the outside of the packaging, together with detailed information on the type of contamination.
9 Technical Data and Conformity

This chapter contains important technical data as well as information on the conformity.

9.1 Performance Data and Specifications | Sigma 300 and Sigma 300 VP

The Microscope System must only be operated in closed rooms. It is recommended to install the Microscope System in a dark room where artificial illumination, sunlight or other light sources cannot interfere with image acquisition. The Microscope System should not be installed near windows with direct sunlight or radiators. Compliance with the installation requirements of the Microscope System and the availability of the requested supplies is the responsibility of the customer and has to be provided at the time of installation. Due to continuous development, we reserve the right to change specifications without notice.

The Microscope System must be plugged into a properly installed power socket with protective earth contact using the supplied mains cable. The protective earth connection must not be impaired by the use of extension cables.

### Info

Your ZEISS Sales & Service Partner will provide you with the detailed installation requirements.

<table>
<thead>
<tr>
<th>Main Components</th>
<th>Length (mm)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
<th>Weight (kg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plinth + column</td>
<td>822</td>
<td>960</td>
<td>1757</td>
<td>636</td>
</tr>
<tr>
<td>Table + PC</td>
<td>1133</td>
<td>1076</td>
<td>826</td>
<td>85</td>
</tr>
<tr>
<td>Static damping block</td>
<td>180</td>
<td>180</td>
<td>160</td>
<td>44</td>
</tr>
<tr>
<td>Quiet mode option</td>
<td>324</td>
<td>324</td>
<td>300</td>
<td>17.0</td>
</tr>
<tr>
<td>Pre-vacuum pump</td>
<td>430</td>
<td>250</td>
<td>290</td>
<td>26</td>
</tr>
</tbody>
</table>

### Electron Optics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEM resolution</td>
<td>Gemini column in high resolution configuration (max. probe current 20 nA) at optimum working distance:</td>
</tr>
<tr>
<td></td>
<td>- 1.0 nm at 30 kV (STEM mode)</td>
</tr>
<tr>
<td></td>
<td>- 1.0 nm at 15 kV</td>
</tr>
<tr>
<td></td>
<td>- 1.6 nm at 1 kV</td>
</tr>
<tr>
<td>Acceleration voltage</td>
<td><strong>Range:</strong> 20 V to 30 kV</td>
</tr>
<tr>
<td></td>
<td><strong>Adjustment:</strong> Continuously variable in 10 Volt steps</td>
</tr>
<tr>
<td>Probe current</td>
<td><strong>20 nA high resolution configuration:</strong> 3 pA to 20 nA</td>
</tr>
<tr>
<td></td>
<td><strong>100 nA high current configuration:</strong> 6 pA to 100 nA</td>
</tr>
<tr>
<td>Probe current selection</td>
<td>via seven apertures (six apertures in case of 100 nA configuration) with electromagnetic selection and precise alignment</td>
</tr>
<tr>
<td>Optional OptiProbe</td>
<td><strong>Optional OptiProbe</strong> module for continuous probe current adjustment</td>
</tr>
<tr>
<td>Magnification</td>
<td><strong>Range:</strong> 10x – 2,000,000x referenced to Polaroid 5” × 4.5” image format</td>
</tr>
</tbody>
</table>
### Technical Data and Conformity | 9.1 Performance Data and Specifications | Sigma 300 and Sigma 300 VP

#### Electron source
- **Filament**: Schottky field emitter
- **Automatic emitter run-up**: Safe controlled run-up to the target emitter conditions

#### Objective lens
- **Type**: Gemini electromagnetic/electrostatic objective lens system (80º conical final lens) with water cooling for best thermal stability and reproducibility

#### Focus
- **Working distance**: Range from 0.1 mm to 50 mm, depending on operating conditions and stage configuration
- **Focus compensation**: Automatic compensation to minimize focus changes over the entire acceleration voltage range
- **Dynamic focus**: For correction of focus on tilted specimens
- **Focus wobble**: For assistance in aperture alignment, with adjustable amplitude and speed
- **Rotation compensation**: Automatic correction of apparent image rotation with changes in working distance

#### Beam shift
- For precise adjustment of image position at high magnifications

#### Maximum scan speed
- 50 ns/pixel

#### Image framestore
- 4:3 format with 16 bit dynamic range
  - 1024 × 768 pixels
  - 2048 × 1536 pixels
  - 3072 × 2304 pixels
  - 4096 × 3072 pixels
  - 6144 × 4608 pixels
  - 8192 × 6144 pixels
  - 12288 × 9216 pixels
  - 24576 × 18432 pixels
  - 32768 × 24576 pixels
- Dual channel and quad mode are only available for maximum 12k × 9k and scan speed 2 upwards.
- 32k × 9k is only available for normal scans, scan speed 2 upwards.
- DCFA is limited to maximum 4k × 3k.
- 32k × 24k can only be used for SmartSEM (not in combination with Zen applications).

#### System control
- SmartSEM user interface operated by mouse and keyboard
- Windows 10 multilingual operating system

#### Specimen Chamber and Stage

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specimen chamber dimensions</td>
<td>- 365 mm inner diameter</td>
</tr>
<tr>
<td></td>
<td>- 275 mm height</td>
</tr>
<tr>
<td>Free accessory ports</td>
<td>10</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dedicated EDS ports</td>
<td>1</td>
</tr>
<tr>
<td>Analytical working distance</td>
<td>8.5 mm</td>
</tr>
<tr>
<td>Specimen stage</td>
<td><strong>Type:</strong> 5-axes motorized Cartesian controlled via the SmartSEM user interface or operated by a dual joystick control box</td>
</tr>
<tr>
<td></td>
<td><strong>Mounting:</strong> Drawer-type door</td>
</tr>
<tr>
<td></td>
<td><strong>Movements:</strong> § X/Y = 125 mm § Z = 50 mm § T = −10° to 90° § R = 360° continuous</td>
</tr>
<tr>
<td></td>
<td><strong>INFO:</strong> The movements may be reduced by specimen size, operating conditions, and accessories attached.</td>
</tr>
<tr>
<td>Accessory ports</td>
<td>Two accessory ports on the stage door are provided</td>
</tr>
<tr>
<td>Specimen weight</td>
<td>Up to 0.5 kg all axes, up to 2 kg without tilt, up to 5 kg on XY platform only</td>
</tr>
<tr>
<td>Specimen current monitor</td>
<td>with integrated <strong>Touch Alarm</strong> (audible touch alarm warning with on-screen message)</td>
</tr>
<tr>
<td>Specimen mounts</td>
<td>One carousel 9x specimen holder for 13 mm diameter stubs included in base tool configuration, various specimen holders available as option</td>
</tr>
<tr>
<td>Plasma cleaner (optional)</td>
<td><strong>Integrated plasma cleaner:</strong> Chamber mounted plasma cleaner for removal of hydrocarbon contamination from both specimen and chamber; integrated software control for user defined cleaning cycles without user interaction after starting the cleaning process</td>
</tr>
<tr>
<td>Vacuum Modes</td>
<td>§ High vacuum § Variable pressure (optional) 10–133 Pa</td>
</tr>
</tbody>
</table>

### Detection System

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InLens detectors</td>
<td><strong>InLens SE detector:</strong> High efficiency annular scintillator detector mounted in Gemini column with optically coupled photomultiplier.</td>
</tr>
<tr>
<td>Chamber detectors</td>
<td><strong>SE detector:</strong> Everhart-Thornley SE detector with optically coupled photomultiplier; collector bias adjustable from −250 to +400 V</td>
</tr>
<tr>
<td></td>
<td><strong>VPSE detector</strong> (optional, only for VP mode): Fourth generation variable pressure secondary electron detector for imaging in VP mode with up to 85 % improvement in Weber contrast ratio</td>
</tr>
<tr>
<td></td>
<td><strong>C2D detector</strong> (optional; only for VP mode):</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cascade Current Detector with floating amplifier electronics, for enhanced imaging in Variable Pressure mode up to 133 Pa. Delivers detail at low kV for specimens that demand higher pressures, e.g. polymers, bio specimens, pharmaceuticals, powders, and fibers. Enhanced signal-to-noise ratio versus VPSE detector.</td>
<td></td>
</tr>
<tr>
<td>aBSD1-LH detector (optional):</td>
<td>Pneumatically retractable 5 segment multi-mode solid state BSE detector; enables materials contrast, crystal orientation, and topographic imaging</td>
</tr>
<tr>
<td>HDBSD detector (optional):</td>
<td>High definition retractable four quadrant or five segment 16 mm solid state diode backscattered detector fitted below the objective lens assembly. Provides superb compositional BSE imaging at low kV of metals, polymers, minerals, etc. both in HV and VP modes.</td>
</tr>
<tr>
<td>YAG BSD detector (optional):</td>
<td>Robust, fully retractable, YAG-crystal-based BSE scintillator detector with rise time ~200 ns. Easy to use with no amplifier gain adjustment required.</td>
</tr>
<tr>
<td>HDAsB detector (optional):</td>
<td>Crystallographic and channeling contrast imaging of metals and minerals. Four-quadrant solid state BSD diode (each segment 10 mm²) integrated in the Gemini objective lens for the detection of angular selective backscattered (AsB) electrons. BSD imaging is possible at acceleration voltages above 1 kV. Allows operation at short working distance. Modified instrument resolution because of the 2 mm additional height of the HDAsB detector is indicated in the resolution values. The WD indication is automatically corrected, i.e. the displayed WD is the real distance between the specimen surface and the HDAsB detector bottom side.</td>
</tr>
<tr>
<td>CL detector (optional):</td>
<td>Cathodoluminiscence (CL) chamber detector (option for non-VP configurations, included in VP option)</td>
</tr>
<tr>
<td>aSTEM detector (optional):</td>
<td>Pneumatically retractable multi-mode annular Scanning Transmission Electron Microscopy (aSTEM) detector, with 12x specimen holder; enables bright field (BF), dark field (DF), oriented dark field (ODF), and high angle annular dark field (HAADF) transmission imaging</td>
</tr>
<tr>
<td>Chamber camera</td>
<td>Color CCD camera with white-light illumination and IR illumination.</td>
</tr>
<tr>
<td>Specimen current monitor</td>
<td>Auto ranging for precise current measurement in the range of 1 pA to 10 μA</td>
</tr>
</tbody>
</table>

For more details refer to the document Product Specification.
9.2 Performance Data and Specifications | Sigma 500 and Sigma 500 VP

The Microscope System must only be operated in closed rooms. It is recommended to install the Microscope System in a dark room where artificial illumination, sunlight or other light sources cannot interfere with image acquisition. The Microscope System should not be installed near windows with direct sunlight or radiators. Compliance with the installation requirements of the Microscope System and the availability of the requested supplies is the responsibility of the customer and has to be provided at the time of installation. Due to continuous development, we reserve the right to change specifications without notice.

The Microscope System must be plugged into a properly installed power socket with protective earth contact using the supplied mains cable. The protective earth connection must not be impaired by the use of extension cables.

<table>
<thead>
<tr>
<th>Weight and Sizes</th>
<th>Main Components</th>
<th>Length (mm)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
<th>Weight (kg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plinth + column</td>
<td>822</td>
<td>960</td>
<td>1757</td>
<td>636</td>
<td></td>
</tr>
<tr>
<td>Table + PC</td>
<td>1133</td>
<td>1076</td>
<td>826</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>Static damping block</td>
<td>180</td>
<td>180</td>
<td>160</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>Quiet mode option</td>
<td>324</td>
<td>324</td>
<td>160</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>Pre-vacuum pump</td>
<td>430</td>
<td>250</td>
<td>290</td>
<td>26</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Electron Optics</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEM resolution</td>
<td>0.8 nm at 30 kV (STEM mode)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.8 nm at 15 kV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.3 nm at 1 kV</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Acceleration voltage</th>
<th>Range: 20 V to 30 kV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment</td>
<td>Continuously variable in 10 Volt steps</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Probe current</th>
<th>20 nA high resolution configuration: 3 pA to 20 nA</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 nA high current configuration: 6 pA to 100 nA</td>
<td></td>
</tr>
</tbody>
</table>

| Probe current selection | via seven apertures (six apertures in case of 100 nA configuration) with electromagnetic selection and precise alignment |

| Optional OptiProbe | module for continuous probe current adjustment |

| Magnification | Range: 12 x – 2,000,000x referenced to Polaroid 5” × 4.5” image format |

<table>
<thead>
<tr>
<th>Electron source</th>
<th>Filament: Schottky field emitter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic emitter run-up: Safe controlled run-up to the target emitter conditions</td>
<td></td>
</tr>
</tbody>
</table>
## Technical Data and Conformity

### 9.2 Performance Data and Specifications | Sigma 500 and Sigma 500 VP

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Objective lens</strong></td>
<td><strong>Type:</strong> Gemini electromagnetic/electrostatic objective lens system (80° conical final lens) with water cooling for best thermal stability and reproducibility</td>
</tr>
<tr>
<td><strong>Focus</strong></td>
<td><strong>Working distance:</strong> Range from 0.1 mm to 50 mm, depending on operating conditions and stage configuration</td>
</tr>
<tr>
<td></td>
<td><strong>Focus compensation:</strong> Automatic compensation to minimize focus changes over the entire acceleration voltage range</td>
</tr>
<tr>
<td></td>
<td><strong>Dynamic focus:</strong> For correction of focus on tilted specimens</td>
</tr>
<tr>
<td></td>
<td><strong>Focus wobble:</strong> For assistance in aperture alignment, with adjustable amplitude and speed</td>
</tr>
<tr>
<td></td>
<td><strong>Rotation compensation:</strong> Automatic correction of apparent image rotation with changes in working distance</td>
</tr>
<tr>
<td><strong>Beam shift</strong></td>
<td>For precise adjustment of image position at high magnifications</td>
</tr>
<tr>
<td><strong>Maximum scan speed</strong></td>
<td>50 ns/pixel</td>
</tr>
<tr>
<td><strong>Image framestore</strong></td>
<td>4:3 format with 16 bit dynamic range</td>
</tr>
<tr>
<td></td>
<td>- 1024 × 768 pixels</td>
</tr>
<tr>
<td></td>
<td>- 2048 × 1536 pixels</td>
</tr>
<tr>
<td></td>
<td>- 3072 × 2304 pixels</td>
</tr>
<tr>
<td></td>
<td>- 4096 × 3072 pixels</td>
</tr>
<tr>
<td></td>
<td>- 6144 × 4608 pixels</td>
</tr>
<tr>
<td></td>
<td>- 8192 × 6144 pixels</td>
</tr>
<tr>
<td></td>
<td>- 12288 × 9216 pixels</td>
</tr>
<tr>
<td></td>
<td>- 24576 × 18432 pixels</td>
</tr>
<tr>
<td></td>
<td>- 32768 × 24576 pixels</td>
</tr>
<tr>
<td></td>
<td>Dual channel and quad mode are only available for maximum 12k × 9k and scan speed 2 upwards.</td>
</tr>
<tr>
<td></td>
<td>32k × 9k is only available for normal scans, scan speed 2 upwards.</td>
</tr>
<tr>
<td></td>
<td>DCFA is limited to maximum 4k × 3k.</td>
</tr>
<tr>
<td></td>
<td>32k × 24k can only be used for SmartSEM (not in combination with Zen applications).</td>
</tr>
<tr>
<td><strong>System control</strong></td>
<td>SmartSEM user interface operated by mouse and keyboard</td>
</tr>
<tr>
<td></td>
<td>Windows 10 multilingual operating system</td>
</tr>
</tbody>
</table>

### Specimen Chamber and Stage

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Specimen chamber dimensions</strong></td>
<td>- 358 mm inner diameter</td>
</tr>
<tr>
<td></td>
<td>- 270.5 mm height</td>
</tr>
<tr>
<td><strong>Free accessory ports</strong></td>
<td>14</td>
</tr>
<tr>
<td><strong>Dedicated EDS ports</strong></td>
<td>2</td>
</tr>
</tbody>
</table>
### Analytical working distance
- **Description**: 8.5 mm

### Specimen stage
- **Type**: 5-axes motorized eucentric controlled via the SmartSEM user interface or operated by a dual joystick control box
- **Mounting**: Drawer-type door
- ** Movements:**
  - X/Y = 130 mm
  - Z = 50 mm
  - T = −4° to 70°
  - R = 360° continuous
- **INFO**: The movements may be reduced by specimen size, operating conditions, and accessories attached.
- **Accessory ports**: Two accessory ports on the stage door are provided
- **Specimen weight**: Up to 0.5 kg
- **Specimen current monitor** with integrated Touch Alarm (audible touch alarm warning with on-screen message)
- **Specimen mounts**: One carousel 9x specimen holder for 13 mm diameter stubs included in base tool configuration, various specimen holders available as option

### Plasma cleaner (optional)
- **Integrated plasma cleaner**: Chamber mounted plasma cleaner for removal of hydrocarbon contamination from both specimen and chamber; integrated software control for user defined cleaning cycles without user interaction after starting the cleaning process

### Vacuum Modes
- **High vacuum**
- **Variable pressure (optional)** 10–133 Pa

### Detection System

#### InLens detectors
- **InLens SE detector**: High efficiency annular scintillator detector mounted in Gemini column with optically coupled photomultiplier.

#### InLensDuo detector (optional):
- Column-mounted scintillator detector and optically coupled photomultiplier with energy filtering grid adjustable from 0 V to −1.5 kV. Enables two detection modes:
  - SE detection mode: high efficiency InLens SE detection with filtering grid disabled.
  - BSE detection mode: high efficiency InLens detection of energy and angle selective BSE using the energy filtering grid.
- Simultaneous usage of the two detection modes is not possible. VP range is limited to 50 Pa.

#### Chamber detectors
- **SE detector**: Everhart-Thornley SE detector with optically coupled photomultiplier; collector bias adjustable from −250 to +400 V
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VPSE detector</strong></td>
<td>Fourth generation variable pressure secondary electron detector for imaging in VP mode with up to 85% improvement in Weber contrast ratio.</td>
</tr>
<tr>
<td><strong>C2D detector</strong></td>
<td>Cascade Current Detector with floating amplifier electronics, for enhanced imaging in Variable Pressure mode up to 133 Pa. Delivers detail at low kV for specimens that demand higher pressures, e.g., polymers, bio specimens, pharmaceuticals, powders, and fibers. Enhanced signal-to-noise ratio versus VPSE detector.</td>
</tr>
<tr>
<td><strong>aBSD1-LH detector</strong></td>
<td>Pneumatically retractable 5 segment multi-mode solid state BSE detector; enables materials contrast, crystal orientation, and topographic imaging.</td>
</tr>
<tr>
<td><strong>HDBSD detector</strong></td>
<td>High definition retractable four quadrant or five segment 16 mm solid state diode backscattered detector fitted below the objective lens assembly. Provides superb compositional BSE imaging at low kV of metals, polymers, minerals, etc. both in HV and VP modes.</td>
</tr>
<tr>
<td><strong>BSD4 detector</strong></td>
<td>Pneumatically retractable multi-mode solid state Backscattered Electron Detector (BSD); enables materials contrast, crystal orientation, and topographic imaging; diode with 4 sectors and one additional segment. Provides 4 parallel outputs for 3D surface reconstruction and surface roughness measurements. Can be used in conjunction with optional metrology software.</td>
</tr>
<tr>
<td><strong>YAG BSD detector</strong></td>
<td>Robust, fully retractable, YAG-crystal-based BSE scintillator detector with rise time ~200 ns. Easy to use with no amplifier gain adjustment required.</td>
</tr>
<tr>
<td><strong>HDAsB detector</strong></td>
<td>Crystallographic and channeling contrast imaging of metals and minerals. Four-quadrant solid state BSD diode (each segment 10 mm²) integrated in the Gemini objective lens for the detection of angular selective backscattered (AsB) electrons. BSD imaging is possible at acceleration voltages above 1 kV. Allows operation at short working distance. Modified instrument resolution because of the 2 mm additional height of the HDAsB detector is indicated in the resolution values. The WD indication is automatically corrected, i.e. the displayed WD is the real distance between the specimen surface and the HDAsB detector bottom side.</td>
</tr>
<tr>
<td><strong>CL detector</strong></td>
<td>Cathodoluminiscence (CL) chamber detector (option for non-VP configurations, included in VP option).</td>
</tr>
</tbody>
</table>
### 9.3 Installation Requirements

#### Info

For a complete list of the installation requirements, refer to the document Installation Requirements.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Location Requirements</strong></td>
<td></td>
</tr>
<tr>
<td>Installation site</td>
<td>Exclusively inside buildings</td>
</tr>
<tr>
<td>Recommended room size</td>
<td>Min. 3.6 m × 5.0 m × 2.3 m</td>
</tr>
<tr>
<td>Service area</td>
<td>Min. 0.8 m at each side</td>
</tr>
<tr>
<td>Entrance</td>
<td>Min. 0.8 m wide</td>
</tr>
<tr>
<td>Hallways</td>
<td>Min. 1.0 m wide</td>
</tr>
<tr>
<td>Corners</td>
<td>Min. 1.2 m wide</td>
</tr>
<tr>
<td>Transport ways</td>
<td>Free of staircases</td>
</tr>
<tr>
<td>Installation category</td>
<td>II</td>
</tr>
<tr>
<td>Floor stability</td>
<td>&gt; 1000 kg/m²</td>
</tr>
</tbody>
</table>

#### Exhaust Line

If toxic chemicals or biological specimens are used an exhaust line is recommended to remove the waste gas of the pre-vacuum pump and to transmit it to the outside.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Electrical Supplies</strong></td>
<td></td>
</tr>
<tr>
<td>Nominal AC voltage</td>
<td>230 V&lt;sub&gt;AC&lt;/sub&gt; 1/N/PE or 208 V&lt;sub&gt;AC&lt;/sub&gt; 2/PE</td>
</tr>
<tr>
<td>Protection class</td>
<td>Class I</td>
</tr>
<tr>
<td>Nominal frequency</td>
<td>50–60 Hz</td>
</tr>
</tbody>
</table>
### Parameter | Requirement
--- | ---
Momentary interruption | Less than a half cycle

**System connection**

- The microscope is delivered with a 3 m long power cord that is equipped with a 200–250 V\textsubscript{AC} CEE MALE PLUG 2P3W 6h 16A (blue) according to IEC 60309.
- The supplied connection cable must not be replaced with another one. Otherwise, the conformity with listed standards becomes invalid.
- The building installation should provide the corresponding 200–250 V\textsubscript{AC} CEE FEMALE RECEPTACLE 2P3W 6h 16A (blue) with the correct wiring 1/N/PE or 2/PE and the desired approvals of the country used.
- To avoid disturbance from other installed machines Carl Zeiss Microscopy recommends to use a separate power connection to the main distribution panel.

<table>
<thead>
<tr>
<th>Power consumption</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. 3 kVA, dependent on accessories</td>
<td></td>
</tr>
</tbody>
</table>

| Circuit breaker (at house installation) | 16 A Type C |

| Ampere interrupting capacity (AIC) | 1500 A rms without external EMO box  
10000 A rms with external EMO box |

| Protective ground | High leakage currents are present in the microscope. Therefore, the microscope has to be connected to a separate protective ground.  
An exclusive grounding connection to earth must be provided as part of the building installation, i.e. a grounding screw terminal (Ø 8 mm) which is directly connected to the PE of the FEMALE RECEPTACLE as short as possible. (refer to picture)  
This grounding connection must not be common to other electrical equipment. |

![Diagram](image)

A grounding wire AWG10 (≥ 5 m) is delivered with the microscope. It serves as connection between the grounding screw terminal (Ø 8 mm) and the microscope (Ø 6 mm).

**Cross section**: Min. AWG10 (between grounding screw terminal and PE of the CEE FEMALE RECEPTACLE)\textsuperscript{2}
### Cooling Water

Major components of the microscope such as electron-optic lenses, parts of the electronics and the turbo molecular pump are water-cooled. Any cooling solution has to fulfil the following requirements.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water flow rate</td>
<td>&gt; 1.5 l/min</td>
</tr>
<tr>
<td>Pressure</td>
<td>2–3 bar</td>
</tr>
<tr>
<td>Water temperature</td>
<td>18–22°C</td>
</tr>
<tr>
<td>Stability</td>
<td>0.5 °C/10 min</td>
</tr>
<tr>
<td>Heat dissipation</td>
<td>1 kW</td>
</tr>
<tr>
<td>Connection hose</td>
<td>8 mm inside diameter. One 25 m roll is delivered with the microscope.</td>
</tr>
<tr>
<td>Instrument connection</td>
<td>Quick exchange connectors. Two are delivered with the microscope.</td>
</tr>
</tbody>
</table>

### Nitrogen

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. The nitrogen can be taken either from a gas cylinder or from an in-house supply system.

The connection must be equipped with an appropriate pressure reducer and a shut-off valve that is secured against accidental re-activation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow rate</td>
<td>Approx. 3 l/min for ventilation of specimen chamber with chamber door open</td>
</tr>
<tr>
<td>Pressure</td>
<td>0.2–3.3 bar</td>
</tr>
<tr>
<td>Quality</td>
<td>4.6 with nitrogen content &gt; 99.996 %</td>
</tr>
<tr>
<td>Connection hose</td>
<td>4 mm inside diameter. 10 m are delivered with the microscope.</td>
</tr>
<tr>
<td>Instrument connection</td>
<td>Quick exchange connector. One is delivered with the microscope.</td>
</tr>
</tbody>
</table>

### Compressed Air

Compressed air is used to operate several valves and the auto leveling system. The necessary compressed air can be either generated by a compressor (part no. 345596-0000-000) or taken from a gas cylinder or from an in-house supply system.

The connection must be equipped with an appropriate pressure reducer and a shut-off valve that can be secured against accidental re-activation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typical flow rate</td>
<td>Less than 1 l/min during normal operation</td>
</tr>
<tr>
<td>Pressure</td>
<td>0.6–0.8 MPa (6–8 bar)</td>
</tr>
<tr>
<td>Quality</td>
<td>Oil-free</td>
</tr>
<tr>
<td>Connection hose</td>
<td>4 mm inside diameter. 10 m of pipe are delivered with the microscope.</td>
</tr>
<tr>
<td>Instrument connection</td>
<td>Quick exchange connector. One is delivered with the microscope.</td>
</tr>
</tbody>
</table>

**INFO:** Due to acoustic noise and vibrations the compressor – if used – should be installed in a separate room.
### Environmental Requirements

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient temperature</td>
<td>Appr. 21±4 °C</td>
</tr>
<tr>
<td>Stability of ambient temperature</td>
<td>0.5 °C/h</td>
</tr>
<tr>
<td>For long-running experiments:</td>
<td>2 °C/24 h</td>
</tr>
<tr>
<td>Long-term stability of ambient tempera-</td>
<td></td>
</tr>
<tr>
<td>ture</td>
<td></td>
</tr>
<tr>
<td>Relative humidity</td>
<td>Less than 65 %</td>
</tr>
<tr>
<td>Altitude</td>
<td>Max. 2000 m above sea level to guarantee an undisturbed operation</td>
</tr>
<tr>
<td>Pollution degree</td>
<td>2</td>
</tr>
<tr>
<td>Electrical field</td>
<td>The microscope is a class A device (industrial). The microscope is designed to operate in a controlled electromagnetic environment. This means that devices with RF transmitters such as mobile phones or DECT phones must not be used in close proximity.</td>
</tr>
<tr>
<td>Vibrations</td>
<td>Horizontal vibrations (in x/y-direction)</td>
</tr>
<tr>
<td></td>
<td>Up to 10 Hz: less than 0.04 mm/s</td>
</tr>
<tr>
<td></td>
<td>10–20 Hz: less than 0.17 mm/s</td>
</tr>
<tr>
<td></td>
<td>20–70 Hz: less than 0.30 mm/s</td>
</tr>
<tr>
<td></td>
<td>Above 70 Hz: less than 20 mm/s</td>
</tr>
<tr>
<td></td>
<td>Vertical vibrations (in z-direction)</td>
</tr>
<tr>
<td></td>
<td>Up to 8 Hz: less than 0.03 mm/s</td>
</tr>
<tr>
<td></td>
<td>8–45 Hz: less than 0.15 mm/s</td>
</tr>
<tr>
<td></td>
<td>Above 45 Hz: less than 2.00 mm/s</td>
</tr>
<tr>
<td>Magnetic stray fields</td>
<td>Less than 3 mG peak to peak between 10 Hz and 1 kHz (Sigma 300)</td>
</tr>
<tr>
<td></td>
<td>Less than 1 mG peak to peak between 10 Hz and 1 kHz (Sigma 500)</td>
</tr>
<tr>
<td>Acoustic noise</td>
<td>Sigma 300:</td>
</tr>
<tr>
<td></td>
<td>Less than 53 dB for frequencies up to 200 Hz</td>
</tr>
<tr>
<td></td>
<td>Less than 42 dB for frequencies from 200 up to 300 Hz</td>
</tr>
<tr>
<td></td>
<td>Less than 50 dB for frequencies higher than 300 Hz</td>
</tr>
<tr>
<td></td>
<td>Sigma 500:</td>
</tr>
<tr>
<td></td>
<td>Less than 50 dB for frequencies up to 200 Hz</td>
</tr>
<tr>
<td></td>
<td>Less than 40 dB for frequencies from 200 up to 400 Hz</td>
</tr>
<tr>
<td></td>
<td>Less than 45 dB for frequencies higher than 400 Hz</td>
</tr>
</tbody>
</table>
9.3.1 Layout and Connections

1. Static vibration damper
2. Pre-vacuum pump
3. Plinth and column
4. Computer workplace

A  Mains power supply 208…230 V, max. 16 A
B  Equipotential bonding bar, safety earth
C  Vacuum exhaust
D  Chilled water supply
E  Dry compressed air
F  Dry nitrogen supply
G  Additional standard local mains power sockets, max. 13 A
9.3.2 System Layout
9.4 Applicable Standards and Regulations

Observe all general and country-specific safety regulations as well as applicable environmental protection laws and regulations.

The Microscope System is in compliance with the requirements of the following regulations and directives:

<table>
<thead>
<tr>
<th>Regulation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006/42/EC</td>
<td>Machine Directive</td>
</tr>
<tr>
<td>2011/65/EU</td>
<td>RoHS Directive</td>
</tr>
<tr>
<td>2014/30/EU</td>
<td>Electromagnetic Compatibility</td>
</tr>
<tr>
<td>KN 11</td>
<td>Industrial, scientific and medical equipment – Radio-frequency disturbance characteristics – Limits and methods of measurement</td>
</tr>
<tr>
<td>KN 61000-6-2</td>
<td>Electromagnetic compatibility (EMC) – Part 6-2: Generic standards – Immunity standard for industrial environments</td>
</tr>
<tr>
<td>EN 61010-1:2010</td>
<td>Safety requirements for electrical equipment for measurement, control, and laboratory use – Part 1: General requirements</td>
</tr>
<tr>
<td>EN 61326-1:2018</td>
<td>Electrical equipment for measurement, control and laboratory use – EMC requirements – Part 1: General requirements</td>
</tr>
<tr>
<td>EN ISO 13849-1:2015</td>
<td>Safety of machinery – Safety related parts of control systems – Part 1: General principles for design</td>
</tr>
</tbody>
</table>

The product and its accessories have been classified as instrument category 9 (laboratory equipment or comparable standard). The product and its accessories comply with the EU-regulations 2011/65/EU (RoHS) and 2012/19/EU (WEEE), as applicable for the product.

In addition to the European and international guidelines and standards, the 21 CFR §1040.10: "Performance Standards for light emitting products - laser products" applies for the USA.

The following EMC user notice is for Korea only:

기종별 사용자안내문

A급기기(업무용방송통신기자재) 이기기는 업무용(A급) 전자파적합기기로서 판매자 또는 사용자는 이 절을 주의하시기 바라 며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.

European and International Directives / Standards: For more information on ISO, CSA, SEMI certificates or CE Declarations of Conformity, contact your ZEISS Sales & Service Partner.

ZEISS works according to a certified Environment Management System according to ISO 14001. The product was developed, tested and produced in accordance with the valid regulations and guidelines for environmental law of the European Union.
10 Parts and Tools

NOTICE

Spare parts and consumables
Using spare parts or consumables that are not provided by ZEISS can lead to property damage.
- Only genuine spare parts and consumables supplied by ZEISS are to be used in servicing the microscope.
- Contact your ZEISS service representative for information regarding how to order spare parts and consumables.
- Unless otherwise authorized by ZEISS, all spare parts and consumables must be installed by a ZEISS service representative.

10.1 Tools and Accessories

<table>
<thead>
<tr>
<th>Required Parts/Tools</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faraday cup</td>
<td>348342-8055-000</td>
</tr>
<tr>
<td>3 mm Allen key</td>
<td>000000-0015-247</td>
</tr>
<tr>
<td>1.5 mm Allen key</td>
<td>000000-0151-883</td>
</tr>
<tr>
<td>Small pliers</td>
<td>–</td>
</tr>
<tr>
<td>Specimen holders</td>
<td>Refer to specimen holder catalog.</td>
</tr>
<tr>
<td>Stubs</td>
<td>–</td>
</tr>
<tr>
<td>Tweezers</td>
<td>–</td>
</tr>
<tr>
<td>Lint-free cloth</td>
<td>–</td>
</tr>
<tr>
<td>Lint-free gloves</td>
<td>–</td>
</tr>
</tbody>
</table>
# Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>aBSD</td>
<td>Annular Backscattered Electron Detector</td>
</tr>
<tr>
<td>AIC</td>
<td>Ampere Interrupting Capacity</td>
</tr>
<tr>
<td>Aperture</td>
<td>Mechanical limitation of an opening oriented perpendicular to the optical axis, which filters out electrons whose trajectories (tracks) do not run close to the optical axis.</td>
</tr>
<tr>
<td>AsB</td>
<td>Angle-selective Backscattered</td>
</tr>
<tr>
<td>aSTEM</td>
<td>Annular Scanning Transmission Electron Microscopy</td>
</tr>
<tr>
<td>Astigmatism</td>
<td>Lens aberration that distorts the shape of the electron beam, compensated by the stigmator.</td>
</tr>
<tr>
<td>Backscattered electrons</td>
<td>High-energy electrons that are liberated from the specimen surface when the specimen is hit by the primary electron beam.</td>
</tr>
<tr>
<td>Bakeout</td>
<td>Degassing of surfaces of a vacuum system by heating during the pumping process.</td>
</tr>
<tr>
<td>Beam booster</td>
<td>Anode and liner tube of the Gemini column are connected mechanically and electrically forming the beam booster. A booster voltage (UB, liner voltage) of +8 kV is applied to the beam booster, so that a high beam energy is maintained throughout the entire column. The beam booster technique has two main advantages: It minimizes beam widening, that may occur due to stochastic electron-electron interactions. Consequently there is almost no loss in beam brightness, even at low acceleration voltages. Secondly, the beam booster technique enhances protection against external stray fields.</td>
</tr>
<tr>
<td>BSD</td>
<td>Backscattered Electron Detector</td>
</tr>
<tr>
<td>BSE</td>
<td>Backscattered Electron</td>
</tr>
<tr>
<td>C2D</td>
<td>Cascade Current Detector</td>
</tr>
<tr>
<td>CC</td>
<td>Charge Compensator, Charge Compensation</td>
</tr>
<tr>
<td>CCD</td>
<td>Charge-Coupled Device</td>
</tr>
<tr>
<td>CL</td>
<td>Cathodoluminescence</td>
</tr>
<tr>
<td>Condenser</td>
<td>Device that collects and focuses the electron beam onto the specimen.</td>
</tr>
<tr>
<td>D</td>
<td>Depth</td>
</tr>
<tr>
<td>DECT</td>
<td>Digital Enhanced Cordless Telecommunications</td>
</tr>
<tr>
<td>Depth of field</td>
<td>Distance along the optical axis which an object in the specimen can be moved while remaining in focus.</td>
</tr>
<tr>
<td>EBIC</td>
<td>Electron Beam Induced Current</td>
</tr>
<tr>
<td>EBSD</td>
<td>Electron Backscatter Diffraction</td>
</tr>
<tr>
<td>EC</td>
<td>European Community</td>
</tr>
<tr>
<td>EDS</td>
<td>Energy Dispersive X-ray Spectroscopy</td>
</tr>
<tr>
<td>EDX</td>
<td>Energy Dispersive X-ray Spectroscopy</td>
</tr>
<tr>
<td><strong>EHT</strong></td>
<td>Extra High Tension</td>
</tr>
<tr>
<td><strong>EIGA</strong></td>
<td>European Industrial Gases Association</td>
</tr>
<tr>
<td><strong>EM server</strong></td>
<td>A server that implements the internal communication between control software and microscope hardware.</td>
</tr>
<tr>
<td><strong>EMC</strong></td>
<td>Electromagnetic Compatibility</td>
</tr>
<tr>
<td><strong>EMO</strong></td>
<td>Emergency Off</td>
</tr>
<tr>
<td><strong>Eucentric</strong></td>
<td>Type of stage, the rotation axes of which intersect in the same point. The specimen surface is located in the eucentric point, where the tilt axis meets the beam axis. This guarantees that the focus is maintained when the specimen is tilted at a certain working distance.</td>
</tr>
<tr>
<td><strong>Extractor</strong></td>
<td>Positive electrode that attracts electrons from the filament.</td>
</tr>
<tr>
<td><strong>Faraday cup</strong></td>
<td>Small insulated metal container, equipped with an aperture where electrons can enter but not escape. Used to measure the specimen current in the microscope.</td>
</tr>
<tr>
<td><strong>FESEM</strong></td>
<td>Field Emission Scanning Electron Microscope</td>
</tr>
<tr>
<td><strong>Focus wobble</strong></td>
<td>Function that sweeps the focus of the objective lens backwards and forward through the focus on the specimen plane. When the aperture is misaligned a lateral shift is observed.</td>
</tr>
<tr>
<td><strong>GIS</strong></td>
<td>Gas Injection System</td>
</tr>
<tr>
<td><strong>GUI</strong></td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td><strong>H</strong></td>
<td>Height</td>
</tr>
<tr>
<td><strong>HD</strong></td>
<td>High Definition, an imaging component’s or technique’s attribute of yielding an increased amount of information per area compared to concurrent components or techniques</td>
</tr>
<tr>
<td><strong>HDAsB</strong></td>
<td>High Detection Angle-selective Backscattered</td>
</tr>
<tr>
<td><strong>HDBSD</strong></td>
<td>High Detection Backscattered Electron Detector</td>
</tr>
<tr>
<td><strong>HV</strong></td>
<td>High Vacuum</td>
</tr>
<tr>
<td><strong>IGC</strong></td>
<td>Industrial Gases Council</td>
</tr>
<tr>
<td><strong>IGP</strong></td>
<td>Ion Getter Pump</td>
</tr>
<tr>
<td><strong>IR</strong></td>
<td>Infrared</td>
</tr>
<tr>
<td><strong>MSDS</strong></td>
<td>Material Safety Data Sheet</td>
</tr>
<tr>
<td><strong>Operator</strong></td>
<td>A trained person, who is assigned to operate the microscope. Basic operator: Person who has been trained to perform fundamental operation sequences. Advanced operator: Technically skilled person who has in addition been trained to perform basic maintenance tasks.</td>
</tr>
<tr>
<td><strong>OptiProbe</strong></td>
<td>Optional function which allows you to continuously adjust the probe current.</td>
</tr>
<tr>
<td><strong>PC</strong></td>
<td>Personal Computer</td>
</tr>
<tr>
<td><strong>PE</strong></td>
<td>Protective Earth (ground)</td>
</tr>
<tr>
<td><strong>PE</strong></td>
<td>Primary Electron</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Penning gauge</strong></td>
<td>Device for measuring high vacuum in the vacuum system.</td>
</tr>
<tr>
<td><strong>Pre-vacuum pump</strong></td>
<td>A pump for generating a pre-vacuum.</td>
</tr>
<tr>
<td><strong>Primary electron beam</strong></td>
<td>Narrowly bundled beam of accelerated electrons that hit the specimen surface.</td>
</tr>
<tr>
<td><strong>R</strong></td>
<td>R-axis (Rotation)</td>
</tr>
<tr>
<td><strong>RF</strong></td>
<td>Radio Frequency</td>
</tr>
<tr>
<td><strong>SCD</strong></td>
<td>Specimen Current Detector</td>
</tr>
<tr>
<td><strong>Schottky field emitter</strong></td>
<td>Type of electron source in which emission occurs at or near the work function barrier.</td>
</tr>
<tr>
<td><strong>Scintillator</strong></td>
<td>Substance that absorbs electrons and in response, fluoresces photons while releasing the previously absorbed energy.</td>
</tr>
<tr>
<td><strong>SE</strong></td>
<td>Secondary Electron</td>
</tr>
<tr>
<td><strong>Secondary electrons</strong></td>
<td>Low-energy electrons that are emitted from the specimen surface when the specimen is hit by the primary electron beam. Secondary electrons are generated by inelastic scattering.</td>
</tr>
<tr>
<td><strong>SEM</strong></td>
<td>Scanning Electron Microscope</td>
</tr>
<tr>
<td><strong>SEMI</strong></td>
<td>Semiconductor Equipment and Materials International (SEMI) is an industry association comprising companies involved in the electronics design and manufacturing supply chain.</td>
</tr>
<tr>
<td><strong>SmartSEM</strong></td>
<td>Operating software for ZEISS scanning electron microscopes.</td>
</tr>
<tr>
<td><strong>SMT</strong></td>
<td>Semiconductor Manufacturing Technologies</td>
</tr>
<tr>
<td><strong>STEM</strong></td>
<td>Scanning Transmission Electron Microscope</td>
</tr>
<tr>
<td><strong>Stigmator</strong></td>
<td>Compensates astigmatism (lens aberration), so that the electron beam becomes rotationally symmetrical.</td>
</tr>
<tr>
<td><strong>Suppressor</strong></td>
<td>Electrode (anode) that suppresses unwanted thermionic emission from the shank of the Schottky field emitter.</td>
</tr>
<tr>
<td><strong>T</strong></td>
<td>T-axis (Tilt)</td>
</tr>
<tr>
<td><strong>TEM</strong></td>
<td>Transmission Electron Microscope</td>
</tr>
<tr>
<td><strong>U</strong></td>
<td>Voltage</td>
</tr>
<tr>
<td><strong>UIF</strong></td>
<td>User Interface</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>Person examining a sample under the microscope.</td>
</tr>
<tr>
<td><strong>VP</strong></td>
<td>Variable Pressure</td>
</tr>
<tr>
<td><strong>VPSE</strong></td>
<td>Variable Pressure Secondary Electron</td>
</tr>
<tr>
<td><strong>W</strong></td>
<td>Width</td>
</tr>
<tr>
<td><strong>WD</strong></td>
<td>Working Distance</td>
</tr>
<tr>
<td><strong>WDS</strong></td>
<td>Wavelength Dispersive X-ray Spectroscopy</td>
</tr>
<tr>
<td><strong>WDX</strong></td>
<td>Wavelength Dispersive X-ray Spectroscopy</td>
</tr>
<tr>
<td><strong>WEEE</strong></td>
<td>Waste Electrical and Electronic Equipment</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>X-axis</td>
</tr>
<tr>
<td><strong>X-ray</strong></td>
<td>Type of high energy electromagnetic radiation, that is generated during the operation of electron microscopes.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Y-axis</td>
</tr>
<tr>
<td><strong>YAG</strong></td>
<td>Yttrium Aluminum Garnet</td>
</tr>
<tr>
<td><strong>Z</strong></td>
<td>Z-axis</td>
</tr>
</tbody>
</table>

**ZEISS**

ZEISS is an internationally leading technology enterprise operating in the fields of optics and optoelectronics. Further information about ZEISS can be found at www.zeiss.com.

**ZEISS Sales & Service Partner**

The Sales & Service Partner is generally in the field for customer support in a regional area and / or a clearly defined customer group.

**ZEISS service representative**

Specially trained service expert, either ZEISS staff or authorized service partner of ZEISS.
## Index

### A
- **aBSD1-LH detector** 63, 104
- **Accessory** 162
- **Adjusting**
  - **Probe current** 98
- **Analytic gun mode** 34, 96
- **Aperture** 130
- **Arcing** 131
- **aSTEM detector** 141

### B
- **Backscattered electron** 36
- **Backscattered electrons** 57
- **Bakeout** 133, 138
- **Baking out the gun head** 138
- **Beam booster** 33
- **BSD detector** 57, 60, 107
- **BSD1-VP detector** 141
- **BSD4 detector** 141
- **BSE** 57

### C
- **C2D detector** 52, 103
- **Cathodoluminescence** 36, 67
- **CCD camera** 52
- **Chamber CCD camera** 52
- **Chamber door seal** 137
- **Chamberscope** 52
- **Charging** 133
- **Checking**
  - **Position of the circuit breaker** 140
  - **Temperature** 136
- **Chemicals** 130
- **Circuit breaker** 140
- **CL detector** 67, 108
- **Commissioning** 78
- **Compressed air** 134
- **Consumable and chemical** 130
- **Consumables** 130
- **Contamination** 146
- **Control panel** 69
- **Cover panel, protective** 23

### D
- **Decontamination** 146
- **Detector** 36, 99
- **aBSD1-LH** 63, 104
- **aSTEM** 141
- **BSD** 57, 60, 107
- **BSD1-VP** 141
- **BSD4** 141
- **C2D** 52, 103
- **CL** 67, 108
- **Everhart-Thornley** 44
- **HDAstB** 57, 64, 105
- **HDBSD** 57, 60
- **InLens Duo** 56
- **InLens SE** 38, 100
- **InLens Duo** 100
- **SCD** 67
- **SE** 44, 101
- **STEM** 65
- **VPSE** 49, 102
- **YAG BSD** 65, 108
- **Detector settings** 100
- **Disposal** 143, 146
- **Drift** 133
- **Dual joystick** 68

### E
- **EHT** 33
- **Electron optical column** 32
- **Emergency shutdown** 129
- **Emitter life** 130
- **Everhart-Thornley detector** 44
- **Extractor voltage** 98

### F
- **Faraday cup** 97
- **Field emission gun** 131
- **Filament** 131
- **Focus wobble** 93
- **Fuse** 140

### G
- **Gas ballast** 134
- **Gemini 1 column** 32
- **General Safety Information** 11
- **GUI** 71
- **Gun** 131
- **Gun head, bakeout** 138
- **Gun mode**
  - **Analytic** 34, 96
  - **Imaging** 34, 96
  - **Normal** 34, 96
- **Gun vacuum** 134

### H
- **Hazard**
Biological hazard 12
Burn hazard 12
Chemical hazard 13
Electrical hazard 14
High pressure hazard 14
Magnetic field hazard 14
Mechanical hazard 16
Radiation hazard 16
Suffocation hazard 17
Hazards 12
Prevention 12
HDAshB detector 57, 64, 105
HDBSD detector 57, 60

I
Illumination 115
Image
Acquisition 83, 91
Optimization 93
Quality 133
Saving 96
Imaging gun mode 34, 96
Initializing the stage 134
InLens Duo detector 56
InLens SE detector 38, 100
InLensDuo detector 100
Installation 76
Intended use 10, 11

J
Joystick TV angle 135

K
Keyboard Shortcut 82

L
License
REDUCED 94
Lubricating the rod 141

M
Main Switch 25
Maintenance 130
Consumable and chemical interval 130
schedule 130
work 130
Microscope
De-energizing 128
Shutdown 143
Switching on 79, 81

N
Nitrogen 134

O
ON/OFF switch 24
Online help 81
Operation 78
Operator
Basic 11
Training 11
Optimizing the image 93
OptiProbe 98, 140

P
Penning gauge 134
Performance data 147, 151
Plasma cleaner 118
Recipe 119
Schedule 121
Power failure 133
Preventive maintenance 12
Primary electron 35
Probe current 97, 98

Q
Quiet Mode 31

R
Raman spectroscopy 122
Recipe
Plasma cleaning 119
Related documents 8
Replacing the chamber door seal 137
Requirements for personnel 11
Resetting the touch alarm 136

S
Safe operation conditions 11
Safety 10, 130
devices 22
interlocks 22
Safety label 18
Safety procedures 11
Saving images 96
SCD detector 67
Scintillator 130
SE detector 44, 101
Secondary electron 35
Service 11
Servicing the pre-vacuum pump 131
Setting the probe current 98
Shortcuts 82
Shutdown
Emergency 129
Finishing the work session 126
Microscope 143
Signal detection 34
SmartSEM
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>User interface</td>
<td>71</td>
</tr>
<tr>
<td>SmartSEM program suite</td>
<td>74</td>
</tr>
<tr>
<td>SmartSEM user interface</td>
<td>71</td>
</tr>
<tr>
<td>Software</td>
<td>8, 71</td>
</tr>
<tr>
<td>Software manual</td>
<td>8</td>
</tr>
<tr>
<td>Spare parts</td>
<td>12</td>
</tr>
<tr>
<td>Special Keys</td>
<td>82</td>
</tr>
<tr>
<td>Specimen current</td>
<td>97</td>
</tr>
<tr>
<td>Stage</td>
<td></td>
</tr>
<tr>
<td>Post initialization position</td>
<td>135</td>
</tr>
<tr>
<td>Stage control</td>
<td>68</td>
</tr>
<tr>
<td>Stage initialization</td>
<td>134</td>
</tr>
<tr>
<td>Starting SmartSEM</td>
<td>81</td>
</tr>
<tr>
<td>Starting the microscope</td>
<td>81</td>
</tr>
<tr>
<td>STEM detector</td>
<td>65</td>
</tr>
<tr>
<td>Switching off</td>
<td></td>
</tr>
<tr>
<td>Gun</td>
<td>139</td>
</tr>
<tr>
<td>Microscope</td>
<td>128</td>
</tr>
<tr>
<td>Switching on</td>
<td></td>
</tr>
<tr>
<td>EHT</td>
<td>90</td>
</tr>
<tr>
<td>Gun</td>
<td>90</td>
</tr>
<tr>
<td>Microscope</td>
<td>79, 81</td>
</tr>
<tr>
<td>Switching to standby</td>
<td>126</td>
</tr>
<tr>
<td>System vacuum</td>
<td>134</td>
</tr>
<tr>
<td>Temperature</td>
<td>136</td>
</tr>
<tr>
<td>Tool</td>
<td>162</td>
</tr>
<tr>
<td>Touch alarm, reset</td>
<td>136</td>
</tr>
<tr>
<td>Transfer position</td>
<td>111, 112</td>
</tr>
<tr>
<td>Transmitted electron</td>
<td>36</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>133</td>
</tr>
<tr>
<td>Type plate</td>
<td>22</td>
</tr>
<tr>
<td>User access level</td>
<td>73</td>
</tr>
<tr>
<td>User interface</td>
<td>71</td>
</tr>
<tr>
<td>User privilege</td>
<td>73</td>
</tr>
<tr>
<td>Vacuum</td>
<td>134</td>
</tr>
<tr>
<td>Vacuum mode</td>
<td>109</td>
</tr>
<tr>
<td>High Vacuum (HV)</td>
<td>110</td>
</tr>
<tr>
<td>Variable Pressure (VP)</td>
<td>109</td>
</tr>
<tr>
<td>Vacuum system</td>
<td>30, 31</td>
</tr>
<tr>
<td>Variable pressure</td>
<td>109</td>
</tr>
<tr>
<td>Variable pressure mode</td>
<td>31</td>
</tr>
<tr>
<td>VP mode</td>
<td>31</td>
</tr>
<tr>
<td>VPSE detector</td>
<td>49, 102</td>
</tr>
<tr>
<td>Warning</td>
<td></td>
</tr>
<tr>
<td>labels</td>
<td>18</td>
</tr>
<tr>
<td>lights</td>
<td>18</td>
</tr>
<tr>
<td>Weight and Sizes</td>
<td>147, 151</td>
</tr>
</tbody>
</table>